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Limited Warranty on Media and Replacement
If you discover physical defects in the manuals distributed with an Apple product or in
the media on which a software product is distributed, Apple will replace the media or
manuals at no charge to you, provided you return the item to be replaced with proof 
of purchase to Apple or an authorized Apple dealer during the 90-day period after you
purchased the software. In addition, Apple will replace damaged software media and
manuals for as long as the software product is included in Apple’s Media Exchange
Program. While not an upgrade or update method, this program offers additional
protection for two years or more from the date of your original purchase. See your
authorized Apple dealer for program coverage and details. In some countries the
replacement period may be different; check with your authorized Apple dealer.  

ALL IMPLIED WARRANTIES ON THE MEDIA AND MANUALS, INCLUDING IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE,
ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE
ORIGINAL RETAIL PURCHASE OF THIS PRODUCT.  

Even though Apple has tested the software and reviewed the documentation, 
APPLE MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESSED OR
IMPLIED, WITH RESPECT TO SOFTWARE, ITS QUALITY, PERFORMANCE,
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, 
THIS SOFTWARE IS SOLD “AS IS,” AND YOU, THE PURCHASER, ARE ASSUMING
THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.  

IN NO EVENT WILL APPLE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN
THE SOFTWARE OR ITS DOCUMENTATION, even if advised of the possibility of such
damages. In particular, Apple shall have no liability for any programs or data stored in or
used with Apple products, including the costs of recovering such programs or data.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU
OF ALL OTHERS, ORAL OR WRITTEN, EXPRESSED OR IMPLIED. No Apple dealer,
agent, or employee is authorized to make any modification, extension, or addition to
this warranty.  

Some states do not allow the exclusion or limitation of implied warranties or liability for
incidental or consequential damages, so the above limitation or exclusion may not apply
to you. This warranty gives you specific legal rights, and you may also have other rights
which vary from state to state.  

Important
This equipment has been tested and found to comply with the limits for a Class B digital
device in accordance with the specifications in Part 15 of FCC rules. See instructions if
interference to radio or television reception is suspected.  

DOC Class B Compliance This digital apparatus does not exceed the Class B limits for
radio noise emissions from digital apparatus set out in the radio interference regulations
of the Canadian Department of Communications.

Observation des normes—Classe B Le présent appareil numérique n’émet pas de
bruits radioélectriques dépassant les limites applicables aux appareils numériques de la
Classe B prescrites dans les règlements sur le brouillage radioélectrique édictés par le
Ministère des Communications du Canada.

Attention: Il y a danger d’explosion s’il y a remplacement incorrect de la batterie.
Remplacer uniquement avec une batterie du même type ou d’un type recommandé par
le constructeur. Mettre au rébut les batteries usagées conformément aux instructions du
fabricant.
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Radio and television interference

The equipment described in this manual generates, uses, and can radiate 
radio-frequency energy. If it is not installed and used properly—that is, in strict
accordance with Apple’s instructions—it may cause interference with radio 
and television reception.

This equipment has been tested and found to comply with the limits for a 
Class B digital device in accordance with the specifications in Part 15 of FCC
rules. These specifications are designed to provide reasonable protection
against such interference in a residential installation. However, there is no
guarantee that interference will not occur in a particular installation.

You can determine whether your computer system is causing interference by
turning it off. If the interference stops, it was probably caused by the computer
or one of the peripheral devices.

If your computer system does cause interference to radio or television
reception, try to correct the interference by using one or more of the 
following measures:

■ Turn the television or radio antenna until the interference stops.  

■ Move the computer to one side or the other of the television or radio.  

■ Move the computer farther away from the television or radio.  

■ Plug the computer into an outlet that is on a different circuit from the
television or radio. (That is, make certain the computer and the television 
or radio are on circuits controlled by different circuit breakers or fuses.)

If necessary, consult your authorized Apple dealer or an experienced
radio/television technician for additional suggestions. You may find helpful 
the following booklet, prepared by the Federal Communications Commission:
Interference Handbook (stock number 004-000-00345-4). This booklet is
available from the U.S. Government Printing Office, Washington, DC 20402.  

▲s▲s Important: Changes or modifications to this product not authorized by
Apple Computer, Inc., could void the FCC Certification and negate your
authority to operate the product.

This product was tested for FCC compliance under conditions that included
the use of shielded cables and connectors between system components.
It is important that you use shielded cables and connectors to reduce 
the possibility of causing interference to radios, television sets, and other
electronic devices. For Apple peripheral devices, you can obtain the 
proper shielded cables from your authorized Apple dealer. For non-Apple
peripheral devices, contact the manufacturer or dealer for assistance. ▲s▲s

xiv



How to Use This Book
This book has two parts:

■ Part I, Learning Macintosh, covers everything you need to
know to begin using your Macintosh® PowerBook™ computer.
Begin with Part I if you are new to computers or new to the
Macintosh. Then you’ll be ready to learn the programs that
you want to use with your computer.

■ Part II, Macintosh Reference, contains information that you
may need as you become more proficient with your computer.
Use Part II as you would a dictionary or encyclopedia: turn to
it when you need specific information about a particular topic.

Use the table of contents and the index to find information in this
book. The glossary defines terms that may be unfamiliar to you.
The “Troubleshooting” section can help answer questions you may
have about the operation of your computer.

For information about setting up your Macintosh, see the setup
guide that came with your computer. The setup guide also
contains technical specifications for your PowerBook.

Welcome to Macintosh.

xv
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Learning Macintosh
Chapter 1 Turning the Macintosh On and Off

Chapter 2 Working on the Desktop

Chapter 3 Working With Disks

Chapter 4 Creating a Document

Chapter 5 Changing a Document

Chapter 6 Organizing Your Work

Chapter 7 Learning More About Your Macintosh

Start with Learning Macintosh if you are new to computers or 

new to the Macintosh. Read the chapters in order and follow the

steps they describe. Everything you need to know to begin using

your computer productively is covered in this part of the book.

Before you read Learning Macintosh you should have

■ set up your Macintosh according to the instructions in 

the setup guide that came with your computer

■ gone through the Macintosh Basics tour supplied with 

your computer

When you’re finished with this part of the book, you can turn to

the materials that came with the programs you plan to use with

your computer. The skills you learn in Learning Macintosh will

prove useful in any Macintosh program.

For information that you may need as you become more proficient

with your computer, see Part II, Macintosh Reference.
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Turning the Macintosh 
On and Off
In this chapter

■ How to turn your computer on and off

■ What a startup disk is

■ What your “Macintosh desktop” looks like

■ What to do if your computer stops working

Before you begin

You should have already

■ set up your Macintosh according to the instructions in the
setup guide that came with your computer

■ gone through the Macintosh Basics tour supplied with 
your computer
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Turn your computer on
Most electronic devices, including other computers you may 
have used, have two power states: on and off. Macintosh®

PowerBook™ computers, however, have three power states: 
on, sleep, and off. Sleep is a resting state in which the computer
appears to be off but is actually still on at a reduced power level.
When you turn your computer on, you are either “starting it up” 
(if it was off ) or “waking it up” (if it was “sleeping”).

Depending on which PowerBook model you have, you turn the
computer on in one of two ways:

■ Press any key on the keyboard (except Caps Lock).

Press any
key except
Caps Lock.

The trackball
buttons do not
turn on the
computer.

4 Chapter 1: Turning the Macintosh On and Off



■ Press the power button on the back of your computer (not all
models have a power button).

Model If turned off, press If in sleep, press

PowerBook 170 Power button Power button or any key 
PowerBook 140 on the keyboard

PowerBook 100 Any key on the keyboard Any key on the keyboard

You don’t need to know whether your computer is off or in sleep
before you can turn it on. If pressing a key doesn’t work, just press
the power button.

Turn your computer on now.
Power button

Chapter 1: Turning the Macintosh On and Off    5
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6 Chapter 1: Turning the Macintosh On and Off

When you turn on your computer

When you turn on your Macintosh, the computer looks for a
startup disk. A startup disk contains the information that the
computer needs to “start itself up.” In your case, the startup 

disk is the hard disk inside your computer. When the
Macintosh finds a startup disk, it displays the icon
shown and proceeds to start itself up.

When the startup process is complete, the screen displays the
Macintosh desktop. The desktop is a field of gray with

■ a menu bar across the top (containing the names and icons
of menus)

■ an icon near the upper-right corner representing the 
startup disk

■ an icon near the lower-right corner representing the Trash

Chapter 2, “Working on the Desktop,” describes these features 
in more detail.

When you “wake” your computer from sleep, it does not go
through the startup process because it is already on (at a
reduced power level). The Macintosh desktop reappears on 
the screen immediately, looking just the way it did before 
the computer went to sleep.

Startup disk 
icon

Menu bar

Trash icon



Turn your computer off
Before you can turn your computer off, you need to know how 
to use the trackball to choose a command from a menu. (You
learned how to choose commands from menus in the Macintosh
Basics tour.)

If you are going to take a break and resume work within a few
hours, you can put the computer to sleep. To put the computer 
to sleep, choose Sleep from the Special menu. (Follow the
numbered steps below.)

If you are finished working for the day, or if you plan to transport
your computer or attach something to it, you should shut the
computer down. To shut the computer down, choose Shut Down
from the Special menu.

1. Point to the Special menu title in the menu bar.

Roll the trackball until the arrow pointer is positioned on 
the word “Special.”

2. Press and hold down one of the trackball buttons.

Use whichever button you prefer.

3. Drag through the items in the menu until the Sleep or
Shut Down command is highlighted, and then release
the trackball button.

Chapter 1: Turning the Macintosh On and Off    7
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8 Chapter 1: Turning the Macintosh On and Off

If your computer seems to stop working

If your computer seems to stop working while you are going
through Part I of this book, one of two things may have
happened:

■ The computer may have gone to sleep.

Macintosh PowerBook computers are designed to go to
sleep after a period of inactivity. This conserves battery
power. If you spend several minutes reading without using
the computer, or if you take a break, the screen may be dark
when you’re ready to resume working.

Press any key to wake the computer.

The desktop should reappear looking just the way it did
before the computer went to sleep.

If the computer goes to sleep so often that it interferes with
your work, you can change the time interval before sleep
takes effect. See “Adjusting System Sleep” in Chapter 9 for
instructions.

■ The battery may have run down.

The battery needs recharging periodically. If the computer
doesn’t respond when you try to wake it from sleep, it is
likely that the battery needs to be recharged before you can
continue working.

Plug in the computer’s power adapter 
to recharge the battery.

After 15 minutes or so, you should be able to wake the
computer and resume where you left off.

For more information about power and batteries, see 
Chapter 9.



Working on the Desktop
In this chapter

Review basic trackball skills:

■ Moving the pointer

■ Choosing a command

■ Opening an icon

■ Looking at the contents of a window

And learn:

■ How to use the trackball and keyboard comfortably 
and efficiently

■ How to close a window

■ How to move a window

■ What the icons on your desktop represent

Before you begin
If your computer is in sleep or shut down, turn it back on now.

9
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Use the trackball
Macintosh PowerBook computers have dual-button trackballs. 
You use the trackball itself to control the movements of a pointer
on the screen. The pointer you’ll see most often is an arrow.

You use the trackball buttons to initiate actions that you want the
computer to perform. Both trackball buttons do the same thing.
You can always use whichever one you prefer.

Much of the work you do on the Macintosh uses four trackball
actions: pointing, clicking, pressing, and dragging.

(If you want to return to the Macintosh Basics tour for more
practice with the trackball, see your setup guide for instructions
on how to restart the tour.)

Point

You point to an object on the screen by rolling the trackball so 
the pointer is positioned over that object. When the pointer is an
arrow, the very tip of the arrow must be exactly over the object.

Practice pointing to different objects on the Macintosh desktop,
such as the startup hard disk icon near the upper-right corner, the
Trash icon near the lower-right corner, and the Help menu icon
near the right side of the menu bar.

10 Chapter 2: Working on the Desktop



Click

You click an object on the screen by pressing and quickly
releasing a trackball button while the pointer is over that object.

Practice clicking different objects on the Macintosh desktop, such
as the startup hard disk icon near the upper-right corner and the
Trash icon near the lower-right corner.

When you click an icon, it becomes highlighted (the icon is
darkened). A highlighted icon is said to be selected. A selected
icon is the object of whatever action you choose next.

Press

You press by holding down a trackball button without moving 
the trackball.

Practice pressing the menu names and icons in the menu bar 
(start with the Apple® () menu icon at the left side, through the
menu names, and across to the Help and Application menu icons
at the right side). Pressing a menu name or icon “pulls down” the
menu. Read the items in each menu you pull down.

Chapter 2: Working on the Desktop    11
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Drag

You drag an object on the screen by pointing to that object and
holding down a trackball button while you roll the trackball.

Practice dragging the startup hard disk icon and the Trash icon
around the Macintosh desktop. When you drag an icon, an outline
of the icon follows the pointer on the screen. When you release
the trackball button, the icon itself moves.

When you’re finished practicing, drag the icons back to their
original positions. Then click once in the middle of the desktop.
(Clicking anywhere outside a selected icon returns that icon to 
its original “unselected” state.)

12 Chapter 2: Working on the Desktop



Using the trackball comfortably

The way you position your hands on the keyboard and trackball
depends on whether you’re right- or left-handed and whether
you’re a touch typist. The two hand positions described here are
just examples; the right way to work is the way that is most
comfortable and efficient for you.

■ If you are a touch typist, you
can position your fingers on 
the home row, extending one
thumb to reach the upper
trackball button and the other
thumb to reach the trackball 
itself. Or you may prefer to use one thumb to press the
Space bar and the other to work the trackball and button.

■ If you are doing more work 
with the trackball than with 
the keyboard, you can place 
the index and middle fingers 
of your dominant hand on 
the trackball and the thumb 
of the same hand on the lower 
trackball button, leaving your other hand free for typing.

General suggestions:

■ Change hand positions often to avoid fatigue.

■ Try to keep your hands in a relatively straight line with 
your arms.

■ Avoid rolling your thumbs under your palms.

See Chapter 8 for more information about working comfortably
with your computer.

This Not this 

Not thisThis
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Choose a command
Choosing a command involves using a combination of the
trackball actions you’ve reviewed.

1. Point to the Special menu title in the menu bar.

2. Press to pull down the Special menu.

3. Drag to the first item in the menu (the Clean Up
Desktop command) so it becomes highlighted, 
and then release the trackball button.

When you choose the Clean Up Desktop command, the
startup hard disk icon and the Trash return to exactly the
positions they occupied when you first turned on the
computer (as long as they’re already close to their original
positions).

Giving orders to your Macintosh

Telling the Macintosh to do something involves two steps:

1. selecting an object on the screen, and 

2. choosing the action you want to perform on that object.

When you select an object, you’re telling the Macintosh 
to act upon that object. 

The objects you can select include an icon on the Macintosh
desktop, a sentence in a word-processing program, and a
picture in a graphics program—to give just three examples.

Most of the actions you can perform on the selected object 
are listed in the menus at the top of the screen. The items, 
or actions, in the menus are called commands. When you
choose a command, you are telling the computer to take 
the action you’ve chosen on the selected object.

So—you tell your Macintosh what to do by using a very
simple “language” with only two kinds of words: 

■ nouns (the objects), and 

■ verbs (the actions)

and with only one rule:

■ First the noun, then the verb (to this object, do that
action). In Macintosh terms: select an object, then 
choose a command.
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Open an icon
Opening an icon is your first exercise in telling the computer 
what you want it to do.

1. Click the startup hard disk icon to select it.

The icon is in the upper-right corner of the screen. 
Unless someone has changed its name, the icon is called
“Macintosh HD.” Make sure that the icon is highlighted
(darkened), which means that it’s selected.

2. Point to the File menu title in the menu bar.

3. Press to pull down the File menu.

4. Drag to the Open command (the second item in the 
File menu) so it becomes highlighted, and then release
the trackball button.

When you choose the Open command, the selected icon
opens into a window (in this case, the Macintosh HD
window). The icon itself becomes filled in with a pattern 
of dots, indicating that it has been opened.

❖ Different icons? The Macintosh HD window on your screen
may contain items not shown in the illustration above. The
differences are not important; you can still do the exercises 
in Part I of this book.  ❖
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Look at the contents of a window
Every window has several features that help you view the
window’s contents. But before you can work with the contents of
a window, you need to make that window the active window.

Make a window the active window

You can have several windows open on your screen at one 
time, but only one window can be the active window. An active
window is one in which you can select objects and choose actions
to perform on those objects.

The Macintosh HD window is currently on your Macintosh
desktop. (The window appeared when you opened the 
Macintosh HD icon.) You’re going to open another window now.

1. Click the Trash icon near the lower-right corner of the
screen to select it.

Make sure that the icon is highlighted, which means that 
it’s selected.

2. Point to the File menu title in the menu bar.

3. Press to pull down the File menu.

4. Drag to the Open command so it becomes highlighted,
and then release the trackball button.

When you choose the Open command, the Trash icon opens
into a window (the Trash window). The Trash icon itself
becomes filled in with a pattern of dots, indicating that it has
been opened.

You should now have two windows on your Macintosh
desktop: the Macintosh HD window and the Trash window.
The Trash window is the active window. An active window
has solid lines along both sides of its title (at the top of the
window).

16 Chapter 2: Working on the Desktop
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5. Click anywhere in the Macintosh HD window to make 
it the active window.

Notice that the solid lines now appear at the top of the
Macintosh HD window. (The area containing the window 
title and the solid lines is called the title bar.) When 
windows overlap, the active window is the one 
that’s on top.

Make a window larger or smaller

Sometimes you want to make a window larger, so you can see
more of its contents, or smaller, so it takes up less space on your
screen. You can change a window’s size by dragging its size box
or by clicking its zoom box.

1. Point to the size box in the lower-right corner of the
(active) Macintosh HD window.

2. Drag the size box in any direction, and then release the
trackball button.

While you drag, an outline follows the pointer to indicate the
window’s new size: larger or smaller, wider or narrower. The
new size takes effect when you release the trackball button.

continues >
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3. Click the zoom box near the right end of the title bar.

The window “zooms” to a size that shows all the items in 
the window.

4. Click the zoom box again.

The window zooms back to its previous size (the size that 
you chose in step 2).

Move the hidden contents of a window into view

As you work with your computer, you’ll encounter windows
containing more than you can view on the screen at one time. 
You can view any contents that are currently out of sight in any
window, as described in the following steps.

1. In the (active) Macintosh HD window, click the System
Folder to select it.

Make sure that the icon is highlighted, which means that 
it’s selected.

2. Point to the File menu title in the menu bar.

3. Press to pull down the File menu.

4. Drag to the Open command so it becomes highlighted,
and then release the trackball button.

When you choose the Open command, the System Folder 
icon opens into a window (the System Folder window).

You should now have three windows on your Macintosh
desktop: the Macintosh HD window, the Trash window, and
the System Folder window. The System Folder window is 
the active window because you opened the System Folder
most recently.

18 Chapter 2: Working on the Desktop
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5. Point to the size box in the lower-right corner of the
System Folder window.

6. Drag the size box diagonally (up and to the left) to
make the window about half its current size, and then
release the trackball button.

The bars across the bottom and along the right side of the
System Folder window should now be gray, indicating that the
window has contents that are not currently visible. The gray
bars are called scroll bars.

7. Press the scroll arrow at the right end of the horizontal
scroll bar.

The contents of the window scroll past, bringing into view 
the icons that had been out of sight (on the right).

8. Press the scroll arrow at the left end of the horizontal
scroll bar.

The contents of the window scroll past, bringing back into
view the icons that had been out of sight (on the left).

9. Drag the scroll box toward the middle of the horizontal
scroll bar, and then release the trackball button.

Now you see the icons near the middle of the window.

The vertical scroll bar, scroll box, and scroll arrows work the 
same way. Try them.
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Close a window
When you no longer need to see the contents of a window, 
you can close it by clicking the close box.

1. In the (active) System Folder window, point to the 
close box near the left end of the title bar.

2. Click the close box.

The window closes, and the System Folder icon reappears 
in its previous form.

You should now see two windows on the desktop: the
Macintosh HD window and the Trash window.

Move a window
You can move a window anywhere on the screen by dragging its
title bar. By changing the position and size of windows, you can
arrange your Macintosh desktop in whatever way is best for you.

1. Point to the title bar of the (active) Macintosh HD
window.

Position the pointer anywhere on the title bar except over 
the close box or the zoom box.

2. Drag the title bar in any direction, and then release the
trackball button.

When you drag a window’s title bar, an outline of the 
window follows the pointer on the screen. When you release
the trackball button, the window moves to the position 
you’ve chosen.
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Notice how the Macintosh HD window, because it is the active
window, stays on top of the Trash window if and when the
two windows overlap.

3. Close the Macintosh HD window by clicking the close
box near the left end of the window’s title bar.

If you can’t see the close box, drag the window until you can.

The window closes, and the Macintosh HD icon reappears in
its previous form.

The Trash window (the remaining window on the Macintosh
desktop) becomes the active window.

4. Close the Trash window by choosing Close Window
from the File menu.

You choose Close Window by pointing to the File menu 
title, pressing to pull down the menu, dragging to the Close
Window command, and, with the command highlighted,
releasing the trackball button.

Of course, you can also close the window by clicking its 
close box.
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What’s on the desktop?

Just as its large flat surface is the work space on your desk, the
Macintosh “desktop” is the work space on your computer. The
desktop metaphor gives you a familiar way of thinking about
how to use the Macintosh.

Aside from the field of gray that represents the “surface” of 
your work space, the Macintosh desktop has icons, windows,
and menus.

■ Icons represent containers.

■ Windows let you view the contents of containers.

■ Menus list actions that you can apply to selected containers
or their contents.

Icons represent containers

Icons can contain other icons, or they can contain information.

For example, the startup hard disk icon contains the System
Folder icon. The System Folder icon contains the programs
(more icons) that in turn contain the information the Macintosh
needs to start itself up and work properly.

Several types of icons represent different types of containers.

Hard disks and floppy disks are like filing cabinets. You use
disks to store files—your programs and the documents you
create with them.

Shared disks are like filing cabinets containing office supplies 
or records that you share with others in your work group. Your
Macintosh needs to be connected to a network before you can
use shared disks.
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Folders are like folders in a file drawer. You use folders to
organize your files.

Programs are files containing instructions to the computer that
let you do certain types of work.

Documents are files containing words, pictures, numbers,
sounds—whatever you create with your programs.

The Trash is a container for files that you no longer want.

Windows let you view the contents of containers

Windows let you see what’s “inside” all these containers. 
When you open a disk icon, the window that appears shows
you what’s on the disk. When you open the document icon
representing a memo, the window that appears shows you 
the memo.

Changing the size of a window or viewing its contents does 
not change the contents of that window. The contents remain
the same; only your view changes.

Menus offer you choices

Like the menus in a restaurant, Macintosh menus let you choose.
You choose among different actions that the computer can
perform on selected containers (icons), or on the selected
contents of containers (such as words in a memo).
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Using the keyboard

You use the keyboard to type text and numbers, just as you
would on a typewriter. (For touch typists, Macintosh keyboards
have raised dots in the middle of the D key and the K key to
help position your fingers on the home row.)

Depending on the program you’re using, you can use special
keys on the keyboard to give commands to the computer and 
to modify the effect of certain trackball actions. Macintosh
PowerBook computer keyboards have two types of special 
keys: modifier keys and arrow keys.

Modifier keys

All Macintosh keyboards have four modifier keys: Shift, 
x (Command), Option, and Control. 

Pressed by itself, a modifier key does nothing. You need to press
it in combination with another key (or while using the trackball).
The modifier key “modifies” the other key or the trackball
action, giving a different result. 

You type a capital letter, for example, by pressing the Shift key
with a letter key. Most programs let you choose commands by
pressing the x key with certain letter keys.

Arrow keys

All Macintosh keyboards have four arrow keys: Up Arrow, 
Down Arrow, Left Arrow, and Right Arrow.

Many programs let you use the arrow keys as well as the
trackball to move the pointer on the screen.

shift

ctrl option 

shift

Modifier keys Arrow keys



Working With Disks
In this chapter

■ What hard disks and floppy disks are for, and how they differ

■ How to insert and remove a floppy disk

■ How to prepare a disk for use

■ How to copy the contents of a disk

■ How to protect a floppy disk and its contents

■ How to put programs onto your computer

Before you begin

Make sure you know whether your computer has an internal
floppy disk drive, an external floppy disk drive, or no floppy 
disk drive. Refer to your setup guide if you aren’t sure.

■ If you have an internal floppy disk drive, you’re ready 
to continue.

■ If you have an external floppy disk drive, attach it to your
computer now if you haven’t already done so. See “Attaching
the External Floppy Disk Drive” in Chapter 15 for instructions.

■ If you don’t have a floppy disk drive, skim this chapter for
information about hard disks and putting programs onto 
your computer, and then continue with Chapter 4.

You need a new floppy disk to follow the steps in this chapter. 
You should be able to get floppy disks from wherever you got
your Macintosh.

If your computer is in sleep or shut down, turn it back on now.

25
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Insert a floppy disk
The internal and external floppy disk drives available for
Macintosh PowerBook computers work the same way and use 
the same kinds of floppy disks. Both floppy disk drives can
accommodate 3.5-inch (89-millimeter) floppy disks of two types:

■ high-density disks, which can hold up to 1.4 megabytes (MB)
of information

■ double-sided disks, which can hold up to 800 kilobytes (K) 
of information

(The next page explains kilobytes and megabytes.)

Follow these steps to insert your new disk into the disk drive.

1. Write “Practice” on a blank disk label.

2. Attach the label to your new floppy disk.

The molding of the disk’s protective plastic case indicates
where the label goes. Do not affix the label over the metal
shutter.

3. Hold the disk with your thumb on the label and the
metal shutter pointing away from you.

4. Push the disk into the floppy disk drive, label side up
and metal shutter first.

The next section, “Initialize a Disk,” explains what to do about
the message that appears on your screen.

Double-sided (800K) disk

Second hole

High-density (1.4 MB) disk

High-density
disk symbol
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Both floppy disks and hard disks function like filing cabinets:
you use them to store information. You can store much more on
a hard disk than on a floppy disk, however, and the computer
can retrieve information from a hard disk much faster.

Floppy disks and hard disks are represented by different icons.

The disk whose icon is closest to the upper-right corner of your
desktop is the startup disk, which contains the information the
Macintosh uses to start itself up.

Your hard disk is sealed into the hard disk drive inside your
computer. Floppy disks, in contrast, are meant to be taken in and
out of floppy disk drives so you can easily transfer information
from one computer to another.

A floppy disk is made of thin, flexible material with a magnetic
coating. To protect it and make it easier to handle, the floppy
disk itself is enclosed in a rigid plastic case, which gives the
floppy disk its “non-floppy” character. Floppy disks are
sometimes called diskettes.

Even the smallest hard disks can hold the equivalent of a few
thousand pages of information. High-density floppy disks can
hold 1.4 megabytes (MB) of information—about 300 typewritten
pages. Double-sided floppy disks can hold 800 kilobytes (K) 
of information—about 200 typewritten pages. (A megabyte is
about 1,000 kilobytes.)

40 MB20 MB1.4 MB800K4K

5,000 pages

300 pages
200 pages

1 page

10,000 pages

Floppy disks Hard disks 



Initialize a disk
Every new disk needs to be prepared for use. Preparing a new
disk is called initializing it. In the same way that lines are drawn
on a newly paved parking lot to mark off parking spaces, the
initializing process creates organized areas on the disk where the
computer can store information. Your computer’s hard disk was
initialized at the factory, but you need to initialize any new floppy
disks you want to use.

1. Read the message on your screen.

The computer requests information from you or warns you
about the consequences of an action by presenting a message
in the form of a dialog box.

If you inserted a high-density disk, this dialog box appears:

If you inserted a double-sided disk, this dialog box appears:

2. If you see the first box, click Initialize. 
If you see the second box, click Two-Sided.

Another dialog box appears:

This dialog box appears because you can initialize old disks as
well as new ones—and the computer doesn’t know whether
the disk in the drive is old or new. Initializing erases all
information on a disk. In this case, because the floppy disk is
new, there is no information on it to erase.

3. Click Erase.

A third dialog box appears:

4. Type “Practice”.

If you make any typing errors, press the Delete key to
backspace over them.
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5. Click OK.

The computer takes about a minute to initialize the disk.
Messages appear on the screen to let you know how the
process is going.

When initialization is finished, the disk’s icon appears directly
below the Macintosh HD icon (the startup hard disk icon) near
the upper-right corner of the desktop.

Copy the contents of a disk
Most programs you’ll use with your Macintosh are supplied on
one or more floppy disks. You can use a program more efficiently
if you first install it on your hard disk. You install most programs
by copying them from the floppy disk to your hard disk.

To practice copying the contents of a floppy disk to your hard
disk, use your practice disk (even though there’s nothing on it).

1. Drag the Practice floppy disk icon to the Macintosh HD
icon until both icons are highlighted, and then release
the trackball button.

Both icons are highlighted when the tip of the arrow pointer
reaches the Macintosh HD icon.

When you release the trackball button, the Macintosh copies
the contents of the Practice disk onto Macintosh HD (your
hard disk).

Now, find the copy of Practice you just created.

continues >
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2. Click the Macintosh HD icon to select it.

3. Choose Open from the File menu.

You choose Open by pointing to the File menu title, pressing
to pull down the menu, dragging to the Open command, and
then releasing the trackball button.

The Macintosh HD window appears, showing you the
contents of the hard disk. The contents should include a new
folder called Practice, which the computer created when it
copied the contents of the Practice disk to Macintosh HD.

You may have to make the window larger or use the scroll
bars to see the Practice folder.

4. Click the Practice folder icon to select it.

5. Choose Open from the File menu.

The folder holds the contents of the floppy disk you’ve copied.
In this case, the folder is empty because there’s nothing on the
Practice disk.

6. Close all the windows on the Macintosh desktop.

You close a window (when it’s the active window) by either
clicking its close box or choosing Close Window from the 
File menu.
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Taking care of floppy disks

Follow the care instructions that came with your disks, and
remember three key points:

■ Keep floppy disks away from magnets. Because
information is stored on the disk in the form of magnetic
signals, a magnetic field can destroy that information.
Televisions and monitors, telephones, loudspeakers, and
certain kinds of lighting fixtures all contain magnets.

■ Protect disks from extremes of temperature and humidity. 

■ Do not open the disk’s metal shutter. Touching the disk
inside the shutter could damage it.



Take a floppy disk out of its drive
You take a floppy disk out of its drive when you no longer need 
to get information from or store information on that disk.

1. Click the Practice floppy disk icon to select it.

Click the icon, not its name.

2. Eject the floppy disk by choosing Put Away from the
File menu.

You choose Put Away by pointing to the File menu title,
pressing to pull down the menu, dragging to the Put Away
command, and releasing the trackball button.

Put Away returns the object you’ve selected to its original
place. In this case, it ejects the floppy disk from the disk 
drive so you can put it away.
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Protect the contents of a disk
You can lock a floppy disk so its contents cannot be changed in
any way. When a disk is locked, you cannot modify the files on it,
delete any files, or store any new files.

Use your practice disk to practice locking and unlocking a 
floppy disk.

1. Hold the practice disk with your thumb on the label
and the metal shutter pointing away from you, as
though you were going to insert the disk into a drive.

2. Find the square hole in the near-left corner of the
floppy disk.

A moveable tab on the back side of the disk should be
blocking the hole, indicating that the disk is unlocked.

If you’re using a high-density disk, you’ll notice an additional
square hole, across the label from the first hole. This second
hole has no moveable tab and is always open.

3. Turn the disk over and lock it by sliding the tab so that
the square hole is open.

Use your thumbnail or a push pin to move the tab.

4. Unlock the disk by sliding the tab back so that the
square hole is blocked.

You are unlocking your practice disk now so you can use it 
to store files in the next chapter.

UnlockedLocked
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Use the Trash
When you no longer need a file or a folder, you can throw it 
away by dragging its icon to the Trash. Practice using the Trash by
throwing away the Practice folder, which you created when you
copied the contents of your Practice disk onto Macintosh HD.

1. Click the Macintosh HD icon to select it.

2. Choose Open from the File menu.

The Macintosh HD window appears, showing you the
contents of the hard disk. You may have to make the window
larger or use the scroll bars to see the Practice folder.

3. Drag the Practice folder icon to the Trash icon until
both icons are highlighted, and then release the
trackball button.

If the Macintosh HD window is blocking the Trash icon, move
the window by dragging its title bar.

Both icons are highlighted when the tip of the arrow pointer
reaches the Trash icon.

When you release the trackball button, the Practice folder
“disappears” into the Trash. When you put an object in the
Trash, the Trash icon bulges to indicate that it is no longer
empty.

continues >
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4. Open the Trash icon.

(Click to select the icon, and then choose Open from 
the File menu.)

The Trash window appears. Anything you drag to the Trash
stays there until you empty the Trash.

You can retrieve items from the Trash by clicking to select
them and then choosing Put Away from the File menu. 
(Or you can drag the items back to where they were.)

5. Choose Empty Trash from the Special menu.

A message appears asking you to confirm that you want to
permanently remove the contents of the Trash.

6. Click OK.

Clicking OK empties the Trash—in other words, its contents
are erased from the disk.

Notice that the Trash icon no longer bulges, indicating that 
it is empty.

7. Close the Trash window by clicking its close box.

On your own: Install your programs
■ If you have a floppy disk drive and disks containing programs

that you plan to use with your Macintosh, you can install the
programs on your hard disk now (or you can wait until later
and continue with Chapter 4).

■ If you do not have a floppy disk drive, you need to install 
your programs over a network (Chapter 8) or by connecting
your computer directly to a desktop Macintosh (Chapter 15).
Continue with Chapter 4 now and install your programs later.

The general instructions in this section describe how to copy the
contents of a program disk to your hard disk.

▲s▲s Important: Some programs need to be installed in a particular
way. If your programs came with specific instructions, follow
them instead of the instructions in this section. ▲s▲s
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1. Lock the program disk.

The program disk contains your master copy of the program.
Locking the disk protects its contents but doesn’t keep you
from copying the contents onto another disk.

2. Insert the program disk into your floppy disk drive.

3. Drag the program disk icon to the Macintosh HD icon
(your hard disk icon) until both icons are highlighted,
and then release the trackball button.

Both icons are highlighted when the tip of the arrow pointer
reaches the Macintosh HD icon.

When you release the trackball button, messages appear on
the screen to let you know that the computer is copying the
contents of the program disk onto your hard disk.

When the copying process is finished, the contents of the
program disk appear on your hard disk in a folder that has 
the same name as the program disk.

4. Eject the program disk by selecting it and then
choosing Put Away from the File menu.

5. Open the Macintosh HD icon.

The Macintosh HD window shows you the contents of 
your hard disk. Among its contents is the program folder,
which contains the same items as the original disk.

6. Click the program folder to select it.

7. Choose Open from the File menu.

The folder window appears, showing you the contents of 
the program folder. The folder has the same contents as the
program disk.

8. Look for a System Folder in the program folder.

Some program disks contain a System Folder so they can be
used as startup disks. (A startup disk, by definition, is a disk
that has a System Folder on it.) If the program disk you’ve
copied has a System Folder, you now have two System Folders
on your hard disk. For the computer to work properly, you
must throw away any extra System Folders.
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Throw away extra System Folders

Your startup disk must have only one System Folder on it.
Whenever you copy the contents of a program disk to your hard
disk, make sure that you have not copied an extra System Folder.
If you have, throw the extra System Folder away.

1. Drag the extra System Folder from the program folder
to the Trash.

2. Choose Empty Trash from the Special menu.

A message alerts you that you’re about to throw away the
contents of the Trash (in this case, the extra System Folder).

3. Click OK to confirm that you want to throw away the
contents of the Trash.

4. Close the program folder window by clicking its 
close box.
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Creating a Document
In this chapter

■ How to open a program

■ How to use a program to create a document

■ Why it’s important to save your work, and how to save it

■ How to switch between programs

■ How programs and system software differ from each other

■ How to close a document

Before you begin
If your computer is in sleep or shut down, turn it back on now.
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Open a program
Your computer comes with a simple word-processing program
called TeachText. You’re going to use this program to create a
document.

1. If you closed the Macintosh HD window when you
finished Chapter 3, open the Macintosh HD icon now.

(Click the icon to select it, and then choose Open from the 
File menu.)

The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the 
TeachText program.

2. Open the TeachText icon.

(Click the icon to select it, and then choose Open from 
the File menu.)

When you open the TeachText program, you notice one dramatic
change on your desktop:

■ A window called “Untitled” appears.

You also notice two subtle changes:

■ The menu bar shows the menu titles for the TeachText
program.

■ The Application menu icon in the right corner of the menu bar
becomes the TeachText icon.

The untitled window is empty because you haven’t written
anything in it. In the next few sections, you’re going to write 
a short document, save it, and give it a name.

����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

	�
� ��
����

�	�� 	����������������	���� �����

���� �	�� �	����������	����� ���

�� ���� �����	������������	�������������������

�� �� � ������������ ������!���������� ������������	�����������"��������

�� �	���#���� ������� �������!���� ������������!�	�������������������

�� ���������� �����������	����� �����	������������� ��!	������!	��������������������

�� �������� ���������������� ������������������ ��!���������	�������������� ������

�� �������� ������������������ �������������������� ��!��!����$�"%����������#�������

�� ���������� ����������������� ������������������ �� ����"%�"%�����������&�����

�� ���������� ������������� ������������������ ��!��!��!"��"'�����
�	��������

�� �"%������� ���������������� ������������������ ������������!�"��!�	���������

�� "

�

�� �����������"
��
� �������"
���������"
� �"���������"����	��� ���

�� ���	��������
����"����	���� ���

�� ��	��� "���	��� ���

�� ���� �"�(���� ���

�� ���� "

� ���

�� ���

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

�� ���

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

���� ���� ���

���� ��������������������������������������������������������

���� ���� ���

������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������ �����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

���������� ���������������������� �� ��������!���� ���

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������!�����������!������� ��!������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

���������� �����������������������������	������	����� ��������!���� ���

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������!���������������������������������������!�������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

���������� ��������������������������������������� ��������!���� ���

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������!����������������������������������������!���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

���������� ������������������������������!����� �����!���� ���

�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������!���������������������������������������!����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

���������� "
��
���������"
������"
�����"
��
��"
���� �����!���� ���

������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������ ����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

���� ���� ���

���� ���������������������������������������������������������

���� ���� ���

������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������

������ �������� ���

������ �������������������������������������������������������������

������ �������� ���

������ ������������������������������������������������������������

������ �������� ���

������ ���������������� ��������������������

������ ������������������������������������������ ���

������ ��������������������������������������������������������������������

������ ���������������������������������������� ���

������ ���������������������������������������������������������������������

������ ���������������������������������������� ���

������ ��������������������������������������������������������������������

������ ���������������������������������������� ���

������ ����������������������������������������������&����������������������

������ �������������
�
�
�
�
�
�
�
�
�
�
�
�
�
�� ���

������ ����������������� ���������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ���������������������������������������������������������������������������

���� ��������������������������������������������������������������������!���

���� ���������������������������������������������������������������������������

���� �����������������������������������������������������������	�������!���

���� ��������� �����������������������������������������������������������������

���� ��������������	����	�������	�������	��������	���������������������!���

���� �������"������
��"����������������"����)��������������������������������

���� ����������������������������������������	��������������������������!���

���� ������������)����	�������������	��	������� ��������������������������������

���� ������������������"����������������"����"�����������������"�������!���

���� ���������������������������������������������������������������������������

���� ��������������������������������������������������������������������!���

���� ���������������������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �����������������������������������������������������������������

���� �������������� ���

���� ������������������������������������������������������������������

���� ��������������� ���

���� ��������������������������������������������������������������������

���� ��������!�������� ���

���� ��������!������������������������������������������������������������

���� ��������!�������� ���

���� ��������������������������������������������������������������������

���� ���%����������� ���

���� �������������������������������������������������������������������

���� ����!�������� ���

���� ����!�������������������������������������������������������������

���� ����!�������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� ���������������������������������������(�����������������������

���� �������� ���"��� ���

���� ���������������������������	��������������������������������������

���� �������� 	��� �� ���

���� �������������������������������������������������������������������

���� �������� �� �� ���

���� ����������������������������� ��������������������

���� �������� ���������������������� ���

���� ������������������������������������������������������������������

���� �������� ������������������ ���

���� �������������������������������������������������������������

���� �������� ������������������ ���

���� ��������������������������������������������������������������

���� �������� ������������������ ���

���� �������������������������������������������������������������

���� �������� ������������������ ���

���� ��������������������������������������������������������������

���� �������� ������������������ ���

���� �������������������������������������������������������������

���� �������� ������������������ ���

���� ��������������������������������������������������������������

���� �������� ������������������ ���

���� �������������������������������������������������������������

���� �������� ������������������ ���

���� ��������������������������������������������������������������

���� �������� ������������������ ���

���� �������������������������������������������������������������

���� �������� ���������������������� ���

���� ������������������������������������������������������������������

���� �������� �� ���� ���

���� ����������������������������* ��������������������

���� �������� "
����������������
� ���

���� ������������������������� ��������������

���� �������� ���

���� ������������������������������ ���������������

���� �������� �� �� ���

���� ������������������������������(�������	������������������������

���� �������� ���������"��$ ����+�� ���

���� �����������������������!�������	����"
��������������������

���� �������� �������$ ����)&����� ���

���� ���������������������������������"
�����
���������������������

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������� ���

���� ����������������������� ������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

���� �������� ���

���� �������������������������������������������������������������

���� �������� ���

���� ������������������������������������������������������������

�*�� �������� �����

��������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������%����

�������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������� )��

�"�����������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������(���

"
�* ���
���

�
���������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������������
����

38 Chapter 4: Creating a Document

TeachText menu titles

TeachText icon



Create a document
The untitled window is like a blank sheet of paper. In the 
upper-left corner of the empty document is a blinking vertical 
line. This line is called the insertion point, because it marks 
the place where the text you type will be inserted.

As you type, use the Macintosh keyboard as you would a
typewriter keyboard, except:

■ If you make a mistake, press the Delete key to backspace 
over it.

■ Don’t press the Return key when you get to the end of a 
line. Keep typing, and words will move to the next line
automatically.

Type the following text:

Sailing across an unknown sea, we saw the

lights of a city in the distant horizon. Was

it another strange land, with strange and

cruel people speaking different languages,

eating different food, wearing different

clothes? We wished it were home.

You will be changing this text in the next chapter.

Save your work
Work that you do in a program exists only in the computer’s
memory until you save it onto a disk. Since work that exists only
in memory is lost when you shut down the computer, you need 
to save your work so you can come back to it later. If you don’t
save your work, it disappears—like thoughts that are lost unless
you write them down.

1. Choose Save from the File menu.

The dialog box that appears lets you name the document and
save it on your hard disk.

continues >
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2. Type “Opening Lines”.

Because the word “Untitled” is selected (highlighted) when
the dialog box appears, all you have to do to name your
document is start typing. Whatever you type replaces the
selected text.

3. Click Save.

The window is now titled “Opening Lines” and the document
has been stored on your hard disk.

Switch programs
You can have several programs open on your Macintosh desktop
at one time (how many depends on how much memory your
computer has and how much memory the programs use). But
only one program at a time can be the active program. The active
program is the one that’s “on top of ” other open programs—in the
same way that the active window is on top of other windows.

The Opening Lines window is now the active window, and
TeachText is the active program. But TeachText is not the only
program that’s open.

Since you turned on your computer, you’ve been working with the
Finder™ program. The Finder displays the Macintosh desktop. The
Finder is always open when your Macintosh is on, so right now it
is open but not active.

1. Make the Opening Lines window smaller by dragging 
its size box up and to the left, and then release the
trackball button.

After you resize the window, you should be able to see your
hard disk icon in the upper-right corner of the desktop.
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2. Make the Finder the active program by clicking the
Macintosh HD icon, or clicking anywhere on the
desktop outside the Opening Lines window.

The Finder becomes the active program. Notice:

■ The Macintosh HD window appears on top of the
Opening Lines window.

■ The menu bar shows the Finder’s menu titles.

■ The Application menu icon at the right end of the 
menu bar becomes the Finder icon.

You may also notice the Opening Lines icon in the 
Macintosh HD window, representing the document you 
just created and saved.

3. Make the Opening Lines window active by clicking
anywhere inside it.

(Part of the window may be hidden by the Macintosh HD
window.)

When you click, the Opening Lines window comes back to
the top. It’s now the active window again, and TeachText is 
the active program.

You make a window active by clicking any visible part of it.
The program that “owns” the window becomes active when
the window becomes active.

continues >
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Here is another way to make a program active:

4. Make the Finder the active program by choosing 
Finder from the Application menu at the right end 
of the menu bar.

You choose Finder by pointing to the Application menu icon,
pressing to pull down the menu, dragging to highlight the
name Finder, and then releasing the trackball button.

The Finder becomes the active program, and the 
Macintosh HD window becomes the active window.

5. Make TeachText the active program by choosing
TeachText from the Application menu.

TeachText becomes the active program, and the Opening Lines
window becomes the active window.

All open programs are listed in the Application menu. You can
use the Application menu to choose which program to make
active. The icon in the menu bar (representing the “title” 
of the Application menu) is always the icon of the currently
active program.
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Close a document
When you close a document, you do not close the program that
you used to create it. (Closing a program is called quitting.) The
program remains open and active until you quit the program or
make another program active.

1. If the Opening Lines window is not the active window,
click anywhere inside it to make it active.

2. Close the Opening Lines window.

You can either click the close box near the left end of the title
bar, or choose Close from the File menu.

The Opening Lines window closes but TeachText is still the active
program. Notice:

■ The menu bar still shows the TeachText menu titles.

■ The Application menu icon at the right end of the menu bar 
is still the TeachText icon.

Two types of programs

Programs that you use to do your work on the computer are
called application programs, or applications, because they’re
ways of applying computer technology to the work that you do.

Word-processing programs, for example, are applications 
that enable you to write memos, novels, or whatever you 
need to write. And if your work involves creating illustrations,
designing buildings, composing music, or keeping track 
of large amounts of data, there are application programs for
those kinds of work, too.

Because most Macintosh programs work in similar ways, 
you can transfer most of what you learn in one application 
to other applications.

Programs that the computer uses to do its work (in contrast 
to your work) are called system software, or sometimes the
operating system.

And then there’s the Finder

Between you and the system software is an application
program called the Finder, which is the program that displays
the Macintosh desktop. It’s called the Finder because, like the
viewfinder in a camera, it gives you a view of all the objects—
disks, programs, folders, and documents—on your desktop.

You use the Finder to tell the system software what you want it 
to do for you: which disks you want to use, which documents
you want to open, and where you want files to be stored.
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Opening and closing documents and programs

Doing this Also causes this

Opening a document Opens the program that created 
that document

Making a document Makes the program that “owns” 
window active that document active

Closing a document Simply closes that document; does
not close the program that created 
that document

Quitting a program Prompts you to save your work, 
then closes the program that created 
the active document



Changing a Document
In this chapter

■ How to open a document

■ How to change a document

■ What “keyboard shortcuts” are and how to use them

■ How to quit a program

■ How to make a backup copy of a document

Before you begin

If your computer is in sleep or shut down, turn it back on now.
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Open a document
When you open a document, the program you used to create that
document becomes the active program.

1. If you closed the Macintosh HD window when you
finished Chapter 4, open the Macintosh HD icon now.

(Click the icon to select it, and then choose Open from the 
File menu.)

The Macintosh HD window appears, showing you the
contents of your hard disk. The contents include the TeachText
program and the TeachText document called Opening Lines,
which you created in Chapter 4.

The next step describes a different way to open an icon.

2. Open the Opening Lines icon by double-clicking it.

To double-click an icon, you click it twice in rapid succession
without moving the pointer. (Use the trackball to position 
the pointer over the icon, and then click one of the trackball
buttons twice.) Double-clicking an icon has the same effect as
selecting the icon and then choosing the Open command.

When you open Opening Lines, TeachText becomes the active
program. Notice that:

■ the Opening Lines window appears

■ the menu bar shows the TeachText menu titles

■ the Application icon at the right end of the menu bar is the
TeachText icon

Change a document
The Opening Lines window shows you the text you typed in
Chapter 4. In this section you’ll make some changes to the text
using techniques that work in most Macintosh programs.

Keep two things in mind:

■ The insertion point—the blinking vertical line—marks the
place where anything you type will appear.

■ A pointer called an I-beam replaces the arrow pointer when
you’re working with text. You control the I-beam pointer 
with the trackball in the same way that you control the 
arrow pointer.
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1. Locate the insertion point. It should be in the upper-left
corner of the document.

2. Locate the I-beam pointer. If you don’t see it, roll the
trackball slightly. The pointer moves as the trackball
moves.

Now you’re ready to insert some text.

3. Move the I-beam pointer to the immediate left of the
word “an” (after “Sailing across”).

4. Click the trackball button once.

Clicking moves the insertion point to the spot where you
positioned the I-beam. Whatever you type next is inserted 
at that point.

5. Type the words “the blackness of space, adrift in”.

If you make any typing errors, press the Delete key to
backspace over them.

Now you’ll change some text.

6. Move the I-beam pointer to the immediate left of the
word “lights” (after “we saw the”).

7. Drag horizontally, selecting the word “lights”, and then
release the trackball button.

To drag, hold the trackball button down while you roll the
trackball. The selected word is highlighted (surrounded by
black).

If you select more or less than you intended to, go back to
step 6 and try again.

continues >
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8. With “lights” selected, type the words “clear blue”.

The words you type replace the word you selected. (Press 
the Delete key to backspace over any typing errors.)

9. Now move the I-beam pointer to the immediate left of
the word “city” (after “of a”).

10. Drag horizontally, selecting the word “city”, and then
release the trackball button.

11. With “city” selected, type the word “planet”.

The word you type replaces the word you selected.

12. Move the I-beam pointer between the letters “n” and “t”
in the word “distant” (after “in the”).

13. Drag to select the letter “t” and the word “horizon”, and
then release the trackball button.
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14. With “t horizon” selected, type the letters “ce”.

If the period is missing after “distance”, type one now.

(Press the Delete key to backspace over any typing errors.)

Save your work so far
The changes you’ve made so far are not part of Opening Lines
until you save them. You save them by telling the computer to
record them in the Opening Lines document that’s stored on 
your hard disk.

It’s important to remember that no change is “official” until 
you save it onto a disk. Your work could be lost if power 
to the computer were interrupted or if a problem with a 
program caused the computer to stop working properly.

Choose Save from the File menu.

Save regularly, and save often.

Taking a shortcut

You can choose some menu commands by using the keyboard
instead of the trackball. A keyboard shortcut is a combination
of keys that you press at the same time to get the same result
as choosing a command from a menu. One of the keys you
press is always the x key or another modifier key.

For example, instead of choosing Save from the File menu,
you can hold down the x (Command) key on the keyboard
while you press the S key. Pressing x-S is a keyboard shortcut
equivalent to choosing Save from the File menu.

You can see the available keyboard shortcuts by pressing a
menu title and looking at the commands in the menu. The
keyboard shortcuts are listed next to the commands.
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Make more changes
The changes you’ve made so far are now part of the document
that’s stored on your hard disk.

Now you’re going to move some text to a different place in the
paragraph.

1. Move the I-beam pointer to the immediate left of the
words “ We wished” (at the beginning of the last
sentence).

2. Click the trackball button once.

Clicking moves the insertion point to the spot where you
positioned the I-beam.

3. Move the I-beam pointer between the letter “e” in
“home” and the period at the end of the last sentence.

4. Hold down the Shift key on your keyboard and click 
to select the words “ We wished it were home”.

Holding down the Shift key while you click selects the text
between the insertion point and wherever you click.

5. With “ We wished it were home” selected, choose Cut
from the Edit menu.

Choosing Cut removes the selected material from the
document and stores it in a small temporary file called 
the Clipboard.
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6. Move the I-beam pointer to the immediate left of the
word “ Was” (in “ Was it another strange land”).

7. Click to place the insertion point.

8. Choose Paste from the Edit menu.

When you choose Paste, the Macintosh takes whatever’s in the
Clipboard and puts it into the document at the location of the
insertion point.

Next, you’ll delete a sentence.

9. Drag the I-beam pointer across the words “Was it
another strange land” to select them, and then release
the trackball button.

If the words are on two lines, drag down to the second line
and release the trackball button when the pointer is to the
immediate right of the word “land”.
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10. With “ Was it another strange land” selected, choose
Clear from the Edit menu.

When you choose Clear, the Macintosh removes the selected
text from the document. (Pressing the Delete key once has 
the same effect.)

11. Select the word “cruel” (after “strange and”) by double-
clicking it.

To select a word by double-clicking it, position the I-beam
pointer over the word and then click twice in rapid
succession, without moving the pointer.

12. With “cruel” selected, type “wonderful”.

The word you type replaces the word you selected.

13. Drag the I-beam pointer across the question mark (after
“different clothes”) and the stray period at the end of
the paragraph, and then release the trackball button.

14. With the question mark and the period selected, type 
a period.

You may now have extra spaces or no spaces between words.
If so, position the I-beam pointer where you need to delete 
or add a space, click to place the insertion point, and press 
the Delete key or the Space bar as necessary.

15. Choose Save from the File menu.
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Quit a program
Quitting a program closes the program as well as any open
documents that were created using that program. (Simply closing
a document, which you did at the end of Chapter 4, leaves the
program open and active.)

1. Make sure that the Opening Lines window is active.

2. Quit the TeachText program.

You can either choose Quit from the File menu, or press 
the x key and the Q key together.

If a message asks whether you want to save any changes, 
click Save.

The Opening Lines document and the TeachText program are
closed, and the Finder becomes the active program.

Make a backup copy of a document
Storing a copy of your work on another disk is a wise practice, 
like saving often. Occasionally a file or an entire disk becomes
damaged and you can no longer use your original document. 
(It seldom happens, but even once is too often.) If you have a
backup copy of the document on another disk, you can continue
working without interruption.

To practice making a backup copy, put a copy of Opening Lines
on your practice disk.

(If you don’t have a floppy disk drive, you’re finished with this
chapter. Turn now to Chapter 6.)

1. Make sure the disk is unlocked.

The moveable tab on the back side of the case should be
blocking the square hole near the lower-left corner (when 
you hold the disk as if to insert it), indicating that the disk 
is unlocked.

2. Insert the disk into your computer’s floppy disk drive.

The Practice disk icon appears on the desktop, directly below
the Macintosh HD icon.

continues >
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3. Drag the Opening Lines icon to the Practice disk icon
until both icons are highlighted, and then release the
trackball button.

Both icons are highlighted when the tip of the arrow pointer
reaches the Practice disk icon.

When you release the trackball button, the computer copies
the Opening Lines document onto the Practice disk.

You copy an icon by dragging it to a different disk. When you
drag it elsewhere on the same disk, you are only moving it to
a new location in the window.

4. Open the Practice disk icon.

Click the icon to select it and then choose Open from the 
File menu, or double-click the icon.

The Practice disk window appears, showing that a backup
copy of the document, also called Opening Lines, is stored 
on the floppy disk.

5. Eject the Practice disk from the disk drive.

Make sure the Practice disk icon is selected, and then 
choose Put Away from the File menu. The Practice window
disappears when you eject the Practice disk.
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Organizing Your Work
In this chapter

■ How to duplicate a document

■ How to change an icon’s name

■ When and how to use the Save As command, and how it
differs from the Save command

■ How to organize icons in a folder

■ What an alias is and how to use one

■ How to create a stationery pad

Before you begin

This chapter covers some basic tasks related to manipulating icons
on your desktop. The usefulness of some of these tasks will be
more apparent after you have been using your Macintosh for a
while. You can go through this chapter now if you are interested;
or you can skip to Chapter 7 now and then turn to the programs
you bought to use with your computer.

If your computer is in sleep or shut down, turn it back on now.
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Duplicate a document
You’ll often want to make a copy of a document so you can
preserve the original and modify the copy. To practice making a
copy of a document you’ll first create a new document.

1. If your hard disk window is closed, open the hard disk
icon.

2. Open the TeachText icon.

An untitled window appears.

3. Type the following text.

Dear Mom and Dad,

This letter is overdue, I know, but until
I sat down to write, I had no idea how
long overdue it is. Time sure flies when
you don’t have enough of it.

Julie and I are doing well. The dog is
getting better all the time. How are you
all?

Remember:

■ If you make a typing mistake, press the Delete key to
backspace over it.

■ When you get to the end of a line, keep typing. Don’t
press the Return key.

■ Press the Return key only when you want to start a new
paragraph.

■ The insertion point—a blinking vertical line—marks the
place where whatever you type next will appear.

■ An I-beam pointer replaces the arrow pointer when 
you’re working with text. You control the I-beam pointer
with the trackball in the same way that you control the
arrow pointer.

4. Choose Save from the File menu.

The dialog box that appears lets you name the document 
and store it on your hard disk.
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5. Type “Letter to Parents”.

Because the word “Untitled” is already selected (highlighted)
when the dialog box appears, all you have to do is start
typing. The words you type replace the selected text.

6. Click Save.

The window is now titled “Letter to Parents” and the
document has been stored on your hard disk.

7. Close the Letter to Parents window.

(Click the close box near the left end of the title bar, or 
choose Close from the File menu.)

The window closes, and TeachText remains the active
program.

8. Click the hard disk icon, the hard disk window, or
anywhere on the desktop.

The Finder becomes the active program. Among the contents
of the hard disk window is the Letter to Parents icon,
representing the document you just created and saved.

9. Locate the Letter to Parents icon in the hard disk
window.

You may have to make the window larger or use the scroll
bars to find it.

10. Click the Letter to Parents icon to select it.

continues >
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11. Choose Duplicate from the File menu.

A new icon, labeled “Letter to Parents copy”, appears in the
hard disk window. Notice that the icon is selected.

Change the name of an icon
You can change the name of any icon, using any characters except
a colon (:). If you change an icon’s name and then open it, you’ll
see that the name of its window has also changed.

1. Drag the “Letter to Parents copy” icon away from the
original icon so that the two icons do not overlap.

2. Click the name (not the icon) “Letter to Parents copy”;
do this even if the icon is already selected.

When the name is selected, it is highlighted and a box appears
around it. Notice that when you point to the selected name,
the arrow pointer becomes an I-beam.

3. With the name selected, type “Letter to Sister”.

(Or drag the I-beam over the words “Parents copy” to select
them, and then type “Sister” to replace them.)

Whatever you type replaces the selected text.
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4. Press the Return key.

Pressing Return saves the new name.

Now you have two identical documents with different names.
You can revise one without changing the other.

5. Open the Letter to Sister icon.

6. Drag the I-beam over the words “Mom and Dad” to
select them.

7. Type “Sis”.

The word you type replaces the words you selected.

8. Choose Save from the File menu.

9. Choose Close from the File menu.

(Or click the close box near the upper-left corner of the Letter
to Sister window.)

You now have two slightly different versions of your letter:
one for your parents and one for your sister.

TeachText remains the active program.
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Save a different version of a document
There is another way to create a different version of a document:
by saving a copy of that document under a different name.

1. Click the hard disk icon, the hard disk window, or
anywhere on the desktop.

The Finder becomes the active program.

2. Open the Letter to Parents icon.

3. Drag the I-beam over the words “Mom and Dad” to
select them.

4. Type “Juan”.

5. Choose Save As from the File menu. Do not choose
Save.

Choosing Save would change the original letter (so that the
letter to your parents would begin, “Dear Juan”).

Choosing Save As, in contrast, lets you create a new document
identical to the original except for the changes you just made.
The original document remains unaltered.

The dialog box that appears lets you name the new document
and tell the computer where you want to store it. “Letter to
Parents,” the name of the original document, is already
selected and ready to be changed.
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6. Type “Letter to Juan”.

7. Click Save.

The new document, “Letter to Juan,” now appears in the active
window, replacing the original document, “Letter to Parents.”
Notice that the window’s title bar now says “Letter to Juan”.

If you were to open the original document, you would find
that the first line is still “Dear Mom and Dad”.
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Choosing Save stores the changes you’ve made to the active
document (the document in the active window) since you
opened it, or since the last time you chose Save.

Choosing Save As, on the other hand, creates a new document
that includes the changes you’ve made. Save As sets aside the
original document without storing the most recent changes to
it. In other words, the original document remains the way it
was when you opened it (or last saved changes to it).

When you give the new document a name, it replaces the
original document in the active window. The title bar of the
active window shows the name of the new document.



Open a document 
while its program is active
You can open a document without first making the Finder active
and then opening the document icon on the Macintosh desktop.
Whenever a program is active, you can open any document
created with that program.

1. Close the document called Letter to Juan.

TeachText remains the active program.

2. Choose Open from the File menu.

The dialog box that appears lets you select the document you
want to open.

3. Click Letter to Parents to select that document.

4. Click the Open button.

The Letter to Parents document window appears.

Organize icons in a folder
Sooner or later, you’ll have more documents and programs on
your Macintosh desktop than you can see at a glance. The
Macintosh offers numerous tools and techniques (all explained in
Part II of this book) to help you manage your files. Creating a
folder and putting files in it is the simplest way to get organized.

1. Choose Quit from the File menu.

The Finder becomes the active program.
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2. If your hard disk icon is not open, open it.

Your hard disk window should be the active window.

3. Choose New Folder from the File menu.

An icon named “Untitled folder” appears in the hard disk
window. The icon, including its name, is already selected.
(The name is highlighted and has a box around it.)

4. Type “Letters to Family” and press Return.

If nothing happens when you type, click the name of the icon
so that a box appears around it, and then try again.

5. Drag the Letter to Parents icon to your new folder icon
until both icons are highlighted, and then release the
trackball button.

6. Drag the Letter to Sister icon to the new folder icon.

The Letters to Family folder now contains Letter to Parents and
Letter to Sister. You can open the Letters to Family folder icon
if you want to see the document icons.
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Use an alias
As you work, you may find it handy to store a program or a
document in several different folders, so you can open it quickly
from any of those folders.

1. If your hard disk icon is not open, open it.

Your hard disk window should be the active window.

2. Choose New Folder from the File menu.

An icon named “Untitled folder” appears in the hard disk
window. The icon and its name are already selected.

3. Type “October Letters”.

4. Open the Letters to Family folder icon.

5. Click Letter to Sister to select it.
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What’s an alias?

An alias is a representation of a program, a folder, or a
document. It is not a copy of the program, folder, or document.
An alias merely “points” to the original file that it represents.
When you open an alias (in the same way that you would
open the original file), you’re actually opening the original file.
Any changes that you make and save are stored in the original
file, so you see them when you open any of the aliases for 
that file. You can make as many aliases for a program, folder,
or document as you want.

Why would you want to make aliases for a file? You could
make several copies of the file instead—but each copy would
take up much more room on your disk than an alias would.
And if you wanted the copies to remain identical, you’d have
to change every copy each time you changed one copy.

Using aliases helps you find your important files more easily,
and saves space on your disks.



6. Choose Make Alias from the File menu.

An icon named “Letter to Sister alias” appears on top of the
Letter to Sister icon. The icon and its name are already
selected.

Note that the name of the alias appears in italics. This is so you
can tell which icons are aliases.

7. Drag the Letters to Family window aside until you can
see the October Letters folder in the hard disk window
behind it.

8. Drag the Letter to Sister alias to the October Letters
folder in the hard disk window, and then release the
trackball button.

You may have to change the size and position of the Letters 
to Family window so you can see both icons.

9. Open the October Letters folder icon.

10. Open the Letter to Sister alias icon.

The document Letter to Sister opens, and TeachText becomes
the active program.

The insertion point should be at the beginning of the
document, to the left of the D in “Dear”.

continues >
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11. Type “16 October 91” and press the Return key once.

12. Choose Save from the File menu.

13. Choose Close from the File menu.

The Letter to Sister document closes, and TeachText remains
the active program.

You can open the original Letter to Sister icon (in the Letters 
to Family folder) and see that it is now dated 16 October 91.

Letter to Sister is now available in both the Letters to Family
folder and the October Letters folder. By keeping the original
document in one folder and an alias of that document in 
the other folder, you have access to the same letter from 
either folder.

14. Quit TeachText.

15. Close all the windows on the desktop.

Create a stationery pad
You may find it convenient to create a document that serves as the
computer equivalent of stationery, like a memo pad or “While You
Were Out” forms. Each time you need a sheet of this “stationery”
you can take one from your endless supply and fill it in.

To practice creating a stationery pad, you’re going to create a
TeachText document that works like a memo pad.

1. Open TeachText.

An untitled TeachText window appears.

2. Type the following text:

DATE:

TO:

FROM: [Type your name here]

RE:
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3. Choose Save from the File menu.

The dialog box that appears lets you name the document 
and tell the computer where to store it.

If Macintosh HD (or the name of your own hard disk) does
not appear above the list on the left side of the dialog box,
click the disk name above the word Eject.

4. Type “Memo Pad”.

Because the word “Untitled” is already selected (highlighted)
when the dialog box appears, all you have to do is start
typing. The words you type replace the selected text.

5. Click Save.

The window is now titled “Memo Pad” and the document 
has been stored on your hard disk.

6. Close the Memo Pad document.

TeachText remains the active program.

7. Click the hard disk icon or the hard disk window.

The Finder becomes the active program, and the hard disk
window becomes the active window. Among its contents is 
the Memo Pad document icon.

8. Click the Memo Pad icon to select it.

9. Choose Get Info from the File menu.

The Info window that appears contains information about the
selected icon.

continues >
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10. Click “Stationery pad” near the lower-right corner of
the Info window so an X appears in the checkbox.

Clicking “Stationery pad” converts Memo Pad from an ordinary
document to a stationery pad. When you open a stationery
pad, an untitled window appears showing an unused “page”
of that stationery (or a message appears asking you to name
the new document).

11. Close the Info window.

Note that the Memo Pad icon has changed from an ordinary
document icon to a stationery pad icon.

12. Close the Macintosh HD window.
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Learning More 
About Your Macintosh
In this chapter

■ How to use the Balloon Help™ system

■ Where to look for information about your computer and 
its software

Before you begin

This short chapter answers many questions you may have about
where to find certain kinds of information about your computer.

If your computer is in sleep or shut down, turn it back on now.
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Use Balloon Help
Balloon Help is a feature of all Macintosh computers that 
run System 7 or later. Balloon Help explains the function or
significance of icons, menus, commands, and other objects 
on the Macintosh screen, using balloons similar to those in 
comic strips. Each balloon points to the object it explains.

Many Macintosh programs also have Balloon Help.

To use Balloon Help, you need to turn it on. Here’s how:

1. Point to the Help icon near the right end of the 
menu bar.

2. Press to pull down the Help menu.

3. Drag to highlight the Show Balloons command, 
and then release the trackball button.

Balloon Help is now turned on, and balloons containing
explanatory text appear next to objects that you point to 
on the screen.

4. To show a balloon describing your startup hard disk,
point to the hard disk icon.

A balloon appears next to the icon. Except for the fact that
balloons appear next to objects that you point to, the way 
you work with the computer is the same: you select icons,
choose commands, and so on.
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5. Click your hard disk icon to select it.

You can select the icon even with the balloon showing.

6. Point to the File menu.

A balloon appears next to the menu title.

7. Press to pull down the File menu.

The balloon disappears when you pull down the menu.

8. Slowly drag to highlight the Open command, and then
release the trackball button.

Notice that a balloon appears next to a command if you pause
briefly as you drag past it.

The hard disk window becomes the active window. To see
more balloons, you can point to different parts of the window
and to different icons in the window.

In the next step, you’re going to turn off Balloon Help.

9. Choose Hide Balloons from the Help menu.

(Point to the Help icon in the menu bar, press to pull down 
the Help menu, drag to highlight the Hide Balloons command,
and then release the trackball button.)

When Balloon Help is turned off, the Show Balloons
command appears in the Help menu. When Balloon Help 
is turned on, the Hide Balloons command appears.
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Use Part II of this book
Part II of this book, Macintosh Reference, contains all the
information you need to use your computer’s hardware and
system software. Unlike Part I, which is meant to be read 
from beginning to end, Part II is meant to be used like an
encyclopedia: you turn to it when you need to look up some
information, and read only that information.

To help you find the information you need, this book has a 
table of contents and an index.
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What’s not in Part II

Part II of this book does not tell you

■ how to set up your computer

Your setup guide tells you everything you need to know
about setting up your computer and getting it started.

■ how to use application programs

Your best source of information about a particular program
is the set of books and disks that came with that program.

■ your computer’s technical specifications

Technical details about your Macintosh PowerBook are
listed at the end of your setup guide.



Where to find information . . .

To find out about . . . See . . .

Basic Macintosh skills The Macintosh Basics tour
Chapters 1–7

Basic Macintosh terminology Balloon Help
Glossary

Setting up your computer Your setup guide

Using power efficiently Chapter 9

Attaching other devices Chapter 15
to your computer

Using hard disks and Chapter 10
floppy disks

Exchanging files and disks Appendix B
with MS-DOS computers

Using printers Chapters 13 and 15

Using your computer Chapter 14
on a network

Using your modem Your modem manual

Installing system software Chapter 8

Using system software Chapters 8, 11, and 12

Using application programs Your program manuals

To find out about . . . See . . .

Working comfortably with your Your setup guide
trackball and keyboard Chapters 2 and 8

Customizing your Macintosh Chapter 12
work environment

Important safety information Chapter 16

Troubleshooting information Chapter 16 
“Troubleshooting” section

Care and maintenance Chapter 16

Technical information about Your setup guide
your computer model Appendix C

What next?

Congratulations. If you’ve gone through the Macintosh Basics tour
and Part I of this book, you’ve seen and practiced all the basic
skills you need to use your computer productively.

At this point, you could

■ check the charge level of your battery and recharge if
necessary (see Chapter 9 for more information)

■ start learning how to use your application programs

■ turn to any topic in Part II that interests you

■ take a break
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Macintosh Reference
Chapter 8 Setting Up Your Macintosh System

Chapter 9 Using Power Efficiently

Chapter 10 Using Hard Disks and Floppy Disks

Chapter 11 Organizing Your Files

Chapter 12 Adapting the Macintosh to Your Own Use

Chapter 13 Printing

Chapter 14 Using Your Macintosh on a Network

Chapter 15 Enhancing Your Macintosh System

Chapter 16 Caring for Your Macintosh

Appendix A Keyboards and Character Sets

Appendix B Exchanging Disks and Files With MS-DOS Computers

Appendix C For More Information About Your Macintosh

Glossary

Use Macintosh Reference to look up answers to questions about

using your computer and its system software. The table of

contents or the index can help you locate the topic you want.

Before you consult Macintosh Reference you should have

■ set up your Macintosh according to the instructions in the

setup guide that came with your computer

■ become familiar with the information in the Macintosh Basics

tour and in Part I of this book

If you are an experienced Macintosh user and want to read about

the features unique to PowerBook computers, these are discussed

mainly in Chapters 9, 15, and 16.

If you need more technical information than is provided in Part II,

see Appendix C.
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Setting Up Your 
Macintosh System
In this chapter

■ Setting up your computer hardware

■ Working comfortably

■ Installing, reinstalling, or updating your system software

■ Installing your programs

■ Working with several programs at a time

Setting up your computer hardware
For information on how to get your computer up and running, 
see the setup book that came with your Macintosh.

The table shows where to find information about setting up 
other equipment you can use with your computer.

Equipment See

Battery recharger Chapter 9

External floppy disk drive Chapter 15

SCSI device Chapter 15 and the device manual
(hard disk, scanner, etc.)

Printer Chapter 15 and the printer manual

Mouse or other input device Chapter 15

Microphone Chapter 15

Headphones or speakers Chapter 15

Local-area network Chapter 14

Modem The modem manual
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Working comfortably
These suggestions, along with those in Chapter 2, should help 
you work more comfortably with your computer.

■ Whenever possible, sit with your feet flat on the floor and the
backs of your knees slightly higher than the seat of your chair.
Your chair should support your lower back.

■ When you use the keyboard and trackball, your shoulders
should be relaxed. Your upper arm and forearm should form 
a right angle, with your wrist and hand in roughly a straight
line. Use a soft touch on the keyboard and keep your hands
and fingers relaxed.

■ Wherever you’re working, take a moment to think about
whether you feel comfortable, and change position if
necessary.

■ Adjust the screen to minimize glare and reflections from lights
and windows. Make sure there is enough light to read the
screen easily. Clean the screen regularly.

■ Occasionally rest your eyes. From time to time focus your eyes
on a distant object, and blink often while you work.

■ Take periodic breaks from your work. Frequent short breaks
are helpful in reducing fatigue.

■ Some computer users may develop discomfort in their arms,
wrists, or hands if they do intensive work without breaks.
If you begin to develop chronic pain or discomfort in your
arms, wrists, or hands, consult your physician.
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Installing, reinstalling, or updating 
your system software
System software is the set of programs that the Macintosh 
uses to start up, to keep track of your files, and to support the
application programs you use. When you turn on your computer,
it looks for a disk that contains the system software, which is
always in a folder called the System Folder. Any disk that contains
a System Folder is a startup disk.

The startup disk is usually the hard disk that’s inside your
computer, though a floppy disk can also be a startup disk.

If your Macintosh cannot find a startup disk, it displays this 
icon in the middle of the screen:

If you see this icon, you need to install system software on your
computer’s internal hard disk.

❖ If your hard disk already has system software on it and 
you see this icon: Your hard disk or system software may be
damaged, and you may need to reinstall the system software.
See “Starting Up With a Floppy Disk” later in this chapter, 
and “Testing and Repairing Disks” in Chapter 10.  ❖

Before you install

You use the Installer program to install, reinstall, or update 
system software on a startup disk.

▲s▲s Important: Before you install a new version of system
software, make a backup copy of your current System Folder
on another disk in case you need it later (to use a program 
that is incompatible with the new system software, 
for example). ▲s▲s

Using the Installer is a fast, efficient way to update your system
software without losing special files (fonts, sounds, and so on)
you may have installed.

Before you install, reinstall, or update system software:

■ Your hard disk must be initialized, a process that prepares 
the disk to store information. (All Macintosh PowerBook
computers have their hard disks initialized at the factory.)

■ You need the Macintosh system software disks that came 
with your computer or your system software upgrade kit. 

You’ll be using the Installer program on the Install 1 disk
to start the process.

If you have access to the new system software on a shared
disk on a network, you don’t need a floppy disk drive or 
the system software disks. Open the Installer program and
then follow the procedure in the next section, beginning 
with step 4.
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Installing system software

The Installer program’s Easy Install option lets you install system
software on your computer’s hard disk.

1. Shut down your Macintosh.

2. Insert the Install 1 disk into the floppy disk drive.

3. Turn on your Macintosh.

The Installer program opens automatically.

4. Click OK.

The Easy Install dialog box appears.

5. Make sure that the hard disk named in the box is the
one you want to install system software on.

If it isn’t, click the Switch Disk button until the correct disk
name appears.

6. Click Install.

The Installer begins to install system software for your
Macintosh model.

7. Follow the instructions that appear on the screen.

If you are installing from floppy disks, you see messages
asking you to insert different system software disks so the
installation process can continue.

If you are installing over a network, no such messages appear.

8. When you see a message reporting that the installation
was successful, click Quit.

If a message reports that installation was not successful, try
installing again. (Follow the instructions on the screen.)

9. Restart your Macintosh.

Make a backup copy of the System Folder on floppy disks (or on
another hard disk).
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Installing customized system software

Custom installation allows you to select a combination of system
files for your specific needs. You can also use custom installation
to install or update a single file, or to save space on your hard 
disk by installing only the files you want.

To install from floppy disks, begin with step 1; to install over a
network, open the Installer program and begin with step 4.

1. Shut down your Macintosh.

2. Insert the Install 1 disk into the floppy disk drive.

3. Turn on your Macintosh.

The Installer program opens automatically.

4. Click OK.

The Easy Install dialog box appears.

5. Make sure that the hard disk named in the box is the
one you want to install system software on.

If it isn’t, click the Switch Disk button until the correct disk
name appears.

6. Click the Customize button.

The custom installation dialog box appears. All available
components of the system software are listed.

7. Scroll through the list of items and hold down the 
Shift key as you click the items you want to install.

If you want to conserve space on your hard disk, select the
“minimal software” option for your Macintosh.

▲s▲s Important: Be sure to install the files that your Macintosh 
uses to communicate with the printer, network, and other
equipment it is connected to. ▲s▲s

continues >
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8. Click Install.

9. Follow the instructions that appear on the screen.

If you are installing from floppy disks, you may see messages
asking you to insert different system software disks.

If you are installing over a network, no such messages appear.

10. When you see a message reporting that the installation
was successful, click Quit.

If a message reports that installation was not successful, try
installing again. (Follow the instructions on the screen.)

11. Restart your Macintosh.

Make a backup copy of the System Folder on floppy disks (or on
another hard disk).

▲ Warning:  Your startup disk must have only one System
Folder. Multiple System Folders can cause malfunctions and
data loss. You can use the Find command (in the Finder’s File
menu) to see if there is more than one System Folder on your
hard disk. Drag any extra System Folders to the Trash.  ▲

Starting up with a floppy disk

You need to use a hard disk as your startup disk with Macintosh
system software version 7 or later. But if you’re unable to use your
hard disk and you have a floppy disk drive, you can start up your
computer by inserting the Disk Tools disk into the floppy disk drive
and then turning on the computer. This disk contains programs
you can use to initialize, test, and repair disks. (See Chapter 10 for
more information.)
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Installing your programs
Most application programs come on floppy disks, and you install
them by simply copying them from the floppy disks to your hard
disk. (Some programs have special installation procedures; see 
the instructions provided with the programs.)

To use your programs most effectively:

■ Put only one copy of each program on your hard disk. Having
more than one copy can lead to problems when you’re using
the program.

■ Whenever you copy the contents of a program disk to your
hard disk, be careful not to copy an extra System Folder.
Always check to see what you’ve copied, and drag any extra
System Folders to the Trash.

■ Put frequently used programs (or aliases for those programs)
in the Apple menu so you can open the programs more
conveniently. See “Installing an Item in the Apple Menu” in
Chapter 11.

■ If you want the Macintosh to open a program automatically
each time it starts up, see “Specifying Which Items You Want
Opened at Startup” in Chapter 12.

■ Keep the original program disk in a safe place. If the program
on your hard disk malfunctions, you can replace it with a fresh
copy from the original disk.

■ If a program malfunctions consistently, and installing a 
fresh copy does not correct the problem, find out from 
the software manufacturer whether your version of the
program is compatible with the Macintosh system software 
you’re using.

Installing programs without a floppy disk drive

If you don’t have a floppy disk drive, there are other ways to 
copy programs onto your hard disk:

■ If you have access to a network, you can connect your
computer to the network and copy programs from a shared
disk. See Chapter 14.

■ If you have a PowerBook 100 and access to a desktop
Macintosh, you can connect the two computers and copy
programs directly from the desktop Macintosh. See “Using
Your Computer as a SCSI Disk” in Chapter 15.

Remember that the software license agreement for a given
program may limit the number of copies you can make. Make 
sure you’re acting within the terms of the license agreement 
before you copy programs onto your computer.
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Checking for computer viruses

Viruses—programs that damage files or erase disks—can be a
significant problem for people who use computers. A virus can be
introduced into your Macintosh from a floppy disk, from a shared
disk on a network, or from an electronic bulletin board service.

Programs that detect and eliminate viruses are available from user
groups, bulletin boards, and dealers.

You should check for viruses frequently if you exchange disks 
or data with other users. Some programs check for viruses
automatically.

■ Check all disks—even those in new, unopened commercial
software packages—for viruses before using them or copying
anything from them to your hard disk.

■ Check your hard disk regularly with a virus-detection program
and correct any problems the program finds.

■ Since new viruses appear regularly, make sure you have the
latest version of your virus-detection software.

■ To avoid compatibility problems, be sure to use only one
virus-detection program at a time.

■ If your Macintosh is on a network or if you use a modem 
to connect to information services or bulletin boards, 
check for viruses each time you copy information from 
an outside source.

■ If you give information to other Macintosh users on disks 
or send information electronically, make certain that there 
are no viruses on your computer system before distributing
the information.

84 Chapter 8: Setting Up Your Macintosh System



Working with several programs at a time
You can open as many programs and desk accessories as your
computer’s memory allows.

All open programs are listed in the Application menu at the right
end of the menu bar. The active program’s name has a checkmark
next to it, and its icon appears in the menu bar.

Finding out what programs are open

If you have several programs and windows open, you can find out
which program is active and what other programs are open by
pulling down the Application menu.

Switching programs

You can switch among open programs or desk accessories 
by choosing their names from the Application menu.

If a program’s icon is dimmed in the menu, that means its
windows are hidden. Choosing the program from the 
Application menu displays its windows.

You can also switch programs by clicking in a window 
that “belongs” to an open program, or by double-clicking 
a program icon (or the icon of a document that was created 
with the program).

Hiding and showing windows on the desktop

You can hide all windows except those of the active program by
choosing the Hide Others command from the Application menu.

The other windows remain available even though they’re hidden.
When you switch to another open program, its open windows 
are displayed. If you want to see all the windows that are open,
choose Show All from the Application menu.
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Changing the amount of memory a program uses

All open programs use a certain amount of your computer’s RAM.
Each program sets aside the amount of memory it needs. (If you
see a “not enough memory” message on your screen, it usually
means that you are trying to open more programs than your
Macintosh has the memory to support.)

On rare occasions you may want to increase or decrease the
amount of memory a program uses. You might want to increase
the amount so you can open more documents at once, or you
might want to decrease it so you can open more programs at
once. You adjust the program’s memory size in its Info window.

1. Quit the program if it’s open, and then click the
program’s icon to select it.

2. Choose Get Info from the File menu.

The Info window appears.

3. Drag across the number in the box labeled “Current
size” to select it.

4. Type the number of kilobytes (K) of memory that you
want the program to use.

If you type a number smaller than the amount shown next to
“Suggested size,” the program may work more slowly, show
other performance problems, or not work at all.

5. Close the Info window.

If you make the memory size smaller than recommended,
you’ll see a message asking you to confirm your decision.
Click Cancel to avoid problems with the program.
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Using Power Efficiently
In this chapter

■ Turning on the computer

■ Turning off the computer

■ Monitoring the battery charge level

■ Recharging the battery

■ Removing or replacing the battery

■ Maximizing battery life

■ Replacing backup batteries

■ Conserving power

Turning on the computer
A working Macintosh PowerBook computer that appears to be off
is in one of two power states: sleep (a “resting” state designed to
conserve power) or shut down (off ).

Turning on the computer for the first time

If your computer has never been used before, turn it on as
described in your setup guide.

Chapter 9



Turning on the computer to resume your work

There are two ways to turn the computer back on:

■ Press any key on the keyboard.

Pressing Caps Lock, pressing a trackball button, or moving 
the trackball does not turn on the computer.

■ Press the power button on the computer’s back panel.

You’ll need to hold the button in for a fraction of a second for
it to take effect. (The PowerBook 140 and 170 have a power
button; the PowerBook 100 does not.)

If the Macintosh does not respond, try the following:

■ If you have a PowerBook 100, make sure the storage switch 
is in the “on” position (up).

■ Plug in the power adapter (in case the battery has become
depleted). You may need to wait 15 minutes or so to give the
battery time to recharge.

■ Try pressing a key or the power button once more.

■ See “Restarting a Computer That Can’t Be Turned On
Normally,” later in this chapter.

Power button
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Restarting a computer that’s already on

You need to restart your computer—turn it off and back on again
immediately—when you want to turn on certain changes to your
control panels, turn on a newly installed system software file, or
start up the computer from a different disk.

■ Choose Restart from the Special menu.

When you choose Restart, the computer prompts you to save
your work, closes all open programs, and then restarts itself.

Choosing Restart does not affect your RAM disk (if you created
one) or its contents.

You also need to restart if you see a “system error” message on
your screen (indicating a temporary software problem). In this
case, click the Restart button that appears.

Restarting a computer that 
can’t be turned on normally

If your system crashes (a rare event resulting from temporary
software problems), or if a computer with a properly installed and
charged battery does not respond when you try to turn it on, you
should be able to restart using one of the methods described in
this section. Try them in the order given.

■ Press and release the reset button (the one on the
right).

continues >
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On the PowerBook 140 and 170 the reset button is recessed;
you can press it with a pen, a paper clip, or a similar object.

Restarting the computer with the reset button does not affect
your RAM disk (if you created one) or its contents.

■ If your model has a power button, press the power
button, wait a second, then press it again.

This has the effect of turning the computer off and then 
on again. Turning the computer off with the power button
removes a RAM disk and its contents.

■ Restart from a floppy disk.

If your system has a floppy disk drive, try starting up from a
floppy disk. Begin with step 1 if you have an external drive,
and with step 3 if you have an internal drive.

1. If you haven’t already done so, connect the external 
floppy disk drive to your computer as described in
Chapter 15.

2. Press the computer’s reset and interrupt buttons
simultaneously (see the illustration on the 
previous page).

3. Insert the Disk Tools disk into the floppy disk drive.

4. Press any key on the keyboard, or press the power
button again.

If the computer turns on, there is a problem with your
hard disk. You may be able to fix the problem yourself
(using the Disk First Aid™ program or another disk repair
program; see Chapter 10). Or you may prefer to take the
computer to your authorized Apple service provider.

■ If your model supports SCSI disk mode, connect it to a
desktop Macintosh and start it up as a SCSI disk.

The PowerBook 100 can be connected to a desktop Macintosh
and used as an external SCSI disk drive. This feature allows
you to reinstall system software without using floppy disks.
The recovery procedure has two parts:

First you need to connect your computer to a desktop
Macintosh, as described in Chapter 15.

Then you need to reinstall system software on your
computer’s hard disk, as described in Chapter 8.

Follow the steps in Chapters 15 and 8 if you need to restart your
computer as a SCSI disk and reinstall its system software.
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Turning off the computer
If you are taking a work break, put the computer to sleep.

If you want to turn off your computer for the night, transport it,
connect or disconnect devices, or change the battery, shut the
computer down.

Putting the computer to sleep

If you are turning off your computer for up to a few hours, save
your work and then put the computer to sleep so it uses only the
power it needs to maintain the contents of RAM.

There are two ways to put the computer to sleep:

■ Choose Sleep from the Special menu.

■ Click the Sleep button in the Battery desk accessory.

When you resume working, the desktop appears on the screen 
the way you left it.
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Sleep shortcuts from the Battery desk accessory

You can put the computer to sleep from the compressed Battery
desk accessory: with the Battery window active, hold down the
Option key and click the battery icon next to the close box.

When you put the computer to sleep while AppleTalk is active, 
a message alerts you that sleep interrupts network connections,
and you must click another Sleep button to confirm your decision.
To bypass the AppleTalk message:

■ If the Battery DA is expanded, hold down the Shift key while
clicking the Sleep button.

■ If the Battery DA is compressed, hold down the Option and
Shift keys while clicking the battery icon.

Shutting the computer down

If you want to turn off your computer for the night or longer,
transport it, connect or disconnect devices, or change the battery,
save your work and then shut the computer down.

■ Choose Shut Down from the Special menu.

Do not use the power button to shut down your 
PowerBook 140 or 170.
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▲ Warning: When you shut down a PowerBook 100, the 
RAM disk (if any) is not affected. When you shut down a
PowerBook 140 or 170, however, the RAM disk is removed.  ▲

The best way to store your computer if you will not be using it for
a few days or weeks is to shut it down and leave it in a cool, dry
place with the power adapter plugged in. You can also store your
computer for up to a week without connecting the power adapter.

If you know that you will be storing your PowerBook 100 for
longer than a week and cannot leave the adapter plugged in, you
should turn off the storage switch. 

See Chapter 16 for complete instructions on storing your
computer.

Monitoring the battery charge level
Your battery will last longer and your computer will perform 
better if you monitor the battery charge level and recharge it as
appropriate. The Battery desk accessory shows roughly how
much power is left in the battery.

Opening the Battery desk accessory

■ Choose Battery from the Apple menu.

You can leave the Battery desk accessory on your desktop to keep
track of the battery charge while you work.
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Responding to low-power messages

When your battery starts to run low, the computer advises you by
displaying a series of messages. The work time remaining after
you begin to see low-power messages will vary depending on
how you are using the computer. It is safest to put the computer 
to sleep or plug in the power adapter as soon as possible.

■ The first message indicates that it’s time to recharge the
battery. Right after the message appears, the screen brightness
dims automatically.

If you have a PowerBook 140 or 170, you may have just a few
minutes of battery charge remaining. Recharge the battery 
as soon as possible after you see this message. If you can’t
recharge the battery right away, save your work and put the
computer to sleep.

If you have a PowerBook 100, you may have up to 15 minutes
of battery charge remaining. Recharge or replace your battery
as soon as possible.

■ If you continue to work without recharging the battery, the
computer displays a second low-power message.

If you have a PowerBook 140 or 170, you may have just
enough time left to save your work.

If you have a PowerBook 100, you have a few minutes of
work time remaining. Plug in the power adapter now.

■ A short time after the second message appears, the computer
displays a third and final message indicating that the computer
is about to put itself to sleep. When time is up, the computer
goes to sleep automatically to protect the contents of RAM.

If you continue working until the computer goes to sleep
automatically, you may not be able to wake it again until you
recharge the depleted battery for 15 minutes with the computer’s
power adapter plugged in. With PowerBook 140 and 170 models,
information you have not saved will be lost if you replace the
battery instead of recharging the battery as just described.

If you don’t have your power adapter available, the contents of
RAM are retained in sleep for at least 2 days. If you recharge the
battery within 2 days, you should be able to wake the computer
and resume work where you left off.

▲s▲s Important: Recharge a depleted battery as soon as possible.
Leaving a depleted battery in the computer for longer than 
2 weeks (especially in a hot location, such as the trunk of a
car) may damage the battery so that it cannot be recharged. If
this happens, you need to replace the battery. See Chapter 16
for information about storing your computer safely.  ▲s▲s

Do not use your computer without a battery. While it may work
with the power adapter plugged in and no battery installed, your
backup batteries begin to drain as soon as you unplug the power
adapter, and dirt that gets into the computer through the battery
compartment can cause problems with your equipment.
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Recharging the battery
You can recharge the battery in either of two ways:

■ plug in the power adapter

■ use an (optional) external recharger

Using the power adapter

To use the power adapter, plug it in as shown. Place the computer
on a flat surface; don’t recharge the battery with the computer in a
vertical position. If you have a PowerBook 100, make sure the
storage switch is in the on (up) position, or the battery will not
charge.

By using the power adapter you can recharge the battery 
without taking it out of the computer. You can continue to use 
the computer while the battery is recharging, but the battery 
will take longer to recharge if you do. 

▲ Warning: Use only the power adapter that came with your
Macintosh PowerBook. Adapters for other electronic devices
(including other portable computers) may look similar, but
they may damage your computer.  ▲

A lightning bolt icon appears in the Battery desk accessory when
the power adapter is plugged in and the battery is recharging. 
The lightning bolt icon goes away when recharging is about 85%
complete, though recharging continues. The icon appears even 
if the power adapter is plugged into the computer only, so make
sure the adapter is plugged into both the computer and
a power outlet.

Battery recharging time while the computer is in use depends on
how often you use the hard disk, how bright the screen is, how
deeply the battery is depleted, and other factors. If you recharge
with the computer shut down, your battery will be about 80%
recharged within 2–3 hours (it takes several more hours to bring
the battery charge to 100%). Your battery will last longer if you
recharge it at (or slightly below) room temperature.

If you use the power adapter whenever you’re working near an
electrical outlet, you should seldom have to stop work to recharge.

See “Maximizing Battery Life” later in this chapter for more
information about using your battery efficiently.

Chapter 9: Using Power Efficiently    95

R
E

F
E

R
E

N
C

E



Using an external recharger

An external battery recharger and additional batteries are available
as options for your computer. If you purchase a recharger and an
extra battery, you can charge one battery while you use the other,
so you always have a fully charged battery on hand.

The rechargers can accommodate two batteries. The battery slots
work independently, so you can put batteries in or take them out
at different times.

The recharger must be plugged into an electrical outlet to charge 
a battery. You can plug it in using the power adapter that came
with your computer, or you can purchase an additional (identical)
power adapter from your authorized Apple dealer.

▲s▲s Important: Do not use any other type of power adapter with
the recharger. Doing so may damage the recharger, the power
adapter, or both.  ▲s▲s

To recharge a battery, follow these steps.

1. Place the recharger on a level surface.

2. Plug one end of the power adapter into the recharger
and the other end into an electrical outlet.PowerBook 140/170

recharger
PowerBook 100

recharger
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3. Place the battery in the recharger as shown in the
illustrations.

The light beside the battery slot indicates the charge status of 
the battery.

■ No light: The recharger is not plugged in, or the battery is
defective. (If the light goes off during recharging, there is a
problem with the battery.)

■ Yellow: The battery is charging.

■ Green: The battery is charged and can be used.

The table shows approximate recharging times for fully 
depleted batteries.

PowerBook 80% charge 100% charge

140/170
1 battery 2.5 hours 5 hours
2 batteries 5 hours 10 hours

100
1 battery 2 hours 6 hours
2 batteries 4 hours 12 hours

You can remove a battery from the recharger at any time during 
or after recharging.

▲s▲s Important: To preserve a battery’s charge, don’t leave it 
in the recharger if the power adapter is not plugged into 
an electrical outlet. ▲s▲s

PowerBook 140/170
recharger

PowerBook 100
recharger
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Removing or replacing the battery
To remove or replace the battery, follow these steps.

1. Save your work, and then choose Shut Down from the
Special menu.

2. Close the display.

3. Open the battery door by sliding its cover panel in the
direction indicated by the arrow.

The battery door is physically attached to the battery.
Replacement batteries come with a battery door attached.

4. Carefully pull the battery out of its compartment.

5. If you are inserting a new or a spare battery, slide it 
into the battery compartment.

6. Close the battery door by sliding it back into place.

7. If you just inserted a new battery, it’s a good idea to 
plug in the power adapter in case the battery is not 
fully charged.

▲s▲s Important: Macintosh PowerBook computers use sealed 
lead-acid and nickel-cadmium batteries, which contain
hazardous materials. It is inappropriate, and in some cases
unlawful, to throw the batteries away with your household 
or business trash. Return dead batteries to your authorized
Apple service provider, who will make sure they are handled
correctly through Apple’s battery recycling and disposal
network. See Chapter 16 for more about proper battery care
and for information about how to find an Apple service
provider near you. ▲s▲s

▲ Warning: Damaged nickel-cadmium and sealed lead-acid
batteries may leak small amounts of potassium hydroxide or
sulfuric acid, respectively. These substances can cause severe
burns to the skin and eyes. If you touch a damaged battery,
immediately wash your hands and any other affected areas
with water for at least five minutes. Do not use soap. ▲

PowerBook 100 PowerBook 140/170 
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Maximizing battery life
Macintosh PowerBook computers use two types of batteries 
that differ in their charging characteristics. The PowerBook 140
and 170 use nickel-cadmium (NiCad) batteries, and the
PowerBook 100 uses sealed lead-acid (SLA) batteries.

To maximize the life of PowerBook 140 and 170 (NiCad) batteries,
discharge them completely once every 90 days. Just use the
computer as you normally would, but ignore the low-power
messages that appear on the screen. (Make sure to save your
work, however.) When the computer goes to sleep automatically,
recharge the battery completely before using that battery again.

Avoid discharging a PowerBook 100 (SLA) battery to the point
where the computer goes to sleep automatically. If this happens
occasionally it will not harm the battery, but repeated deep
discharges will shorten the battery’s life.

With proper care you can expect your battery to last for at least 
a year. If you notice that the battery no longer holds a charge for
as long as it should, you may need to replace it.

Replacing backup batteries
In addition to its main battery, your computer has one or more
small backup batteries that maintain your clock and control panel
settings while you replace the main battery. (The PowerBook 100
backup batteries also maintain the contents of RAM—your RAM
disk and any work in progress.)

The backup batteries usually last several years. You need to
replace them if you notice that some of your system settings
changed after you removed or replaced the main battery. (You
may notice, for example, that the clock time is different.) By
replacing the backup batteries you can preserve your system
settings the next time you change the main battery.

The PowerBook 140 and 170 have one backup battery, which
must be replaced by an authorized Apple service provider.

The PowerBook 100 has three backup batteries, which you 
can replace yourself. It is important to use the correct type 
of replacement battery. Recommended types include the 
Sony CR2430 and Sanyo 2430 3-volt lithium cells, available 
at most consumer electronics stores.

▲s▲s Important: Lithium batteries contain hazardous materials. 
It is inappropriate, and in some cases unlawful, to throw the
batteries away with your household or business trash. Return
dead batteries to your authorized Apple service provider, who
will make sure they are handled correctly through Apple’s
battery recycling and disposal network.  ▲s▲s
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To replace the backup batteries in your PowerBook 100, 
follow these steps.

▲ Warning: Lithium batteries can explode if handled
improperly.  ▲

1. Save your work, and then choose Sleep from the 
Special menu.

2. Close the display.

3. Open the door covering the ports on the back of 
the computer.

4. Open the battery door.

Use your fingernail or a similar object to open the door.

5. Remove and replace the three lithium cells.

Make sure to place the new batteries with their positive sides
up, as shown in the drawing. 

6. Close the battery door and the door covering the ports.

You’re ready to start using the computer again. Remember to
restore your previous clock and control panel settings if necessary.

Positive sides up

Battery door
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Conserving power
The more efficiently you conserve power, the longer you can
work without having to recharge your battery. The length of time
you can use your Macintosh between battery charges varies
considerably, depending on the configuration of your system 
and the methods you use to conserve power.

PowerBook Work time* 80% charge** 100% charge**

140/170 (NiCad) 2–3 hours 2–3 hours 8 hours

100 (SLA) 2–4 hours 2–3 hours 10 hours

*Typical use time; actual times will vary.
**Typical time to charge in the computer (shut down).

Suggested methods of maximizing battery use time

Not all of these methods apply to all PowerBook computers, 
as indicated by notes following some items.

■ Turn down the screen brightness whenever possible. At its
highest level, the screen brightness consumes up to half the
power your computer is using.

■ Adjust the automatic sleep controls for the system and the
hard disk to the shortest intervals you find convenient.

■ Plug any SCSI devices you use with your computer into their
own power sources, turn them on before the computer, and
turn them off after the computer.

■ Quit any program that uses a modem unless you’re using the
program for telecommunication. As long as the program is
open, your modem is consuming power.

■ Keep virtual memory turned off (PowerBook 140 and 170).

■ If you’re working near an electrical outlet, plug in the power
adapter while you work.

■ Whenever you aren’t using the computer, even for a short
time, put it into system sleep and plug in the power adapter.

■ Turn on Power Saver (PowerBook 170 only).

■ If your computer has 6 MB of memory or more, use a RAM
disk as your startup disk to minimize hard disk use.

■ Connect only low-power Apple Desktop Bus (ADB) devices,
marked with the icon below, to the ADB port.

Chapter 9: Using Power Efficiently    101

R
E

F
E

R
E

N
C

E



102 Chapter 9: Using Power Efficiently

Adjusting system rest

The power consumption of your computer’s microprocessor is
reduced automatically when the computer detects that no activity
requiring its attention has taken place for a certain period of 
time. This feature is called system rest. The microprocessor comes
back up to speed instantaneously when you resume using 
the computer.

You don’t need to do anything to use system rest. But if you notice
that one of your programs performs very slowly, you might want
to turn off system rest while using that program.

To turn off system rest, follow these steps.

1. Choose Control Panels from the Apple menu.

2. Open the Portable control panel.

3. Hold down the Option key while clicking “Minutes Until
Automatic Sleep.”

4. Click Don’t Rest.

(Click Rest to turn system rest back on.)

5. Click OK.

If you have open programs performing an activity in the
background, system rest may slow those programs down.

❖ Other effects? When system rest is on, you may notice that 
the Alarm Clock is updated irregularly or that the wristwatch
pointer appears on the screen more often. These changes 
do not indicate a problem with your computer.  ❖

▲s▲s Important: To conserve power most efficiently, turn off
system rest only when using programs that system rest
interferes with. Turn system rest back on again as soon as
possible. (System rest is turned back on automatically the
next time you choose Restart or Shut Down.) ▲s▲s
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Adjusting system sleep

System sleep is a power-conserving state in which your computer
uses only the power it needs to maintain the contents of RAM. A
computer in system sleep has a darkened screen and appears to
be off, though it is still drawing battery power at a low level.

When you’re not using the computer, system sleep goes into effect
automatically after a time interval that you designate.

To set the system sleep interval, follow these steps.

1. Choose Control Panels from the Apple menu.

2. Open the Portable control panel.

3. In the “Minutes Until Automatic Sleep” box, drag the
slider to set the number of minutes of inactivity before
system sleep takes effect.

The shorter the interval you select, the more power you
conserve. When you change the setting, the new setting takes
effect immediately.

If you have the power adapter connected, you can prevent
system sleep by clicking “Stay awake when plugged in.”

4. Close the control panel.

If you want to put the computer to sleep before the selected time
interval elapses, choose Sleep from the Special menu or click the
Sleep button in the Battery desk accessory.

You “wake” the computer from sleep by pressing any key on the
keyboard except Caps Lock. (On the PowerBook 140 and 170, 
you can also wake the computer by pressing the power button.)

❖ System sleep and network use: System sleep does not go into
effect automatically under the following circumstances:

■ The AppleTalk® software is turned on.

■ Your computer is connected to a shared disk on the
network.

■ Your computer’s modem port or printer port is in use.  ❖
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Adjusting hard disk sleep

Hard disk sleep is a power-conserving feature that stops your
computer’s internal hard disk from spinning when it isn’t being
used. Hard disk sleep goes into effect automatically after a time
interval that you designate.

The hard disk starts spinning again (after a delay of a few seconds)
when the computer needs it to store or retrieve information.

To set the hard disk sleep interval, follow these steps.

1. Choose Control Panels from the Apple menu.

2. Open the Portable control panel.

3. In the “Minutes Until Automatic Sleep” box, drag the
slider to set the number of seconds or minutes of
inactivity before hard disk sleep takes effect.

The shorter the interval you select, the more power you
conserve. When you change the setting, the new setting takes
effect immediately. The interval before hard disk sleep cannot
be longer than the interval before system sleep.

If you have the power adapter connected, you can prevent
hard disk sleep by clicking “Stay awake when plugged in.”

4. Close the control panel.

You  should not use hard disk sleep and virtual memory at the
same time because virtual memory requires frequent hard disk
access. See Chapter 12 for more about virtual memory.

In all other respects, using your computer’s hard disk is like using
any other hard disk.
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Using Power Saver

The PowerBook 170 has a feature called Power Saver that slows 
down your computer’s microprocessor from 25 MHz to 16 MHz.
Decreasing the microprocessor speed may slow the performance
of some programs, but you may gain up to 30 more minutes of
work time before you need to recharge the battery. Power Saver
also limits the screen brightness range by reducing the highest
brightness settings.

To use Power Saver, follow these steps.

1. Choose Battery from the Apple menu.

2. If necessary, click the lever in the upper-right corner 
to expand the Battery desk accessory.

3. Click the On button.

4. Choose Restart from the Special menu.

The computer restarts at the lower microprocessor speed,
which stays in effect until you click the Off button in the
Battery desk accessory and restart the computer.

Using a RAM disk

A RAM disk is a portion of your computer’s memory that you set
aside for use as a temporary storage device. Using a RAM disk
conserves power because the computer uses less energy to access
RAM than to access a hard disk or a floppy disk.

Memory assigned to a RAM disk is not available for opening
programs, so it is usually not practical to create a RAM disk unless
your computer has at least 4 MB of RAM.

Some actions remove a RAM disk. RAM disks are more permanent
on the PowerBook 100, as summarized in the table.

Will the RAM disk survive? 

Action PowerBook 140/170 100

Choose Sleep yes yes

Press power button to wake up yes —

Choose Restart yes yes

Press reset button yes yes

Choose Shut Down no yes
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It’s a good idea to observe a few precautions if you use a 
RAM disk:

■ Before using a program on a RAM disk, test the program on
your hard disk or a floppy disk to make sure that it works
properly with your computer.

■ Don’t store your only copy of a file on a RAM disk. Keep an
extra copy on your hard disk or a floppy disk.

Creating a RAM disk

1. Choose Control Panels from the Apple menu.

2. Open the Memory control panel.

The RAM disk portion of this control panel is at the bottom 
of the window.

3. Click the On button below the words “RAM disk”.

4. Drag the slider to choose the percentage of available
memory you want to use for your RAM disk.

Choose a size large enough to accommodate the programs
and documents you want to put on the RAM disk. Memory 
set aside for the RAM disk won’t be available for opening
programs, so don’t choose a larger size than you need.

The default size uses 100% of the available memory over 
2 MB; that is, it’s the largest RAM disk you can use on your
computer.

The size of the RAM disk you select appears in the “RAM Disk
Size” box.

5. Close the control panel.

6. Choose Restart from the Special menu.

A RAM disk icon appears on the desktop when the computer
restarts.
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Erasing a RAM disk

There are two ways to erase the contents of a RAM disk. They do
not remove the RAM disk itself or make more memory available
for opening programs.

■ Select the RAM disk icon and choose Erase Disk from
the Special menu.

■ Drag everything on the RAM disk to the Trash and
choose Empty Trash from the Special menu.

Resizing or removing a RAM disk

1. Copy any programs or documents that you want to 
save onto the internal hard disk or a floppy disk.

If you want to resize a RAM disk, you need to remove and
then restore the items on it.

2. Drag everything in the RAM disk to the Trash.

3. Choose Empty Trash from the Special menu.

4. Choose Control Panels from the Apple menu.

5. Open the Memory control panel.

6. Drag the slider to choose the percentage of available
memory you want to use for your RAM disk.

Drag the slider to 0% if you want to remove the RAM disk.

7. Close the control panel.

8. Choose Restart from the Special menu.

If you resized your RAM disk, a new RAM disk icon appears
on the desktop when the computer restarts. If you removed
your RAM disk, no icon appears.
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Making a RAM disk the startup disk

If you have 6 MB or more of memory, an efficient way to use 
a RAM disk on the PowerBook 100 is to make it your startup 
disk. You can also use a RAM disk as a startup disk on the
PowerBook 140 and 170, but it is less convenient because 
the RAM disk is removed if you choose Shut Down. (If this 
happens, the computer starts up from the hard disk.)

To make a RAM disk your startup disk, follow these steps.

1. Create a RAM disk.

2. Locate and open the Installer program.

The Installer is on the Install 1 floppy disk that came with 
your computer.

3. Install a minimal System Folder on the RAM disk.

See Chapter 8 for instructions on installing customized 
system software.

4. Choose Control Panels from the Apple menu.

5. Open the Startup Disk control panel.

6. Select the RAM disk as your startup disk.

7. Choose Restart from the Special menu.

The RAM disk is now your startup disk. It’s a good idea to
keep a backup copy of the contents of the RAM disk in case 
it is lost.
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Using Hard Disks 
and Floppy Disks
In this chapter

■ Preparing a new disk for use

■ Erasing a disk

■ Designating a startup disk

■ Protecting the information on a disk

■ If you can’t save files on a floppy disk

■ Ejecting a disk

■ Caring for disks

■ Testing and repairing disks

Preparing a new disk for use
Before you can use a new disk, you need to prepare it so 
the computer knows where to store information on the disk. 
The preparation process is called initializing (or formatting)
the disk.

The hard disks shipped with Macintosh PowerBook computers 
are already initialized when they leave the factory. If your
computer has a floppy disk drive, you need to initialize new 
3.5-inch (89-millimeter) floppy disks that you want to use 
in the drive.
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Initializing a hard disk

Occasionally a hard disk may become damaged in such a way that
you can’t use it again until you reinitialize it. (The key symptom of
such damage is that the hard disk’s icon does not appear on the
desktop when you start up the computer using another disk.)

If your hard disk’s icon does not appear on the desktop, first try to
repair it as described in “Testing and Repairing Disks” later in this
chapter. If you can’t repair the disk, use the Apple HD SC Setup
program to initialize and name the disk again. The program is on
the system software disk called Disk Tools.

1. Locate the Apple HD SC Setup icon and open it.

The name of the hard disk currently selected is shown as the
“volume name.” The SCSI ID number of the selected hard disk
is displayed above the Drive button. (The ID number of an
internal hard disk is 0.)

2. If the volume name and ID number don’t match the
hard disk you want to initialize, click Drive until the
disk you want to initialize is selected.

You cannot initialize your startup disk or the disk 
that contains the Apple HD SC Setup program.

3. Click Initialize.

You must confirm or cancel your decision.

4. Click Init to initialize the hard disk.

5. If a message appears asking you to name the disk, 
type a name and then click OK.

6. Click Quit when you see a message reporting that
initialization was successful.

If a message reports that initialization failed, try again. 
If initialization fails a second time, take the disk to your
authorized Apple service provider for repair.
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Initializing a floppy disk

Initializing a new floppy disk prepares the disk to store
information.

1. Insert a new floppy disk into your floppy disk drive.

If you inserted a high-density disk, this message appears:

If you inserted a double-sided (800K) disk, this message
appears:

2. If you inserted a high-density disk, click Initialize.
If you inserted a double-sided disk, click Two-Sided.

Another message appears:

This message alerts you that you’re about to erase any
information that may be on the floppy disk. A new floppy 
disk has no information on it.

3. Click Erase.

A third message appears:

continues >
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4. Type a name for the disk.

If you don’t name the disk, the computer gives it the name
“Untitled.”

5. Click OK.

The computer takes about a minute to initialize the disk.
When initialization is finished, the icon of the floppy disk
appears on the desktop.

Erasing a floppy disk
Erasing a disk actually reinitializes it.

▲ Warning: When you erase a disk, you lose any information
that was on the disk. ▲

1. Click the icon of the disk you want to erase.

2. Choose Erase Disk from the Special menu.

A message appears, giving you a chance to cancel the
procedure.

3. If you inserted a high-density disk, click Initialize.
If you inserted a double-sided disk, click Two-Sided.

The computer takes about a minute to erase the disk.
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Designating a startup disk
If you have more than one startup disk, you need to specify 
which one you want the computer to use. For example, you may
sometimes want to use a RAM disk as a startup disk instead of 
the hard disk. (See Chapter 9 for information about creating 
and using a RAM startup disk.)

1. Choose Control Panels from the Apple menu.

2. Open the Startup Disk control panel.

3. Click the icon of the disk you want to use as the 
startup disk.

4. Close the Startup Disk control panel.

Scanning order for startup disks

When you turn on your computer, it looks for a startup disk 
(a disk containing a System Folder) in the following sequence:

1. internal floppy disk drive (if any)

2. external floppy disk drive (if any)

3. disk (or RAM disk) selected in the Startup Disk control panel
(if any)

4. internal hard disk

5. external hard disk (if there is more than one, it looks first at
the hard disk with the highest SCSI ID number)

6. internal hard disk (the computer returns to this drive and 
waits another few seconds)

If the computer does not find a startup disk, it displays a blinking
question mark in the middle of the screen.

To bypass the internal hard disk in the scanning sequence, press
x-Option-Shift-Delete while the computer starts up.

▲s▲s Important: If you use an external hard disk, turn it on and
wait a few seconds before you turn on your Macintosh, or the
computer will not recognize the disk. ▲s▲s
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Protecting the information on a disk
The information on a locked floppy disk, or in a locked file, can
be opened or copied but cannot be changed.

Locking a floppy disk

■ Slide the tab on the back side of the disk so that the
square hole is open.

Use your thumbnail, a push pin, or a similar object to move
the tab.

To unlock the disk, slide the tab back so that it covers the
square hole.

Locking a file

You use the Get Info command to lock a document or a program.
Locking a program may affect its operation.

1. Click the icon of the file you want to lock.

2. Choose Get Info from the File menu.

3. In the Info window, click the Locked box in the 
lower-left corner.

4. Close the Info window.

To unlock the file, click the Locked box again (so the X
disappears).

You can’t lock a folder, but you can lock items in a folder.

You can lock an alias, but doing so does not lock the original file.
Locking an alias merely protects it from being thrown away.

Locked Unlocked
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Backing up your files

Making backup copies of important files is good protection
against possible damage to the originals.

■ You can back up files stored on your hard disk by copying
them onto floppy disks.

■ You can back up an entire floppy disk by copying it to another
floppy disk, or to a hard disk.

■ You can use a commercial backup program to copy some or
all files from a hard disk to another hard disk, to a tape drive,
or to a series of floppy disks.

■ If you have a PowerBook 100, you can connect it as a SCSI
disk to a desktop Macintosh and back up files by copying
them from one computer to the other. (See Chapter 15 for
information about using your PowerBook 100 as a SCSI disk.)

If you can’t save files on a floppy disk
If you can’t save files on a floppy disk, the disk may be locked,
full, or damaged, or the disk drive may not be working properly.
Try the following:

■ Make sure the tab on the back of the disk is in the unlocked
position (the square hole should be closed).

■ If you see a message reporting that the disk is full, erase
unneeded files from that disk, or save on another disk.

■ If you see a message that the disk is not initialized, and you
know that it has been initialized, eject the disk and carefully
insert it again. If the same message appears, the disk is
probably damaged. (You may be able to recover its
information with Disk First Aid or another disk-recovery
program; see “Testing and Repairing Disks” later in this
chapter.)

■ Check the disk for obvious damage to the plastic case or the
sliding metal shutter.

■ Insert a different disk and try saving again. If you can’t save on
the second disk, take the disk drive to your authorized Apple
service provider for repair.
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Ejecting a disk
You can eject a floppy disk by doing any of the following:

■ Click the disk icon to select it and choose Put Away
from the File menu.

The disk is ejected and its icon disappears from the desktop.

■ Drag the disk icon to the Trash.

The disk is ejected and its icon disappears from the desktop.
(Dragging a disk to the Trash does not erase the disk’s
contents.)

■ Click the disk icon to select it and choose Eject Disk
from the Special menu.

The disk is ejected and its dimmed icon remains on 
the desktop.

You can use the first two methods to remove a hard disk icon from
the Macintosh desktop (provided that it’s not your startup disk), or
to disconnect from a shared disk on the network.

All three methods also work with CD-ROM discs.

If you can’t eject a floppy disk

If you can’t eject a floppy disk in the usual way, try the following:

1. Hold down the x and Shift keys and press the number 1
key on your keyboard to eject a disk in an internal disk
drive; press x-Shift-2 to eject a disk in an external disk
drive.

2. If step 1 doesn’t work, turn off the Macintosh. If the
disk isn’t ejected, then hold down the trackball button
while you turn the computer on again.

3. If step 2 doesn’t work, locate the small hole near the
disk drive’s opening, and carefully insert the end of a
large straightened paper clip into it.

Push gently until the disk is ejected. Do not use excessive
force.

4. If step 3 doesn’t work, take the computer or disk drive
to your authorized Apple service provider to have the
disk removed.
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Caring for disks
For information on floppy disk care, see Chapter 3, “Working 
With Disks,” or consult the instructions that came with your 
floppy disks.

Hard disk precautions

Hard disk drives are delicate mechanisms and should be handled
with care.

■ Do not bump, jar, or move your computer while the hard disk
is in use. If you need to move the computer, wait until the
hard disk stops spinning.

■ Do not spill any liquids on or near the hard disk.

■ Do not expose the hard disk to hazardous vapors, such as
those from cleaning solvents.

Testing and repairing disks
Both floppy disks and hard disks can become damaged by
repeated use and handling. If you see a message reporting that 
a disk is damaged or unreadable, you can use Disk First Aid or
Apple HD SC Setup to try to diagnose and correct the problem.
Both programs are supplied with your system software.

If you have a PowerBook 100, you may be able to correct a
problem with your hard disk by connecting your computer to a
desktop Macintosh and then reinstalling the system software on
your PowerBook from the desktop computer. (See “Using Your
Computer as a SCSI Disk” in Chapter 15 for more information.)

If a hard disk icon doesn’t appear

If you can’t start up from a hard disk or don’t see its icon on the
desktop, try the following:

■ If the hard disk is internal, shut down your Macintosh, wait 
at least 10 seconds, and then turn it on again.

■ If the hard disk is your startup disk, start up with a different
disk. If the hard disk’s icon appears on your desktop, reinstall
system software on the hard disk (use your backup copy or
use the original system software).

continues >
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■ If the hard disk is external, make sure it is turned on and its
cable is connected firmly; then restart the Macintosh.

■ If you use more than one hard disk with your Macintosh,
check the ID numbers of all SCSI equipment connected to
your computer. If any two devices have the same ID number,
or if any external device has the ID number 7 or 0, the
computer will not recognize one of the devices. Change the
numbers so that each device has its own ID number. Also
check that the chain of devices is terminated properly. (See
Chapter 15 for information about setting SCSI ID numbers and
checking termination.)

Using Disk First Aid

You can use the Disk First Aid program to test floppy disks 
and hard disks that may have been damaged. Disk First Aid 
also repairs some types of disk damage.

1. Locate and open the Disk First Aid icon.

Disk First Aid is on the system software disk labeled 
Disk Tools.

2. Click the Drive or Eject button as necessary until the
name of the disk you want to test appears.

If you are testing a floppy disk, you need to insert it into a
floppy disk drive.

3. Click Open.
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4. If you wish, choose Repair Automatically from the
Options menu. Then click the Start button to begin
testing the disk.

5. When testing and repair are finished, choose Quit from
the File menu.

If you want to test another disk, choose Close from the File menu,
then select and open the other disk (repeat steps 2 and 3).

If Disk First Aid cannot correct the problem:

■ Try repairing the disk again. Sometimes repeating the process
corrects the problem.

■ Use another disk repair or recovery program. Some disk repair
programs let you recover information from a damaged disk.

■ Consult a specialist for help.

■ Once you have recovered all the information you can, erase
(reinitialize) the disk. If the initialization process doesn’t work,
discard the damaged floppy disk, or take the hard disk to your
authorized Apple service provider for repair.
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Testing a hard disk

You can test a hard disk with the Apple HD SC Setup program.

1. Locate and open the Apple HD SC Setup icon.

Apple HD SC Setup is on the system software disk labeled
Disk Tools.

2. Click the Drive button until the disk you want appears.

3. Click Test.

4. Click OK.

5. When a message tells you that testing is complete, 
click Quit.

If the test reveals a problem, you may be able to correct it 
by using Disk First Aid or another disk repair program, or 
you may have to reinitialize the disk. Consult a specialist 
for assistance if necessary.
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Organizing Your Files
In this chapter

■ Straightening up your files

■ Using folders to organize your files

■ Filing documents when you save them

■ Making items easier to find

■ Finding an item

■ Creating a template or stationery

■ Getting information about your files

Straightening up your files

To accomplish this . . . Do this . . .

Straighten up all icons on the  Choose the Clean Up command
desktop or in the active window from the Special menu

Straighten up selected icons only Hold down the Shift key 
while choosing Clean Up

Arrange icons alphabetically by Hold down the Option key 
name, or according to the list while choosing Clean Up
view displayed most recently in 
that window

Line up icons near the right edge Click the desktop, then hold down the 
of the desktop Option key while choosing Clean Up
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Using folders to organize your files
Macintosh folders, like the paper folders in a file cabinet, can be
used to store and organize your work. You can place one folder
inside another to create a hierarchy of files.

Creating and naming folders

You can create a new folder whenever the Finder is the active
program.

1. Choose New Folder from the File menu.

A new folder named “untitled folder” appears in the active
window (or on the desktop if no window is active). The name
is already selected.

2. Type a name for the folder and press Return.

You move, copy, and remove folders in the same way that you do
other icons.

Many programs also let you create and name a new folder in the
dialog box that appears when you save a document.
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Filing documents when you save them
The first time you save a document (or whenever you choose Save
As to create another version of that document), a directory dialog
box appears. A directory is the list of files and folders contained in
a folder or on a disk.

You use this box to name your document and indicate where 
to store it. Directory dialog boxes vary slightly from program 
to program, but all share certain features.
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Type a name for
the document here.

The name of the current 
directory; use this pop-up menu 
to choose a higher-level directory.

Click to list the items on
the Macintosh desktop.

This directory window lists the files
and folders inside the folder or disk
named in the pop-up menu above.

The name of 
the current disk

When you open a folder,
its contents are listed in

the directory window.
Click to create 
a new folder.

Click to save the document 
in the directory named at 
the top of the window.



Making items easier to find
Your Macintosh provides several ways to make a file, folder, 
or other item easy to find and open. You can

■ create aliases for the item and put the aliases in convenient
locations

■ install the item (or its alias) in the Apple menu

■ move the item (or its alias) to the Macintosh desktop

Using an alias

An alias represents and points to a file, folder, disk, or other item
(even a shared item on a network). You can make as many aliases
for an item as you want. See Chapter 6 for more information on
aliases.

Creating an alias

1. Click to select the item you want to make an alias for.

2. Choose Make Alias from the File menu.

The alias appears overlapping the original item. Its name is in
italics and ends with “alias.”

3. If you wish, type a new name for the alias (the name is
already selected), and then move it to a new location.

Uses of aliases

Alias for Location Purpose

Any item that Everywhere the You can get access to an 
could be stored item logically fits item from several places.
in several places

Apple Menu  On the desktop You can easily add or 
Items folder remove Apple menu items.

A program that On the desktop; You can start the program  
must stay with in the Apple without opening the folder 
certain files menu or disk where it is stored.

A document or Anywhere on When opened, the alias 
folder stored on your work disk asks for the disk by name, 
a separate disk then opens the original 

when the disk is inserted.

An item on a Anywhere on When opened, the alias 
shared disk your work disk automatically connects to

the shared disk and opens
the item.

❖ Trouble? If you open an alias and nothing happens, or if 
you see a message that the original file isn’t available, then 
the alias is damaged or the original has been deleted. You 
can open the alias’s Info window to find out where the
original is. ❖
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Locating the original of an alias

An alias’s Info window shows the location of the original.

1. Select the alias whose original you want to find.

2. Choose Get Info from the File menu.

The alias’s Info window appears.

3. Click the Find Original button.

The window containing the original item opens. The icon is
selected. (If the original is on another disk, you’re asked to
insert the disk.)

If you deleted the original, or if the network is not available,
you’ll see a message that the original can’t be found. Aliases
are not deleted when the original is deleted.

Installing an item in the Apple menu

You can install any item in the Apple menu, and then open the
item by choosing it from the menu.

1. Open the System Folder icon and locate the Apple Menu
Items folder.

2. Drag the item you want to install (or its alias) into the
Apple Menu Items folder.

The item appears immediately in the Apple menu.

You remove an item from the Apple menu by opening the Apple
Menu Items folder and dragging its icon out of the folder.

❖ Trouble? If the Apple menu does not contain the items it
should, make sure that the Apple Menu Items folder is in the
System Folder of your startup disk. If it is, open the folder to
check that all the items you want in the menu appear there. ❖

Moving an item to the desktop

You can make an item easy to find by dragging its icon to the
desktop. The icon stays there until you remove the disk on which
the item is stored.

If you’ve placed an icon on the desktop, you can put it back in its
original location by selecting the item and choosing Put Away
from the File menu.
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Finding an item
When the Finder is the active program, you can use the Find
command in the File menu to find any item on any disk on the
desktop. (The Find command cannot locate items inside the
System file, such as fonts and sounds. You need to open the
System file to see its contents.)

Finding an item by name

1. Choose Find from the File menu.

The dialog box that appears lets you find an item by name.

If the dialog box you see has more items than shown here,
click the Fewer Choices button in the lower-left corner.

2. Type the name (or part of the name) of the item you
want to find.

It doesn’t matter whether you type capital or small letters.

3. Click the Find button.

The first item that matches the name (or partial name) you
typed is shown highlighted in a Finder window. If no item
matches, you hear an alert sound.

4. To see the next matching item, choose Find Again from
the File menu.

If no more items are found, you hear an alert sound.

126 Chapter 11: Organizing Your Files

Click to start a search.

Type the name (or partial
name) you want to find.

Click to choose additional
search criteria.



Finding an item using other criteria

You can use the Find command to find a file or a folder by
specifying its size or label, the date it was created or modified, 
or other characteristics.

1. Choose Find from the File menu.

The Find dialog box appears.

2. If you see a button labeled More Choices, click the
button.

The dialog box that appears lets you select different search
characteristics using pop-up menus.

The content of the middle pop-up menu and the text area vary
according to the item selected in the left pop-up menu.

3. Choose an item from the left pop-up menu.

4. Choose an item from the middle pop-up menu.

5. Adjust the date, choose an item, or type text in 
the upper-right area of the dialog box.
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6. Choose a search location from the pop-up menu 
labeled Search.

7. If you want all items displayed at once, click the
checkbox labeled “all at once.”

8. Click the Find button when you’ve finished selecting
options.

The first matching item is shown highlighted in a Finder
window or on the desktop. To see the next matching item,
choose Find Again from the File menu. If no item is found,
you hear an alert sound.

When you display items all at once, they are shown
highlighted in an outline view.

128 Chapter 11: Organizing Your Files

A list view,
in outline

form, shows
the contents
of folders at
all levels on

the disk.

Indentation means that an item
is located inside a folder.

Disk selected for searching



Finding items that meet two criteria

You can locate items that meet two sets of criteria, such as all items
created before a certain date and larger than a certain size.

1. Choose the first criterion.

2. Click the “all at once” box so that an X appears.

3. Click the Find button.

The items found are shown highlighted in an outline view.

4. Choose the Find command again, before you click or
take any other action.

You choose Find immediately so that the items located in the
first stage of the search remain highlighted.

5. Choose the second criterion.

6. Choose “the selected items” in the pop-up menu labeled
Search.

7. Click Find to begin the second stage of your search.

The items meeting both criteria are highlighted.

Ways to use the Find command

The Find command can help you locate files quickly, organize
documents, and develop an efficient system for backing up and
archiving your work.

This characteristic Can be used to locate

Name 1.  Files whose names you can’t recall exactly
2.  All items for which you use a standard name, 

such as status reports or expense reports

Kind 1.  All application programs
2.  All aliases

Size Large files, to make space available on a disk

Label All the files to which you added the same label 
(such as “top secret”)

Lock Locked files, to unlock them for editing

Modification date All files changed since a certain date, 
to back up new and changed files

Creation date All files created before a certain date, 
to archive or erase outdated material
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Creating a template or stationery
Most documents can be saved as or converted into a stationery
pad, which is a template form of the document. The template
retains the format and content it had at the time you made it into
stationery, and you can use it repeatedly as a master for similar
documents.

Many programs let you save a document as a stationery pad. 
If the directory dialog box that appears when you choose Save or
Save As has a stationery pad option, you can click it to save your
document as a template.

If the program you’re using does not offer a stationery pad option,
you can use a document’s Info window to create a stationery pad.

1. Click the icon of the document to select it.

2. Choose Get Info from the File menu.

3. Click “Stationery pad” near the lower-right corner 
so that an X appears in the checkbox.

Clicking “Stationery pad” converts the document from an
ordinary document to a stationery pad. 

4. Close the Info window. 

The document icon now appears as a stationery pad icon.

When you open a stationery pad, an untitled window appears
showing the contents of the stationery, or a dialog box appears
asking you to name the new document.

You cannot change the stationery pad itself unless you turn it 
back into a regular document. You can do this by opening the
stationery pad’s Info window and clicking “Stationery pad” to
remove the X.
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Getting information about your files
When the Finder is the active program, you can obtain information
about your files in two places:

■ in the file’s Info window

■ in the View menu

Using the Info window

The Get Info command displays information about a 
selected item.

1. Click to select the item you want information about.

2. Choose Get Info from the File menu.

You can use the Info window to lock a file (so it can’t be
changed), turn a document into a stationery pad, change 
the amount of memory a program uses (see Chapter 8), 
and change a file’s icon (see Chapter 12).

You can type comments in the Info window and use the 
Find command to search for them later.

3. Click the close box.
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Using the View menu

You can use the View menu to display the contents of a window
by icon or small icon, or you can list items according to various
characteristics such as name, size, or kind. (See Chapter 12 for
information on using the Views control panel to change how files
are listed and what information is included in the list.)

Windows are preset to show icons. Displaying items in a list can
be useful when you have too many files to see easily as icons or if
you want your files arranged according to a different attribute. For
example, listing items by the date and time of their most recent
modification makes backing up files an orderly task.

When the contents of a window are displayed as a list, click any
other column heading (such as Size or the Last Modified date) to
rearrange the list according to that characteristic.

132 Chapter 11: Organizing Your Files

The type of list displayed is underlined.



Adapting the Macintosh 
to Your Own Use
In this chapter

■ Specifying which items you want opened at startup

■ Putting an item in the Apple menu

■ Putting files in the System Folder

■ Changing the items in the Label menu

■ Setting the time and date

■ Setting a time for the Alarm Clock to go off

■ Adjusting the way the trackball works

■ Adjusting the way the keyboard works

■ Setting the alert sound

■ Changing the desktop pattern

■ Adjusting the blinking of a menu item

■ Adjusting the blinking of the insertion point

■ Changing the way the contents of windows appear

■ Changing the appearance of icons

■ Assigning a label to an icon

■ Adjusting screen brightness

■ Magnifying the screen image

■ Turning off the Empty Trash warning

■ Managing memory
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Specifying which items 
you want opened at startup
To have a program or a document open automatically when you
start up your Macintosh, drag the icon or its alias to the Startup
Items folder, which is inside the System Folder. You can open as
many items at startup as your computer’s memory allows.

If you no longer want an item to open automatically, remove its
icon or alias from the Startup Items folder.

Putting an item in the Apple menu
Choosing an item from the Apple () menu opens that item, 
so the Apple menu is a convenient place to list items you 
open frequently.

To put a program, document, or other item in the Apple menu,
drag its icon or alias to the Apple Menu Items folder, which is
inside the System Folder. (If you drag a desk accessory to the
System Folder icon, it’s automatically placed in the Apple Menu
Items folder.)

To remove an item from the Apple menu, open the Apple Menu
Items folder and drag the item out of the folder.

Putting files in the System Folder
Certain types of programs and other files need to be installed in
the System Folder so your Macintosh can use them as part of the
system software. These files include

■ system extensions and control panels

■ “preferences” files belonging to application programs

■ drivers for printers, scanners, and other equipment

■ sounds (instructions for installing sounds are in this chapter)

■ fonts (instructions for installing fonts are in Chapter 13)

Sometimes you need to use a special installation program to install
these files. Check the information that came with the files for
instructions. You can install many files simply by dragging their
icons to the System Folder icon (not the System Folder window).
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When you drag a system file icon to the System Folder icon, the
Macintosh recognizes which type of file it is and stores it in the
appropriate folder. (If you drag an icon to the System Folder
window, it is not stored automatically.)

To install items in the Apple Menu Items folder or the Startup
Items folder inside the System Folder, you need to drag them
directly to the correct folder.

Removing files from the System Folder

You remove a file from the System Folder by dragging its icon out
of the System Folder (or out of a folder inside the System Folder).

Depending on which external devices you use, whether you’re
connected to a network, and how you use your Macintosh, you
can remove the following types of files from your System Folder 
if you want to conserve space on your startup disk:

■ software for printers or other equipment you don’t use

■ networking software, if you are not on a network

■ Apple menu items you don’t use (you need the control 
panels, but you may not need the Calculator or the Puzzle, 
for example)

■ extra fonts, sounds, or keyboard files

Make sure you have backup copies of the files on floppy disks
before you remove them from your hard disk.
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Changing the items in the Label menu
Labels are for your convenience in tagging files, so you may want
to change the names of the labels.

1. Choose Control Panels from the Apple menu and open
the Labels control panel.

2. To change a label, drag across its name to select it 
and then type a new name.

Setting the time and date
Your Macintosh has a clock that keeps track of the time and date.
Once you set it, it keeps the correct time unless all batteries—
main and backup—are drained, removed, or switched off.

Many programs rely on the clock to automatically enter times and
dates in documents you create or print.

1. Choose Control Panels from the Apple menu and open
the General Controls panel.

The time and date controls are in the lower-right corner.

2. Click the hour, minute, or second in the time display.
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3. Click the up or down arrow until the correct time
appears.

Repeat steps 2 and 3 as necessary to set the time.

You can choose a 12-hour or a 24-hour clock by clicking 
the buttons below the time display.

4. Click the clock icon (next to the word “Time”) to set 
the current time.

5. In the date display, click the month, day, or year.

6. Click the up or down arrow until the correct date
appears.

Repeat steps 5 and 6 as necessary to set the date.

7. Click the calendar icon (next to the word “Date”) 
to set the current date.

8. Close the General Controls window.

You can also set the time and date in the Alarm Clock, which 
you open by choosing Alarm Clock from the Apple menu.

Setting a time for the 
Alarm Clock to go off
You can set the Alarm Clock to alert you when it’s time for 
an appointment or a meeting.

1. Choose Alarm Clock from the Apple menu.

2. If necessary, click the lever at the right to expand 
the Alarm Clock.

continues >
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3. Click the alarm clock icon in the lower-right corner.

The current alarm clock setting appears in the middle section.

4. Click the hour, minute, or second in the alarm clock
setting.

5. Click the up or down arrow until the time you want
appears.

Repeat steps 4 and 5 as necessary to set the alarm.

6. Click the button to the left of the alert time to turn the
alarm on.

The button moves up and the alarm clock icon changes to
indicate that the alarm is turned on. (Clicking the button again
turns the alarm off.)

7. Click the close box.

Turning the alarm off

When the alert time arrives, the alert sound plays twice (the 
menu bar flashes once if the speaker volume is set to zero) and 
an alarm clock icon blinks over the Apple icon at the left end of
the menu bar.

To stop the blinking, open the Alarm Clock.

To turn off the alarm, open the Alarm Clock and click the button 
to the left of the alarm clock setting.
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Adjusting the way the trackball works
The Mouse control panel allows you to adjust the action of input
devices, including a trackball.

You can adjust two aspects of trackball operation: tracking,
which is the relation between trackball rolling speed and 
pointer movement on the screen, and double-clicking speed.

1. Choose Control Panels from the Apple menu and 
open the Mouse control panel.

2. Click the tracking speed you want.

If you click Fast, the pointer moves more than twice as fast 
as the trackball. The Very Slow option is useful for drawing
because the pointer moves at a constant speed relative to
trackball movement.

3. Click the double-clicking speed you want.

You may want to adjust the double-clicking speed if your
Macintosh often interprets two single clicks as a double click,
or a double click as two single clicks.
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Adjusting the way the keyboard works
You can adjust the rate at which a character repeats when a key is
held down, and the delay before the character begins repeating.
You can also change the keyboard layout.

1. Choose Control Panels from the Apple menu and open
the Keyboard control panel.

2. To adjust the rate at which a key repeats when it is held
down, click the button for the rate you want.

3. To adjust the delay before keys repeat, click the button
for the delay you want.

If keys repeat when you don’t want them to, you can set a
longer delay before a character begins repeating. (If you click
the Off button, the keys don’t repeat.)

4. To change the keyboard layout, click the name of the
layout you want to use.

Depending on which country you bought your Macintosh in,
you may have a choice of more than one keyboard layout.
(Additional keyboard layouts are available from various
sources. You install them by dragging them to the System
Folder icon.)

5. Close the Keyboard control panel.
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Making keyboard shortcuts easier to type

A feature called Sticky Keys allows you to type keyboard shortcuts
without pressing the keys simultaneously.

To turn Sticky Keys on or off, press the Shift key five times without
moving the trackball.

With Sticky Keys on, you can type a keyboard shortcut by first
pressing the modifier key (x, Option, Control, or Shift) and then
pressing the character key. An icon at the right end of the menu
bar (to the right of the Application menu icon) indicates whether
Sticky Keys is on and whether a modifier key has been pressed 
or locked.

Sticky Keys can make an alert sound when a modifier key is
pressed. You set this option in the Easy Access control panel
(choose Control Panels from the Apple menu and open Easy
Access).

Adjusting the keyboard to ignore 
accidental keystrokes

A feature called Slow Keys allows the computer to ignore
accidental keystrokes by delaying the acceptance of each
keystroke.

To turn Slow Keys on or off, hold down the Return key for 
a few seconds until you hear an alert sound.

You can adjust the delay and you can turn on a click each time 
a keypress is accepted. You make these adjustments in the Easy
Access control panel (choose Control Panels from the Apple 
menu and open Easy Access).
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Setting the alert sound
Many programs make an alert sound when your attention is
required or when you’re trying to do something that the program
cannot recognize or allow.

You can choose the sound you want, and you can also set the
sound’s volume.

1. Choose Control Panels from the Apple menu and open
the Sound control panel.

2. Click the alert sound you want the Macintosh to use.

The sound plays at the current volume setting when you 
click it.

(The PowerBook 140 and 170 computers come with a
microphone that you can use to record sounds. See
“Recording Sounds” later in this chapter for information.)

3. Drag the slider up or down to set the volume level.

If you prefer to be alerted silently, drag the slider to zero.
Instead of hearing an alert sound, you’ll see the menu 
bar flash.

4. Close the Sound control panel.
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Installing a sound

To install a sound, drag its icon to the System Folder icon (not the
System Folder window). The sound is automatically installed in
the System file and listed in the Sound control panel.

Removing a sound

Removing a sound deletes it from the disk, so make sure you have
a backup copy of the sound before you remove it.

1. Choose Control Panels from the Apple menu and open
the Sound control panel.

2. Click the sound you want to remove.

Make sure you select the correct sound. You cannot undo 
the next step.

3. Choose Cut or Clear from the Edit menu.

4. Close the Sound control panel.

You can also remove a sound by dragging its icon out of the
System file and out of the System Folder. This does not delete 
the sound from the disk.

Recording sounds

The PowerBook 140 and 170 computers have a sound input port
to which you can connect a microphone.

You can record a sound and add it to the list of alert sounds in 
the Sound control panel.

1. Connect a microphone to your computer (see 
Chapter 15 if you need instructions).

2. Choose Control Panels from the Apple menu and 
open the Sound control panel.

Icons representing the available sound input devices 
appear near the bottom of the window.

3. Click the sound input device you want to use.
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4. Click the Add button.

5. Click the Record button.

Recording begins immediately; you have up to ten seconds 
to record your sound. There is no volume control.

6. Click Stop to stop recording.

7. To listen to the sound, click Play.

8. To save the sound, click Save.

9. Type a name for the sound and click OK.

The new sound appears in the Sound control panel.

10. Close the Sound control panel.

Changing the desktop pattern
You can change the pattern that appears on the Macintosh
desktop.

1. Choose Control Panels from the Apple menu and open
the General Controls panel.
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You can choose from a variety of patterns provided for the
Macintosh desktop, or you can create your own design by
editing one of the patterns supplied.

2. To see the patterns available, click one of the small
triangles at the top of the miniature desktop.

3. To see a new pattern on your desktop, click the
miniature desktop.

4. To edit a pattern, click in the square to the left of the
miniature desktop.

Each dot (pixel) in the square changes from white to black 
(or from black to white) when you click it. Your changes are
displayed on the miniature desktop.

5. When you’ve finished creating your new pattern, 
click on the miniature desktop to display the pattern 
on your desktop.

You can save the new pattern by double-clicking on the
miniature desktop. Otherwise the pattern is lost when you
display another pattern.
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Adjusting the blinking of a menu item
You can change the number of times a menu item blinks when it’s
chosen. You make this adjustment in the General Controls panel
(choose Control Panels from the Apple menu and then open the
General Controls panel).

To adjust menu blinking, click the button for the number of 
times you want the menu item to blink. Or click the Off button 
for no blinking.

Adjusting the blinking 
of the insertion point
You can adjust how quickly the insertion point blinks. The
insertion point indicates where text you type will appear. You
make this adjustment in the General Controls panel (choose
Control Panels from the Apple menu and then open the General
Controls panel).

To adjust the blinking of the insertion point, click the button 
for the blinking rate you want.
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Changing the way the contents 
of windows appear
You can change the way the contents of Finder windows are
displayed. You make these changes in the Views control panel.
(Choose Control Panels from the Apple menu and open the 
Views control panel.)

Use the Views control panel to change

■ what options appear in the View menu

■ the font and font size used in the Finder (press to open 
the pop-up menu, then drag to choose a font or a size)

■ the arrangement of icons or small icons

■ the size of icons used in list views

■ what information is included in list views
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Changing the appearance of icons
To change an icon, you create or copy a picture in a graphics
program and then paste it into the icon’s Info window.

Some icons can’t be changed, including those for control panels
and other parts of the system software.

1. In a graphics program, select the picture you want 
to use for the icon.

2. Copy the picture by choosing Copy from the Edit menu.

3. Switch to the Finder, then click the icon you want 
to change.

4. Choose Get Info from the File menu.

5. Click the icon at the upper-left corner of the Info
window to select it.

A box appears around the icon when it’s selected. If no box
appears when you click, the icon can’t be changed.

6. Choose Paste from the Edit menu.

The picture you copied appears in the Info window. If the
picture is bigger than the icon, it automatically shrinks to fit.
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7. Click the close box to close the Info window.

You can change an icon back to its original appearance by 
clicking the picture in the Info window and choosing Cut 
from the Edit menu.

Assigning a label to an icon
You can add a label to each icon. The label is visible when the
contents of a window are displayed as a list (choose By Label from
the View menu). Labels provide a way to group related files.

To assign a label, click the icon to select it and then choose the
label that you want from the Label menu.

Adjusting screen brightness
Macintosh PowerBook computers have brightness and contrast
controls below the screen.

The PowerBook 170, which has an active matrix display, does not
have a contrast control because the screen automatically provides
contrast appropriate for the available lighting.

On all PowerBook computers, the screen brightness range is
increased if the power adapter is plugged in. (There may be a few
minutes’ delay before you notice a difference.)
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Magnifying the 
screen image

The CloseView control panel lets you
magnify the image on your Macintosh screen
up to sixteen times.

CloseView is not automatically installed by
the Installer program when you install system
software.

To install CloseView:

1. Locate the CloseView control panel.

It’s on one of your system software disks.

2. Drag the CloseView icon to the
System Folder icon (not the System
Folder window) on your startup disk.

Click OK in the dialog box.

3. Choose Restart from the Special
menu.
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To turn CloseView on or off, press 
x-Option-O.

To turn the magnification on or off, press 
x-Option-X. (When CloseView is on and the
magnification is off, a rectangle on the screen
indicates which area will be magnified. You
can move the rectangle by moving the
pointer.)

To increase or decrease magnification, 
press x-Option–Up Arrow or 
x-Option–Down Arrow.

You can set additional options in the
CloseView control panel (choose Control
Panels from the Apple menu and open the
CloseView control panel).
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Turning off the Empty Trash warning
When you choose Empty Trash from the Special menu, you see a
warning message. The message helps you avoid throwing away
items unintentionally.

You can turn off this warning in the Info box for the Trash.

1. Click the Trash icon to select it.

2. Choose Get Info from the File menu.

3. Click the checkbox labeled “Warn before emptying” 
to remove the X.

To turn the warning back on, click the checkbox so that 
an X appears.

You won’t see the warning when it is on if you hold down the
Option key when you choose the Empty Trash command.

Until you choose the Empty Trash command, items in the Trash
continue to occupy space on your disk.

Managing memory
You can adjust the way your Macintosh uses its RAM in order 
to open more programs and documents.

Checking memory use

You can find out about memory use by making the Finder the
active program and choosing About This Macintosh from the
Apple menu.

You can adjust how much memory a program uses (see Chapter 8
for instructions).

If you’re unable to open a program or use network services, try
quitting one or more programs to free some memory. If you open
and quit several small programs, you may notice that you cannot
open as many programs as you usually can. You may be able to
solve this problem by quitting and restarting all your programs.
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Adjusting the disk cache

A disk cache is RAM set aside to hold frequently used program
information. The disk cache helps programs work more quickly
and efficiently by minimizing the time the computer spends
reading information from a disk. The larger the disk cache,
however, the less memory available for opening programs and
documents.

The preset and maximum sizes of the disk cache depend on the
amount of memory your Macintosh has. If you often want to open
more programs than memory allows, try setting the disk cache to 
a smaller size.

You set the size of the disk cache in the Memory control panel
(choose Control Panels from the Apple menu and open the
Memory control panel).

To set the size of the disk cache, click the up or down arrow next
to the Cache Size box. The new size takes effect after you choose
Restart from the Special menu.
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Using hard disk space as memory

PowerBook 140 and 170 computers can borrow space on 
a hard disk to increase memory. The disk space, called virtual
memory, is not available for storing information.

For best performance, your Macintosh should contain enough
built-in memory to support the programs you typically use. 
But you can use virtual memory when you want to open more
programs or work with larger documents than you usually use.

Performance is better with virtual memory when you are using
several small programs simultaneously (as opposed to one 
large program).

Because virtual memory requires frequent hard disk access, you
should use it only when you are working with your computer’s
power adapter plugged in. For maximum efficiency, you should
also click the “Stay awake when plugged in” checkbox in the
Portable control panel.

If your Macintosh can use virtual memory, you adjust it in the
Memory control panel (choose Control Panels from the Apple
menu and open the Memory control panel).
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1. To turn on virtual memory, click the On button.

A message advises you that virtual memory requires more
hard disk use and therefore draws more battery power.

2. Click OK.

If more than one hard disk is connected to your computer, 
the Select Hard Disk menu becomes active.

3. Choose the hard disk on which you want to set aside
space for virtual memory.

4. Click the up and down arrows to adjust the disk space
to set aside.

The preset amount of virtual memory is the same as the
amount of RAM in your Macintosh. Using this preset size 
is recommended, because using a larger amount of virtual
memory is likely to slow the computer’s performance.

5. Choose Restart from the Special menu.

After you restart, your computer’s total memory includes the
virtual memory you set aside on the hard disk.

▲s▲s Important: When you turn on virtual memory, the system
software creates a file named VM Storage in your System
Folder (if the startup disk is used for virtual memory) or on 
the desktop (if another hard disk is used). This file is large—
the size of the computer’s RAM plus the designated amount 
of virtual memory. For example, if your Macintosh has 4 MB 
of RAM and you add 2 MB of virtual memory, the VM Storage
file occupies 6 MB on your startup disk. ▲s▲s
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Turning on 32-bit addressing

The PowerBook 140 and 170 support a feature called 32-bit
addressing, which allows you to open larger applications. To use
32-bit addressing, you need 8 MB or more of total memory (RAM
plus virtual memory).

You turn 32-bit addressing on or off in the Memory control panel.
(Choose Control Panels from the Apple menu and open the
Memory control panel.)

▲s▲s Important: Not all programs support 32-bit addressing. 
The use of such programs when 32-bit addressing is turned 
on may cause problems with your computer. Check with 
the software manufacturer to find out whether your 
program is compatible. ▲s▲s

To turn 32-bit addressing on or off, click the appropriate button in
the control panel, and then choose Restart from the Special menu.

Tips for using memory efficiently

The following suggestions may be helpful if you see “not enough
memory” messages while you work.

■ Quit open programs you are not using.

■ Before you print on a LaserWriter printer, quit open programs
you are not using; you may also want to turn off background
printing. (Open the Chooser and click the Off button.)

■ Set the disk cache to 32K. (See “Adjusting the Disk Cache”
earlier in this chapter.)

■ Turn off file sharing if you are not using it. (See “Turning File
Sharing Off ” in Chapter 14.)

■ If you have opened and closed several programs, quit all open
programs and restart your computer. (Choose Restart from the
Special menu.)
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Printing
In this chapter

■ Before you print

■ Printing your work

■ Controlling background printing

■ Working with fonts

Before you print
Before you can print, your Macintosh must be connected to a
printer, either directly or over a network. See the information that
came with your printer for instructions on how to connect it.

Choosing a printer

Once your printer is connected, you must tell the Macintosh which
printer to use by choosing that printer. You need to do this even 
if only one printer is connected to your computer. You choose a
printer when you’re using a printer for the first time and whenever
you change printers.

You choose the printer in a program called the Chooser. How you
use the Chooser depends on whether your printer is connected
directly or over a network.
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If your printer is connected directly to your computer

Make sure you’ve connected the printer according to the
instructions that came with it.

1. Choose the Chooser from the Apple menu.

2. Click to select the icon of the printer you want to use.

❖ If your printer’s icon does not appear in the Chooser:
The printer software is not in your System Folder. Close the
Chooser and install the software you need. If you have an
Apple printer, you can use the Installer to add the printer
software. (The process is the same as the one described in
“Updating Printer Software on Networked Computers,” later 
in this chapter.) If your printer is not an Apple printer, see 
the information that came with it for instructions on installing
its software. ❖

If you have a Personal LaserWriter® SC, go to step 5 now.

3. Click to select the icon of the port to which your printer
is connected.

If your printer is connected to the computer’s modem port, 
go to step 5 now.

If your printer is connected to the computer’s printer port,
continue with step 4.

4. Click the Inactive button next to the word “AppleTalk.”

If Inactive wasn’t already selected, a message appears. 
Click OK.

5. Close the Chooser window.
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If your printer is connected over a network

Ask your network administrator or the person who set up your
computer to tell you

■ which printer you can use

■ which zone it’s in (if the network has zones)

■ what its name is (every printer on a network has its own name)

1. Choose the Chooser from the Apple menu.

2. Click the Active button next to the word “AppleTalk.”

If Active wasn’t already selected, a message appears. 
Click OK.

3. Click the icon representing the type of printer you want
to use.

You may have to scroll to find the icon.

❖ If your printer’s icon does not appear in the Chooser:
The printer software is not in your System Folder. Close 
the Chooser and install the software you need. If you have 
an Apple printer, you can use the Installer to add the printer
software. (See “Updating Printer Software on Networked
Computers,” later in this chapter.) If your printer is not an
Apple printer, see the information that came with it for
instructions on installing its software. ❖

4. If the Chooser lists AppleTalk zones, click the zone
where the printer is located.

Zones are listed alphabetically.

5. Click the name of the printer you want to use (even if
only one name appears).

6. If you want to continue using the Macintosh while your
document is being printed, click the On button next to
Background Printing.

Background printing is not available with all printers. The
PrintMonitor program must be in your System Folder.

7. Close the Chooser.
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Selecting Page Setup options

You use the Page Setup dialog box when you’ve selected a new
printer in the Chooser, or when you want to use a different paper
size or printing options.

■ Choose Page Setup from the File menu and select the
options you want.

When a LaserWriter printer is selected, this Page Setup dialog 
box appears:

When an ImageWriter® printer is selected, this Page Setup dialog
box appears:

You’ll see different options for each type of printer you use. Some
programs provide additional options. You can choose Show
Balloons from the Help menu to see descriptions of the options,
or check your printer or program manual for details.
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Updating printer software on networked computers

All computers on a network that share printers must have the
same version of the printer software. If someone on the network
prints a document from a computer using a different version of the
software, the printer restarts itself (which takes time and clears any
fonts from its temporary memory).

▲s▲s Important: All computers on a network must have the same
printer software versions in their System Folders.  ▲s▲s

You or your network administrator should update the printer
software on any Macintosh computer on the network that is using
system software earlier than version 7.0. You do not have to
update any files other than the printer software.

To update printer software, use the Installer program and the
accompanying Printer Update document (both files are on one 
of the system software disks that came with your computer).

If you store these files on a shared disk on the network, you don’t
need the system software disk to perform the update.

1. Locate the Installer and Printer Update files, and then
open the Installer icon.

2. Click OK.

The Easy Install dialog box appears.

3. Make sure that the hard disk indicated is the 
correct one.

If a different disk name appears, click the Switch Disk button
until the correct disk name appears.

continues >
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4. If you want to install software for additional printers, 
click the Customize button, and then select the names
of the printers you want to install software for.

If you only want to update the printer software that is already
installed on your disk, go to step 5.

When you click Customize, the custom installation dialog box
shows a list of printer software.

5. Click Install.

6. When you see a message reporting that installation 
was successful, click Restart.

If a message reports that installation was not successful, 
try again.

Printing your work
You can print a document while it’s open and its window is active;
you can also print documents while the Finder is active.

1. Make sure that the document you want to print is in the
active window.

If you’re printing from the Finder, select the documents you
want to print.

2. Choose Print from the File menu.

The printing options that appear depend on the selected
printer and the program in which the document was created.

If a LaserWriter printer is selected in the Chooser, this dialog
box appears:
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❖ Printing color or gray-scale documents: You can print color 
or gray-scale documents on any color printer that can use the
LaserWriter printer software. If you print a color document 
on a black-and-white printer, the document is produced as a
halftone (that is, it is composed of patterns of dots).  ❖

Some programs offer additional printing options. See the
manuals that came with your programs for more information
on their printing features.

3. Click Print.

After a moment, a status message appears. If background
printing is turned on, the message disappears after a few
seconds, and you can do other work while printing continues.

Printing the contents of a window or the desktop

You can print the contents of the active window when you’re
working in the Finder.

1. Make sure that the window whose contents you want 
to print is active.

2. Choose Print Window from the File menu.

3. Select the options you want.

4. Click Print.

The window’s contents are printed, including items not 
visible on the screen.

When no window is active, you can print the items on 
the desktop by choosing Print Desktop from the File menu.
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Solutions to common printing problems

If nothing happens or if you see an error message when you try 
to print, try the following:

■ Make sure that the printer is turned on and warmed up.

■ Check the cable connections to the printer.

■ If your printer is an ImageWriter, make sure that the Select
light is on. (If not, press the Select button.)

■ Make sure that a printer (and its name, if it’s a LaserWriter) 
is selected in the Chooser.

■ Make sure that you are using the same version of the printer
software as everyone else on your network.

■ If an error message states that the printer could not print your
document, turn off the printer for at least 10 seconds. Then
turn it on again, wait for the printer to warm up, and try to
print again.

Controlling background printing
If you are using a LaserWriter or StyleWriter® printer and the
background printing option is turned on in the Chooser, you can
continue to work while your documents are printing.

You don’t need to do anything once background printing is turned
on. But if you wish, you can control background printing with
PrintMonitor, a program installed automatically if you use the
Installer’s Easy Install option.
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1. After you have started printing a document, choose
PrintMonitor from the Application menu.

When printing begins, PrintMonitor opens automatically 
and its name appears in the Application menu. When you
choose it from the Application menu, the PrintMonitor
window appears.

You can use PrintMonitor to

■ monitor the printing of your document

■ cancel a document that’s printing or waiting to print

■ set the date and time you want a document to print or
postpone printing indefinitely

■ monitor the paper supply

PrintMonitor’s icon blinks at the right end of the menu bar
when the printer is out of paper. You can change this alert
signal with the Preferences command in the File menu.

■ monitor when to feed paper manually

PrintMonitor’s icon blinks at the right end of the menu bar
to signal that you must confirm the manual printing job.
You can change this alert signal with the Preferences
command in the File menu.

2. Select the options you want, and then click the 
close box.
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Working with fonts
A font is a collection of letters, numbers, and symbols in a
distinctive typographic design.

When you install Macintosh system software, several fonts are
installed in the System file (inside the System Folder on your
startup disk). You can install additional fonts and remove fonts.

Additional fonts are supplied on one of the system software disks.
Fonts are also available from independent manufacturers, user
groups, and electronic bulletin board services.

Outline fonts and bitmap fonts

The Macintosh uses two types of fonts:

■ outline fonts

■ bitmap fonts

Both types of fonts are installed in your System file when you
install system software.

Outline fonts (also called scalable or variable-size fonts) describe
each character as a mathematical formula. The formula accurately
defines the character’s shape no matter what its size.

Your computer needs only a single outline font in a particular
typeface (such as Times®) to be able to display or print that
typeface in different sizes. The outline fonts supplied with
Macintosh system software are called TrueType™ fonts.

RRRRRRR
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Bitmap fonts (also called fixed-size fonts) describe each character
as a grid of black-and-white dots (called a bitmap). The bitmap is
a rendering of the character’s shape in a specific size.

For the best type quality, your computer needs a separate bitmap
font of a typeface in each size you want to display or print, such as
12-point Times or 10-point Helvetica®.

Installing fonts

1. Quit all open programs.

Pull down the Application menu to make sure that the Finder
is the only open program.

2. Locate the icon of the font you want to install, and drag
it to the System Folder icon (not the System Folder
window) on your startup disk.

A message lets you know that the font will be stored in the
System file.

3. Click OK.
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Removing fonts

1. Quit all open programs.

2. Open the System Folder on your startup disk.

3. Locate the System file icon and open it.

4. Locate the icon of the font you want to remove, and
drag it out of the System file window and out of the
System Folder window.

5. Close the System file window and the System Folder
window.

Transferring fonts to a LaserWriter printer

If you’re using a LaserWriter printer equipped to handle the
PostScript® page description language and you want to print 
with PostScript fonts that are not built into your printer, you can
transfer, or download, those fonts from your System Folder to 
the printer. (PostScript is a programming language that describes
the appearance of a document mathematically.) You can also
download TrueType fonts. Downloading fonts saves printing time 
if you plan to print several documents that use those fonts.

When you download a font, it’s stored in the printer’s memory or
on a hard disk attached to the printer. You can download as many
fonts as the printer’s memory and hard disk space allow.

You download fonts with the LaserWriter Font Utility, which is
supplied with the system software disks.

1. Locate and open the LaserWriter Font Utility icon.
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2. Choose Download Fonts from the File menu.

3. If the font you want to download is not listed, click 
the Add button to add fonts to the list.

Use the directory dialog box that appears to locate the fonts
you want.

4. Click the name of the font you want to download, 
and then click Add.

5. When you’ve added all the fonts you want to download,
click Done.

The fonts you added are listed in the Font Utility dialog box.

6. Click Download to send all the fonts in the list to the
printer or its hard disk.

You can click Cancel to stop the process.

7. Click OK when downloading is finished.

8. Choose Quit from the File menu.
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Finding out about available fonts

Many programs have a Font menu that lists the fonts installed in
your System file, though some programs do not list them all. (You
can open the System icon, inside the System Folder, to see all the
fonts stored there.)

The LaserWriter Font Utility program (supplied with the system
software disks) provides three ways to see the fonts available for
printing on a LaserWriter: you can display a list of fonts on the
screen, print a font catalog, or print a set of font samples.

Other ways to use the LaserWriter Font Utility

You can also use the LaserWriter Font Utility program to

■ initialize a hard disk attached to a printer

■ control whether a printer prints a start page

■ restart a printer

■ send PostScript files to a printer

Initializing a hard disk attached to a printer

You can attach a hard disk to some printers. A hard disk allows
you to store more fonts. See the manual that came with your
printer for information about connecting a hard disk.

1. Open the LaserWriter Font Utility icon.

2. Choose Initialize Printer’s Disk from the File menu.

3. Click the Drive button until you see the name of the
hard disk you want to initialize.

4. Click Initialize.

170 Chapter 13: Printing

Displays a window
listing all fonts 

available to the printer

Prints a sample of
each font available

to the printer

Prints a list of the
fonts available to

the printer



Restarting a LaserWriter printer

Restarting the printer clears its memory, removing the fonts 
stored there.

1. Open the LaserWriter Font Utility icon.

2. Choose Restart Printer from the Utilities menu.

3. Click Restart.

Turning the printer’s start page on or off

The LaserWriter can print a start page each time it is turned on 
or restarted.

1. Open the LaserWriter Font Utility icon.

2. Choose Start Page Options from the Utilities menu.

3. Click the On or Off button.

4. Click OK.
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Transferring a PostScript file to a LaserWriter

You can use the LaserWriter Font Utility to send a file in PostScript
format to a LaserWriter.

1. Open the LaserWriter Font Utility icon.

2. Choose Download PostScript File from the Utilities
menu.

3. Click the name of the file you want to download to the
printer, and then click Open.

A dialog box asks you to name a file that saves a record of 
the PostScript activity. If you don’t rename the file, it’s called
“PostScript Log.”

4. Type a name for the log, and then click Save.

The file is sent to the printer and a record of the PostScript
activity is saved in the log.

You can open the log to see the sequence of PostScript
commands when the file was sent.
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Using Your Macintosh 
on a Network
In this chapter

■ Setting up your Macintosh on a network

■ Gaining access to files on shared disks

■ Working with files and folders on other computers

■ Sharing your own files

■ Using access privileges

■ Linking programs

■ Using communications products with System 7

Setting up your Macintosh on a network
Before you can use your Macintosh on a network, you need to
physically connect your computer to the network and install
networking software.

If a network administrator manages the network to which you’ll 
be connecting your computer, you may want to consult that
person for advice or help.
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Connecting to a network

Your Macintosh has built-in AppleTalk networking software. This
software supports the LocalTalk® cables you need to connect your
computer to the network.

1. Choose Shut Down from the Special menu.

2. Attach the LocalTalk cable to the printer port on the
back of your computer.

See your network administrator or the documentation that
came with your cables if you need more information.

Turning on AppleTalk

The first time you turn on your computer after you have
connected it to a network, you need to make sure that 
AppleTalk is turned on.

1. Choose the Chooser from the Apple menu.

2. Click the Active button to turn on AppleTalk.

3. Close the Chooser.

When AppleTalk is active, your computer does not go to sleep
automatically unless you run out of battery power. When you put
your computer to sleep, a message reminds you that sleep may
break your network connections.

Printer port
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Naming your Macintosh and its owner

Before you use the network, you should give your Macintosh a
name and name yourself as its owner.

1. Choose Control Panels from the Apple menu and open
the Sharing Setup icon.

❖ If you can’t find or can’t open the Sharing Setup icon: Make
sure that the Sharing Setup icon is in the Control Panels folder,
and that the File Sharing Extension file and the Network
Extension file are in the Extensions folder inside the System
Folder. If not, place them there and restart your computer.  ❖

2. Type your name in the box labeled Owner Name and
press Tab.

3. Type your password in the box labeled Owner Password
and press Tab.

Your password can be up to eight characters long. After you
press Tab, your password is replaced by bullets (•) so others
can’t read it.

4. Type a name for your Macintosh in the box labeled
Macintosh Name.

This is the name others will see on the network.

5. Close the Sharing Setup control panel.
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Gaining access to files on shared disks
You can retrieve and store information on other computers
connected to your network. For example, a coworker can 
place some files for you on a shared disk called a file server—
a computer on the network dedicated to storing shared files.
Private Macintosh computers on your network might also 
have shared disks.

Before you begin

Before you store or retrieve information on the network, do the
following:

■ Find out the name of the shared disk you want to access
and the name of the computer that it’s on.

■ If your network has zones, find out the name of the
zone the computer is in.

■ Find out if you are registered on the computer or if it
allows guest access.

A Macintosh owner or network administrator can limit access
to files on a shared disk. Ask the Macintosh owner or network
administrator what type of access you have to the files.

■ If you’re a registered user, find out the name and
password you need to use.

Find out exactly how your name and password are spelled,
including capitalization.
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Connecting to a shared disk

1. Choose the Chooser from the Apple menu.

2. Make sure that AppleTalk is active.

3. Click the AppleShare® icon in the upper-left section 
of the Chooser window.

❖ If the AppleShare icon does not appear: Make sure that 
the AppleShare file is in the Extensions folder in your 
System Folder.  ❖

4. If your network has zones, click the zone the computer
is in.

If you don’t see a box labeled AppleTalk Zones, skip this step.

5. Click the name of the computer you want to use.

❖ If the name you want isn’t listed: Make sure you have 
selected the correct zone. If the zone is correct, make sure 
the computer is turned on.  ❖

6. Click OK.

7. Click Guest or Registered User.

If you are a guest, click Guest and go to step 10. If the Guest
option is dimmed, guests do not have access to this computer.
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8. If you are a registered user, make sure the name in the
box is correct.

Capitalization does not need to match.

9. Type your password.

Capitalization needs to match.

10. Click OK.

❖ If your password is not accepted: Make sure that Caps Lock 
is not on. Type your password again, taking care not to 
make typing errors. ❖

11. Click a shared disk to select it.

12. Click OK.

After you click OK, the icon of the shared disk appears on
your desktop.

13. Close the Chooser.

Disconnecting from a shared disk

When you’re finished using a shared disk, close any open files 
or programs on the shared disk and then disconnect in one of 
the following ways:

■ Select the shared disk icon and choose Put Away from the 
File menu.

■ Drag the shared disk icon to the Trash.

■ If you are finished working for the day, choose Shut Down
from the Special menu. Shutting down automatically
disconnects from the shared disk.
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Using an alias to connect quickly to a shared disk

By making an alias for a shared disk, you can connect to that disk
by simply opening the alias.

1. Connect to a shared disk.

2. Select the shared disk icon.

3. Choose Make Alias from the File menu.

4. If you wish, rename the alias, then drag it to a
convenient location.

5. Next time you want to connect to the shared disk, 
open the alias you created in step 3.

If you originally connected to the shared disk as a registered
user, a message appears. Type your password.

If you connected to the shared disk as a guest, this message
does not appear.

The shared disk icon appears on your desktop.

Connecting automatically when you start up

You can connect automatically to one or more shared disks
whenever you turn on your computer.

1. Connect to the computer that has the shared disk you
want to open.

2. Click the checkbox next to the name of the shared disk.
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3. If you’re connecting as a registered user, click the
button that indicates whether you want the shared disk
to save your name only, or both your name and your
password.

To prevent unauthorized people from gaining access to the
shared disk, click “Save My Name Only.” When you start up
your computer, you’ll need to enter your password to connect
to the shared disk.

4. Click OK.

5. Close the Chooser.

Working with files and folders 
on other computers
Once you are connected to a shared disk, you can use the files
and folders on it as if they were on your own computer.

You may not be able to open some items on a shared disk because
the owner hasn’t given you access to those items. For information
on how to check your access privileges, see “Working With
Privileges That Others Have Set” later in this chapter.

Creating a new folder on another computer

You can create a new folder on a shared disk (as long as you 
have the correct access privileges). If you are a registered user,
you become the owner of any folder that you create. If you are
connected as a guest, you share ownership of the folder with 
all guests and registered users.

The icons of folders that you own have a darkened tab.

When you own a folder, you can determine who can use it and 
in what way. See “Using Access Privileges” later in this chapter 
for more information.

180 Chapter 14: Using Your Macintosh on a Network



Changing your password

If you are a registered user, you may be able to change the
password you use to access a shared disk. (Your network
administrator can restrict this capability.)

1. Connect to the computer that has the shared disk 
you want.

2. Click the Set Password button.

If a message tells you that you cannot change your password,
your network administrator has turned off this feature.

3. Type your current password. Then press Tab and type 
a new password.

A bullet (•) appears for each letter you type.

4. Click OK.

5. Click OK in the dialog box that appears.

6. Retype your new password and click OK.

Your new password is now in effect.
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Giving folder ownership to someone else

You can give away ownership of any folder you own. Once you
do so, however, the new owner can restrict your access to that
folder. Make sure you have copies of any files you may need
before you give ownership of a folder to someone else.

1. Connect to a shared disk.

2. Click to select a folder that you own.

3. Choose Sharing from the File menu.

4. Type the name of a registered user or group in the box
labeled Owner.

5. Close the dialog box.

A message asks you to confirm that you want to change the
owner of the folder.

6. Click OK.

The user or group that you named assumes ownership
immediately.

Sharing your own files
You can share files stored on your Macintosh with others on the
network. For example, members of your work group can connect
to your computer and open a file from their own computers.
(They do not have to be using System 7.) Or, if you have both a
desktop Macintosh and a PowerBook computer, you can transfer
files from one computer to the other without using floppy disks.

You control what you share and with whom you share it:

■ You share only folders you specify.

■ You share only with the people you specify—one person, 
a group of people, or everyone on the network.

■ You can see everything on your own computer from another
computer on the network.

How file sharing works

First you turn on file sharing, then you select a folder or disk 
to share.

If you want to share only with certain people, you can

■ name the people (registered users) you want to share with

■ share a folder or disk and then pick from your list of registered
users the people with whom you want to share it

■ prevent others from seeing the shared folder or disk
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Turning file sharing on

1. Choose Control Panels from the Apple menu and 
open the Sharing Setup icon.

Make sure the boxes in the Network Identity section of 
the control panel are filled in.

2. In the section labeled File Sharing, click the 
Start button. 

3. Close the Sharing Setup control panel and the Control
Panels folder.

Continue with the next section to select a folder or disk to share.

Selecting a folder or disk to share

You can share any folder, hard disk, or CD-ROM disc connected to
your computer (you cannot share floppy disks). You can share up
to ten folders or disks at a time. (This number does not include
folders within the folders or disks you share.)

1. Make sure file sharing is turned on.

2. Select a folder or disk to share.

3. Choose Sharing from the File menu.

4. Click the box labeled “Share this item and its contents”
to place an X in it.

For information about the other checkboxes in this window,
see “Using Access Privileges” later in this chapter.
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5. Close the window and click Save in the dialog box.

Everyone on the network now has access to the item you
shared and the files and folders inside it.

If you shared a folder, its icon appears on your desktop with 
a darkened tab and network cables:

When people on the network are connected to your shared
folder, its icon appears with faces in the center:

▲s▲s Important: Before you put programs inside shared folders 
or disks, remember that copyright laws may prevent those
programs from being shared. Check the applicable licensing
agreements and follow their specifications. ▲s▲s

Making a shared folder or disk private

Any shared folder or disk can be made private again.

1. Select the shared disk icon.

2. Choose Sharing from the File menu.

3. Click the box labeled “Share this item and its contents”
to remove the X.

Your changes take effect immediately. If people are connected
to your computer, you see a message asking if you want to
proceed.
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Naming a registered user

You can register as many as 100 people and groups combined, but
for best network performance you should name no more than 50.

1. Choose Control Panels from the Apple menu and open
the Users & Groups icon.

2. Choose New User from the File menu.

An icon labeled New User appears. Its name is selected 
for editing.

❖ If you can’t find the New User command: Make sure the 
Users & Groups window is active.  ❖

3. Type the name of a person you want to register.

Make sure you notify the person of the exact name you type.
(Capitalization does not have to match.)

4. To register more users, repeat steps 2 and 3.

To assign passwords or to name groups of users, continue with 
the next two sections. If you want to start sharing immediately, 
go to “Selecting a User or Group to Share a Folder or Disk” later 
in this chapter.
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Setting a registered user’s password

You can assign passwords for registered users to verify their
identities when they want to gain access to your computer.

1. Open a user icon in the Users & Groups control panel.

2. Type a password in the User Password box, then 
press Tab.

The password can be up to eight characters long. When you
press Tab, the password is replaced by bullets for privacy.
Make sure to inform the user of the exact password, including
capitalization.

3. Close the window, and then click Save in the dialog box.

Naming a group of users

You can name several registered users as a registered group.

1. Open the Users & Groups control panel and choose
New Group from the File menu.

An icon labeled New Group appears. The name is selected 
for editing.

186 Chapter 14: Using Your Macintosh on a Network

The user’s name

Type a password
for this user here.

Drag user icons 
to the group icon.

Group icon



2. Type a name for the group.

3. Drag user icons to the new group icon.

The icons are not moved inside the group icon, as they would
be if it were a folder. Dragging the icons creates a member
icon inside the group icon. You don’t need to drag your own
icon to the group icon because you have access to the entire
contents of your computer (unless you specify otherwise). 
You don’t need to include the <Guest> icon in any group.

To allow this group to gain access to a shared folder or disk,
go to the section “Selecting a User or Group to Share a Folder
or Disk.”

Seeing who’s in a group

■ To see the names of all group members, open the 
group icon.

You can open any member icon to see or change the settings
you’ve made for that user.

■ To see all the groups that a user belongs to, open the
user’s member icon or user icon.
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Selecting a user or group to share a folder or disk

You can give one registered user or group exclusive access to 
a shared folder or disk on your computer.

1. Select a folder or disk to share.

2. Choose Sharing from the File menu.

3. Click the box labeled “Share this item and its contents”
so an X appears.

4. Choose a user or group from the User/Group 
pop-up menu.

5. To share the item with only the user or group you’ve
chosen, click the bottom row of checkboxes (to the
right of Everyone) to remove the X from each box.

6. Close the window and click Save.
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Preventing users or guests 
from accessing your computer

1. Choose Control Panels from the Apple menu and open
the Users & Groups icon.

2. To deny access to a specific user, open the user icon. 

To deny access to guests, open the <Guest> icon.

3. Click the appropriate checkbox to deny access.

4. Close the window and click Save.

If you deny access to a user who is currently connected, he 
or she is disconnected immediately. That user is no longer a
member of any groups, and can connect only as a guest.

If you deny access to guests, any guests currently connected
are disconnected immediately.
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Removing a user from a group

1. In the Users & Groups control panel, open the 
group icon.

2. Drag the member icon to the Trash.

3. Choose Empty Trash from the Special menu.

Removing a user or group 
from your list of registered users

You can remove a registered user or group at any time. When 
you remove a user, he or she will no longer be a member of 
any registered groups.

1. Open the Users & Groups control panel.

2. Drag the user or group icon to the Trash.

3. Choose Empty Trash from the Special menu.

If the user is currently connected, he or she is disconnected
immediately.

You cannot throw away the <Guest> icon or the owner icon.

Giving away ownership of a 
folder or disk on your computer

You can give away ownership of a shared folder or disk on your
Macintosh to a registered user or group.

Because you are the owner of your Macintosh, the new owner of 
a folder or disk on your computer cannot restrict your access to 
it. However, the new owner can change the access privileges 
that other people have to the folder or disk. If you give away
ownership of a folder or disk, make sure to remove any folders 
or documents that you don’t want others to see or change.
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1. Select a shared folder or disk.

2. Choose Sharing from the File menu.

3. Choose a name in the Owner pop-up menu.

If you select <Any User>, then anyone on the network can
change the access privileges or ownership of the item.

4. Close the window and click Save in the dialog box.

5. Click OK again to confirm that you want to change
ownership.

Turning file sharing off

You can turn file sharing off at any time. When file sharing is off,
people on the network cannot access folders or disks on your
computer, and you cannot access your computer from another
computer on the network.

When you turn file sharing back on, the items you shared before
are available again automatically.

1. Choose Control Panels from the Apple menu and open
the Sharing Setup icon.
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2. In the section labeled File Sharing, click the Stop
button.

A dialog box appears in which you can specify a delay before
file sharing is turned off. If you specify a delay, users who are
connected to your computer are warned to save their work
and disconnect.

3. Type the number of minutes you want to elapse before
file sharing is turned off.

To turn file sharing off immediately, type the number 0.

4. Click OK.

If someone is using files on your Macintosh when file sharing is
turned off, any changes he or she has not saved will be lost.

Monitoring file-sharing activity

When file sharing is on, you can see who is connected to your
computer and what folders or disks you’ve shared.

■ Choose Control Panels from the Apple menu and open
the File Sharing Monitor icon.
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Disconnecting someone who 
is connected to your computer

You can disconnect users who are currently connected to your
Macintosh in the File Sharing Monitor control panel.

1. Select the user or users you want to disconnect.

2. Click Disconnect.

3. Type the number of minutes that you want to elapse
before users are disconnected.

If you specify a delay, users are warned to save their work 
and disconnect. It’s a good idea to give people enough time 
to save changes they have made. To disconnect a user
immediately, type 0.

4. Click OK.

A message remains on the screen until the time is up. Click
Cancel to stop the process.

5. When the designated amount of time has elapsed, 
close the File Sharing Monitor.

Chapter 14: Using Your Macintosh on a Network   193

R
E

F
E

R
E

N
C

E



Gaining access to your computer 
from another computer

You can connect to your own Macintosh from another computer
on the network and access everything on the disks attached to
your computer.

1. Make sure that file sharing is turned on.

2. Choose Control Panels from the Apple menu and open
the Users & Groups icon.

3. Open the owner icon (the one with the bold outline).

4. Click the boxes labeled “Allow user to connect” and
“Allow user to see entire disk” to place an X in them.

When these boxes are checked, you can see and use
everything on your disks while you’re using another computer.

To restrict your access, click a checkbox to remove the X.
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5. Close the window and the Users & Groups 
control panel.

6. Leave your computer turned on.

To gain access to your computer, connect to it as a registered 
user. Type your owner name and password as they appear in the
Sharing Setup control panel of your computer. Then connect as
you normally would.

❖ If you are unable to connect to your computer: Make sure
that your computer is turned on, that file sharing is turned on,
and that you have the correct access privileges. Make sure that
you type your password exactly as it is entered in the Sharing
Setup control panel, including capitalization. ❖

Changing your password

You can change the password you use to gain access to your own
computer from another computer.

1. Choose Control Panels from the Apple menu and open
the Sharing Setup icon.

2. Type a new password in the box labeled Owner
Password and press Tab.

Remember the capitalization. Your password is replaced by
bullets to keep it private.

3. Close the Sharing Setup control panel.

Your new password is now in effect.
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Using access privileges
Access privileges let you control what other people can do with
the information you share on a network. For example, you might
want to let people see a file but prevent them from changing it.

Understanding access privileges

You can set access privileges for any shared folders on your own
computer and any folders you create on another Macintosh.
Owners of other computers can set access privileges that restrict
what you can do with their shared disks.

Three categories of people can have access privileges to shared
disks and folders:

■ The owner.  The owner of a folder can change the access
privileges to that folder. You become the owner of a folder
automatically when you create it. You can keep ownership or
give it away.

■ A registered user or group. A registered user has special
access to shared disks over the network. A registered group is
a group of registered users.

■ Everyone.  This category includes the owner, registered users,
and guests.

There are three types of access to shared items:

■ See Folders allows people to see, open, and copy the folders
within a folder or disk.

■ See Files allows people to see, open, and copy the files within
a folder or disk.

■ Make Changes allows people to make changes to a folder or
disk—copy, delete, or change any of its contents.

The table indicates which privileges you need in order to take
certain actions with items in a shared folder or disk.

Action See Folders See Files Make Changes

Copy or move files to a folder

Copy a file from a folder 

Copy a folder from a folder

Create a folder in a folder 

Delete a file from a folder 

Delete a folder from a folder

Open and use a file in a folder 

Save changes to a file in a folder 

196 Chapter 14: Using Your Macintosh on a Network



Setting access privileges to folders and disks

You can set access privileges for shared folders or disks on your
own computer and for folders that you own on other computers.

1. Select the folder or disk.

2. Choose Sharing from the File menu.

The dialog box you see may be slightly different from the 
one pictured.

■ If you’ve selected a folder inside a shared folder, the
checkbox at the top is labeled “Same as enclosing folder.”

■ If you’ve selected a folder on another computer, the
Owner and User/Group areas are text boxes, not 
pop-up menus.

■ If you’ve selected a folder you do not own, all the
checkboxes and their labels are dimmed.

3. Choose a registered user or group to share the 
item with.

Choose from the list of users and groups in the pop-up menu,
or type the name of a registered user or group in the box.

4. To set access privileges, click the appropriate checkbox.

■ To set the same privileges for the folders within this folder
or disk, place an X in the box labeled “Make all currently
enclosed folders like this one.” If you’re working with an
item that contains a large number of folders, such as a 
CD-ROM disc, this action may take a few minutes 
to complete.

■ To prevent the folder from being changed, place an X in
the box labeled “Can’t be moved, renamed, or deleted.” If
you check this box, no one—not even you—can change
the folder.

■ If you want the folder to have the privileges set for the
folder or disk enclosing it, place an X in the checkbox
labeled “Same as enclosing folder.” This box only appears
for folders inside shared folders. When you move such a
folder to another folder, its access privileges change to
reflect those of the enclosing folder.

5. When you’re finished setting access privileges, close 
the Sharing dialog box and then click Save.

The access privileges take effect immediately.
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Access privilege strategies

Access privileges can be combined in several ways. A few
common and useful strategies are summarized here.

■ Allow everyone on the network all access privileges. 
As long as guest access is allowed, everyone on the network
can open, read, and change the files and folders.

■ Keep a folder or disk private. To keep a folder or disk on
your own computer private, do not share it. To keep your
folder on another computer private, use these settings. You
have full access but no one else can see, open, or use its
contents.

■ Allow access to one other person or group. This set of
privileges allows the owner of the item and one registered
user or group to use the item.

■ Keep a folder private but allow others to place files or
folders into it. People on the network can deposit files or
folders into this folder but cannot see, remove, or change its
contents. (This configuration is sometimes called a drop box.)

■ Set up a folder as a bulletin board. People can open and
read the files in this folder but cannot change them.
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Working with privileges that others have set

When you are using the By Icon or By Small Icon view, the
appearance of shared folders indicates the access you have.

Icon Meaning

A darkened tab indicates that you own the folder 
and can set its access privileges.

A plain tab indicates that you can open and use the folder.

A strap indicates that you cannot open and use the folder.

A strap with an arrow indicates that you can put files 
or folders into the folder, but you cannot open it or 
use any files or folders within it.

Checking your access privileges

When you open a folder on another computer, icons under the
title bar indicate the privileges that you do not have.

You can’t You can’t You can’t 
make changes. see files. see folders.
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Linking programs
Some Macintosh programs can exchange information directly 
with other programs. For example, one program might be able to
instruct another program to add a row to a spreadsheet or change
the font size of a paragraph.

Programs implement linking in various ways and not all programs
have this capability. See the documentation that came with your
programs for more information.

Linking to a program on another computer

You can only link to programs that are shared.

1. Within your program, choose the menu command that
allows you to link programs.

The menu location and command name depend on the
program you’re using. You use a dialog box to find the
program that you want to link to.

2. If your network has zones, select a zone in the lower-
left section of the dialog box.

3. Select the Macintosh you want to connect to in the
upper-left section of the dialog box.

4. Select the program you want to link to.
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5. Click OK.

In most cases, you need to identify yourself as a guest or 
a registered user.

6. Click Guest or Registered User.

If you are a guest, click Guest and go to step 9. If the Guest
option is dimmed, guests do not have access to this computer.

7. If you are a registered user, make sure that the name 
is correct.

8. Type your password.

9. Click OK.

The two programs are now linked.

Disconnecting a program link

To disconnect a link to a program on another computer, quit the
program you used to create the link.

Allowing other people to link to your programs

You can allow people on the network to link to programs on your
computer.

■ First you turn on program linking.

■ Then you make a program available for linking by sharing it.

■ Finally, you either allow guest access or allow specific people
to link.

These steps are outlined in the following sections.
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Turning program linking on

When you turn program linking on, your computer is visible to
others on the network whenever they attempt to link a program.
Before you turn program linking on, make sure that AppleTalk 
is active and that you have named your Macintosh.

1. Choose Control Panels from the Apple menu and open
the Sharing Setup icon.

2. In the section labeled Program Linking, click the 
Start button.

3. Close the Sharing Setup control panel.

Once program linking is turned on, you must select programs
to share before network users can link to them, as described in
the next section.

Selecting a program for linking

Before a network user can link to your program, you need to
share it.

1. Select a program to share.

If the program is open, you must quit before you can share it.

2. Choose Sharing from the File menu.

3. Click the box labeled “Allow remote program linking”
to place an X in it.

If the box is dimmed, the program does not support linking,
and you cannot share it.

4. Close the window.

Guest users can now link to your program as long as your
computer is turned on and the program is open.
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Allowing guests to link to your programs

You can let everyone on the network link to your shared
programs.

1. Choose Control Panels from the Apple menu and open
the Users & Groups icon.

2. Double-click the <Guest> icon.

3. Click the box labeled “Allow guests to link to programs
on this Macintosh” to place an X in it.

4. Close the window.

Guest users can now link to any of the programs you’re
sharing, as long as the programs are open.

Naming specific users to link to your programs

You can identify the registered users and groups you want to link
to your programs.

1. Choose Control Panels from the Apple menu and open
the Users & Groups icon.

2. Open the icon of a user.

3. Click the box labeled “Allow user to link to programs 
on this Macintosh” to place an X in it.

4. Close the window and click Save in the dialog box.

5. To give more registered users access to your programs,
repeat steps 2 through 4.
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Using communications products 
with System 7

Using the Communications Toolbox

If you are already familiar with the Communications Toolbox, 
note the following guidelines for its use with Macintosh System 7.
See the manual that came with your communications program for
more detailed information.

■ The Communications Toolbox has been integrated into 
System 7.

■ To use communications tools with System 7, drag them to the
Extensions folder in your System Folder (or to the System
Folder icon).

■ Wherever a program or its documentation refers to the
“Communications Folder,” substitute the “Extensions Folder.”

Using Data Access Language

If you are already familiar with Data Access Language (DAL), note
the following instructions for its use with System 7. For detailed
information about using your DAL application, see the manual
that came with the program.

To use programs that search for the “hosts.CL1” file, do the
following:

1. Make a copy of the DAL Preferences file (in the
Preferences folder in the System Folder).

2. Rename the duplicate file: Hosts.CL1.

3. Move the renamed file outside the Preferences folder,
but leave it inside the System Folder.

Use your program as you normally do. Whenever you make
changes to one of these files, you must update the duplicate file.
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Enhancing Your 
Macintosh System
In this chapter

■ Adding memory to your computer

■ Connecting an external floppy disk drive

■ Connecting SCSI devices

■ Using your computer as a SCSI disk

■ Connecting a modem

■ Connecting a printer

■ Connecting a mouse or other ADB device

■ Connecting a microphone

■ Connecting headphones or speakers

Adding memory to your computer
All Macintosh PowerBook computers come with at least 2 MB of
RAM; some models come with 4 MB. You can find out how much
memory your computer has by choosing About This Macintosh
from the Finder’s Apple menu.

Apple provides 2 and 4 MB memory upgrades through its
authorized dealers. Memory upgrades in these and other amounts
may also be available from other vendors; ask your dealer for
more information.

All memory upgrades must be installed by an authorized 
Apple dealer.

The PowerBook 140 and 170 support virtual memory, a feature
that makes use of hard disk space to provide additional RAM. 
For more information see “Using Hard Disk Space as Memory” 
in Chapter 12.
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Connecting an external floppy disk drive
The Macintosh HDI-20 External 1.4 MB Floppy Disk Drive is an
option available for the PowerBook 100, which does not have an
internal floppy disk drive. (You cannot use an external floppy 
disk drive with the PowerBook 140 or 170.)

Use only the HDI-20 external floppy disk drive with your
computer. Other disk drives draw more power than is
recommended, and their connectors are of a different type.

See Chapter 10 for information about using floppy drives 
and disks.

Attaching the external floppy disk drive

1. Save your work and choose Shut Down from the 
Special menu.

▲ Warning: Connecting the disk drive while your computer is
turned on can damage the disk drive. Turn the computer off
before connecting the disk drive.  ▲

2. Attach the disk drive’s cable to the floppy disk port on
your computer.

Floppy disk drive port

Floppy disk drive port icon
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3. Flip down the disk drive cover and use it to prop up 
the drive.

4. Turn the computer back on.

The floppy disk drive is ready to use.

Starting up from a floppy disk

To start up your computer from a floppy startup disk—one that
has a System Folder on it—you need to insert the floppy disk into
the disk drive before you turn on the computer. Otherwise the
computer starts up from the hard disk as usual (if it contains a
working System Folder).

Disconnecting the external floppy disk drive

1. Save your work.

2. Choose Shut Down from the Special menu.

▲s▲s Important: Disconnecting the disk drive while your
computer is on can damage the drive. Turn the computer 
off before disconnecting the disk drive.  ▲s▲s

3. Disconnect the disk drive’s connector from the floppy
disk port.

Caring for the disk drive

■ Eject any disk from the disk drive before closing the cover.

■ Shut down your Macintosh before connecting or
disconnecting the disk drive.

■ Do not lift or carry the disk drive by its cable.

■ Avoid storing the disk drive where it will be exposed to
extreme heat or cold.

Disk drive cover
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Connecting SCSI devices
SCSI devices include hard disks, CD-ROM drives, and scanners
that connect to your computer using a standard electronic
interface. (SCSI stands for Small Computer System Interface.)

Your computer has a SCSI port to which any SCSI device can be
connected. The SCSI port and its icon look like this:

The SCSI port itself looks different from the SCSI ports you may
have seen on other computers. To connect a SCSI device to it, you
need an Apple HDI-30 SCSI System Cable, as described later in
this chapter.

Setting up a SCSI device involves the steps listed here and
described in the next sections:

■ installing software

■ setting SCSI ID numbers

■ checking that the SCSI chain is properly terminated

■ connecting cables

Installing software

Most SCSI devices come with software that allows your computer
to communicate with them. These programs are called drivers.
(If no drivers come with the device, then it doesn’t need any.) To
install a driver, follow the instructions that came with the device. 

Setting SCSI ID numbers

You can attach up to six SCSI devices to your computer by linking
them together in a chain. Each device in a SCSI chain must have 
its own ID number between 1 and 6 so the computer can identify
it properly.

▲ Warning: Using two or more devices with the 
same SCSI ID number can cause your equipment to 
malfunction. You could lose information as a result.  ▲

Your computer has the SCSI ID number 7, and its internal hard
disk has the number 0.

Some SCSI devices come with a preset ID number; see the
documentation that came with the device for information about 
ID numbers and how to change them. (In most cases, a new 
ID number goes into effect when the device is turned back on.)

SCSI port icon

SCSI port
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The ID numbers of Apple SCSI devices can be set as follows.

1. Make sure the SCSI device is turned off.

If the device is already part of a SCSI chain, make sure 
that all devices in the chain are turned off, including the 
Macintosh itself.

2. Locate the ID number indicator and switch (usually 
on the back panel of the SCSI device).

3. Check the ID numbers of all connected devices.

If the devices you’re connecting already have unique 
ID numbers, you’re finished with this part of the procedure.
Continue with the next section, “Checking That the SCSI 
Chain Is Properly Terminated.”

4. Choose a number between 1 and 6 to assign to the
Apple SCSI device.

Each device in a SCSI chain needs a unique ID number. Give
higher ID numbers to the devices you use more often.

5. Insert the end of a straightened paper clip into the
small hole below the ID number indicator.

The small hole gives you access to the ID number switch.

6. Push the ID number switch repeatedly until the number
you want appears in the ID number indicator.

ID number switch

ID number indicator

5
5
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Checking that the SCSI chain is properly terminated

To ensure accurate transmission of information, a chain of SCSI
devices must have a terminator at each end. Terminators are built
into some SCSI devices and can also be added at appropriate
locations in the chain.

■ Your PowerBook’s internal hard disk, which is always the first
device in the chain, has a small built-in terminator. However,
for reliable information transfer in a chain of SCSI devices, 
it should be supplemented with an external terminator as
described in these instructions.

■ External SCSI devices from Apple do not have built-in
terminators.

■ External SCSI devices from other vendors may have built-in
terminators; consult the documentation that came with 
the device.

Rules for correct chain termination

When connecting one SCSI device to a PowerBook computer,
make sure that there is

■ an external terminator between the HDI-30 system cable 
and the SCSI device and

■ an internal terminator in the SCSI device, or an external
terminator attached to the second SCSI connector on 
that device.

When connecting a chain of SCSI devices to a PowerBook
computer, make sure that there is

■ an internal terminator in the first external device, or an
external terminator between the HDI-30 system cable and 
the first device;

■ an internal terminator in, or an external terminator attached to
the last device; and

■ no other terminator in the chain.

In general, and particularly if you are using extension cables in
your SCSI chain, you should put the terminators as close to the
ends of the chain as possible.

Correct chain configurations are shown in the illustrations on the
following page.

SCSI terminator
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Connecting cables

▲ Warning: When making SCSI connections, always turn 
off power to all devices in the chain. Failure to do so 
can cause the loss of information and damage to your 
computer equipment. ▲

1. Shut down your Macintosh and all SCSI devices in 
the chain.

2. To connect the first (or only) device, use an Apple 
HDI-30 SCSI System Cable.

Attach the smaller end of the cable to your computer, and 
the larger end of the cable to either SCSI port on the device.

3. To connect the next device, use a SCSI peripheral
interface cable.

Both cable connectors are the same; attach one to the
available SCSI port on the first device, and the other to either
SCSI port on the next device.

4. Repeat step 3 for each additional device you want 
to connect.

The illustrations show where to add cable terminators.

▲s▲s Important: The total length of a SCSI chain should not
exceed 6 meters (20 feet). Apple SCSI cables are designed to
meet this restriction. If you are using SCSI cables from another
vendor, check the length of the chain.  ▲s▲s

Once your SCSI devices are connected, always turn them on
before turning on your computer. If you turn the computer on 
first, it may not be able to start up, or it may not recognize the 
SCSI devices.

If this SCSI device has an internal
terminator, omit this external terminator.

Terminator

HDI-30 cable

If this SCSI device has an internal
terminator, omit this external terminator.

HDI-30 cable SCSI peripheral interface cables

Connecting one SCSI device

Connecting more than one SCSI device
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Using your computer as a SCSI disk
You can connect a PowerBook 100 to any desktop Macintosh and
have it function as though it were an external SCSI disk drive. The
PowerBook 100 appears on the screen of the desktop Macintosh
as a hard disk icon, and you can transfer information between 
the two computers by dragging files. This feature of the
PowerBook 100 is called SCSI disk mode.

SCSI disk mode is especially useful if you don’t have an external
floppy disk drive for your computer, or if you’re traveling without
an external disk drive and need to transfer information. You can
also use this mode to reinstall system software on your computer,
as described later in this chapter.

To use your PowerBook 100 as a SCSI disk, you need to purchase
a special cable called the Apple HDI-30 SCSI Disk Adapter from
your authorized Apple dealer.

▲ Warning: Follow the steps for connecting and disconnecting
SCSI devices carefully to avoid loss of information and damage
to your equipment. The PowerBook 140 and 170 do not
support SCSI disk mode, and should never be connected to 
a desktop Macintosh. ▲

Connecting your computer as a SCSI disk

Before making any connections, you need to assign a SCSI ID
number to the PowerBook 100.

1. Choose Control Panels from the Apple menu of your
PowerBook computer.

2. Open the Portable control panel.

3. In the SCSI Disk Mode ID section of the control panel,
click the ID number you want to assign.

If you are connecting the PowerBook 100 to an existing SCSI
chain, make sure to give it an ID number different from those
of the other devices.

4. Turn off the PowerBook 100 by choosing Shut Down
from the Special menu.

5. Turn off the desktop Macintosh by choosing Shut Down
from the Special menu (and then pressing the on/off
switch, if the computer is a compact model such as the
Macintosh SE/30).

6. Turn off all other devices in the SCSI chain, if any.
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7. Connect the PowerBook computer to either (a) the
desktop Macintosh or (b) the end of the SCSI chain.

The illustrations show which cables to use and where to add
cable terminators. Remove the terminator from the last device
in an existing chain before connecting the PowerBook 100.

▲ Warning: Always shut down the PowerBook 100 before
connecting or disconnecting the SCSI disk adapter cable.
Connecting the adapter cable while the computer is turned 
on can damage the computer.  ▲

continues >

Terminator

SCSI system cable HDI-30 SCSI disk adapter 

2 Terminators

SCSI system cable HDI-30 SCSI 
disk adapter

■ Models without internal hard disk:     Classic LC    IIfx
■ Models with internal hard disk:

Classic    LC    SE    SE/30    II    IIx     IIcx    IIci   IIsi   IIfx

■ Models without internal 
hard disk:     SE    SE/30   II
IIx   IIcx   IIci

Connecting to the end of a SCSI chain

Terminator

SCSI system cable HDI-30 SCSI disk adapter

SCSI peripheral
interface cables

Terminator

SCSI system cable HDI-30 SCSI disk adapter

SCSI peripheral
interface cables

Terminator

■ Models without internal hard 
disk:     Plus    Portable

■ Models with internal hard disk:
Portable

Connecting to a desktop Macintosh

* Do not use any terminators, non-Apple cables, or extension cables in this configuration,
or it will not work.

(a)

(b)

SCSI system cable HDI-30 SCSI 
disk adapter

No Terminator*

■ Models without internal hard disk:     Classic    LC    IIfx
■ Models with internal hard disk:

Classic    LC    SE    SE/30    II    IIx     IIcx    IIci   IIsi   IIfx

■ Models without internal hard disk:     
SE    SE/30    II    IIx    IIcx    IIci    Plus    Portable

■ Models with internal hard disk:     Portable
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8. Turn on the PowerBook 100 by pressing any key on 
the keyboard.

After a few seconds a SCSI icon appears on the screen,
showing the SCSI ID number you assigned in step 3.

▲ Warning: If you do not see the SCSI icon, and the computer
either starts normally or displays an error message, choose
Shut Down (if you can) and then immediately disconnect your
computer from the SCSI chain. If you can’t choose Shut Down,
you should disconnect the cable anyway, or you may lose
information. Then go back and repeat steps 4 through 8,
making sure that you have shut down all your equipment
properly, that you are using the correct cables, and that you
have put terminators in the correct places.  ▲

9. Turn on the other SCSI devices in the chain, if any.

10. Turn on the desktop Macintosh.

The PowerBook 100 appears as a hard disk icon on the
desktop Macintosh. You can now transfer files as if the
PowerBook 100 were an external disk drive.

Simplifying the SCSI disk connection process

If you regularly plan to use your PowerBook 100 as a SCSI disk
with the same desktop Macintosh, you can leave the cables,
terminators, and the SCSI disk adapter cable attached to the
desktop Macintosh. When you want to use your PowerBook 100
as a SCSI disk, simply shut down all devices and connect the
PowerBook to the adapter cable. The desktop Macintosh and its
SCSI chain (if there is one) will work correctly with or without 
the PowerBook 100 attached.

▲ Warning: Always disconnect your PowerBook 100 from the
adapter cable when you are not using it as a SCSI disk. Your
PowerBook 100 will not work correctly if the adapter cable
remains attached. ▲

Connect and disconnect your computer here.

These cables stay attached to your
desktop Macintosh or its SCSI chain.

HDI-30 SCSI disk adapter
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Using SCSI disk mode to reinstall system software

If you’re using SCSI disk mode to reinstall system software on your
PowerBook’s hard disk (because its System Folder was damaged,
for example), you may not have had an opportunity to select a
SCSI ID number for the computer. If you don’t know what the
current ID number is, follow these steps:

1. Press the interrupt and reset buttons together to make
sure that all power to your computer is off.

2. Connect the SCSI disk adapter cable to the SCSI port 
on your computer.

Don’t make any other connections yet.

3. Press any key (except Caps Lock) to restart the
computer.

4. Note the SCSI ID number that appears on the screen.

You can’t change this number now, but if you will be attaching
your computer to an existing SCSI chain you can change the
numbers of other devices if there is an ID conflict.

5. Press the reset or the interrupt button to turn the
computer off again.

6. Shut down the desktop Macintosh and the other SCSI
devices in the chain, if any.

7. Change conflicting SCSI ID numbers if necessary.

8. Connect the other end of the adapter cable to the
desktop Macintosh, or to the end of the SCSI chain.

The illustrations in the section “Connecting Your Computer 
as a SCSI Disk,” earlier in this chapter, show the proper cables
and terminator placement.

9. Press any key to restart the PowerBook 100.

10. Turn on the other SCSI devices in the chain, if any.

11. Turn on the desktop Macintosh.

You can now reinstall system software on the hard disk in your
PowerBook 100 as described in Chapter 8. Use the system
software disks that came with your PowerBook computer (the
ones that came with your desktop Macintosh may not be the
correct version).
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Drawing battery power in SCSI disk mode

Your computer continues to draw battery power while you are
using it as a SCSI disk. Low battery power is indicated by the
appearance of a blinking low-power warning on the PowerBook’s
screen.

If you see this warning while using your computer as a SCSI 
disk, either plug in the power adapter or quit SCSI disk mode, 
as described in the next section, so you can remove the battery 
for recharging. If you wait until the computer goes to sleep
automatically, you may lose information.

▲s▲s Important: Do not attempt to change batteries while 
your computer is in SCSI disk mode. ▲s▲s

Quitting SCSI disk mode

1. Shut down the desktop Macintosh.

2. Turn off the PowerBook 100 by pressing the reset 
or interrupt button.

3. Turn off all other SCSI devices in the chain, if any.

4. Disconnect the PowerBook 100 from the desktop
Macintosh or the end of the SCSI chain.

If you regularly plan to connect your PowerBook 100 to 
the same desktop Macintosh, see “Simplifying the SCSI Disk
Connection Process,” earlier in this chapter.

5. Disconnect the adapter cable from the PowerBook 100.

If you leave the adapter cable attached, the computer will
behave as though it is still in SCSI disk mode when you try 
to restart.

Your equipment is now ready for normal use. Make sure that 
the SCSI devices connected to the desktop Macintosh are 
properly terminated.
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Connecting a modem
Apple offers the Macintosh PowerBook Fax/Data Modem—
an internal, low-power, 2400-baud data/9600-baud fax send
modem—for all Macintosh PowerBook computers. See the
modem manual for more information.

You can connect an external modem to the modem or printer 
port on the PowerBook 140 or 170, or to the printer port on the
PowerBook 100. Follow these steps:

1. Choose Sleep from the Special menu.

2. Make sure the modem is turned off.

3. Connect the modem cable to the modem port. 

(If you have a PowerBook 100, connect the modem cable to
the printer port, and make sure that AppleTalk is inactive in
the Chooser.)

4. Turn on the modem.

5. Press any key to wake the computer.

If you do not have an internal modem, your external modem
is ready to use.

If you have a PowerBook 140 or 170, and you have an internal
modem in addition to the external modem you just connected,
continue with the steps below.

6. Choose Control Panels from the Apple menu and open
the Portable icon.

7. In the Portable control panel, click the External 
Modem button.

These modem controls appear only if you have an internal
modem installed. Before you use the internal modem again,
click the Internal Modem button.

8. Close the control panel.

Internal modems available from other manufacturers may use
more power than the modem provided by Apple. The only
drawback to using such modems is that your battery drains faster
when you use them. You may decide that the benefits (such as
faster transfer rate) outweigh the drawback of additional power
consumption. See the modem manual for more information 
about its features.

Modem port icon

Modem port
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Connecting a printer
The printer port on your computer accepts either a direct cable
connection (to a printer such as the StyleWriter) or a network 
cable connection (to a printer such as the LaserWriter IINTX). Some
printers, including the Personal LaserWriter SC, are connected
through the SCSI port as a SCSI device.

Follow the instructions that came with your printer to connect it 
to your Macintosh.

▲ Warning: The StyleWriter printer comes with a power
adapter that looks similar to the adapter provided with your
PowerBook computer. However, these adapters are not
interchangeable. Connecting the computer’s power adapter 
to the printer will not damage your equipment, but the printer
will not work properly. Connecting the printer’s power
adapter to your computer will damage the adapter. 
Use each power adapter only with the equipment for which 
it was intended. (You may want to label the adapters.)  ▲

Connecting a mouse 
or other ADB device
Your computer has one Apple Desktop Bus™ (ADB) port, which
you can use to connect optional low-power input devices (such 
as a mouse) provided by Apple and other vendors.

Make sure that any ADB devices you connect are designed for
portable computers. Such devices are marked with the low-power
icon shown. Do not connect standard ADB devices (such as
keyboards for desktop Macintosh computers) to your PowerBook
computer, even if the power adapter is plugged in.

Low-power icon

ADB port icon

ADB port

Printer port icon

Printer port
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Connecting a microphone
The PowerBook 140 and 170 come with a microphone that can be
used to record sounds. These models have a sound input port to
which you can connect the supplied microphone. (See Chapter 12
for information about recording sounds.)

1. Open the door covering the back panel of your
computer.

2. Plug the microphone into the sound input port on the
back panel.

3. Decide where you want to place the microphone.

The microphone can pick up sounds within a range of several
feet. You can place it anywhere near your computer, or use the
clip provided to attach it to your shirt. The microphone has 
no on/off switch; it is controlled by the program you use to
record sounds.

▲ Warning: Do not plug a sound output device (such as a 
pair of headphones) into the sound input port. Doing so 
may damage your audio equipment. ▲

Microphone

Sound input port
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Connecting headphones or speakers
Your computer has a sound output port to which you can 
connect speakers, an amplifier, headphones, or other audio
output devices. The sound output port accepts a standard 
stereo miniplug, like that used to attach headphones to a 
portable audio cassette player.

The PowerBook 100 has monaural, not stereo, output—but you
should still use a stereo miniplug (a monaural one will not work).

Sound output icon

Sound output port
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Care and Maintenance
In this chapter

■ Important safety instructions

■ Cleaning the computer

■ Caring for batteries

■ Traveling with your computer

■ Storing your computer

■ General troubleshooting suggestions

■ Service and support

Important safety instructions
These instructions apply to your computer and to any optional
equipment you may have purchased along with it (such as an
external disk drive or a battery recharger).

■ Read all the safety instructions in this chapter.

■ Keep these instructions available for reference by you 
and others.

■ Follow all instructions and warnings that apply to your system.

■ Do not attempt to open the computer’s case. There are 
no user-serviceable parts inside. Take the computer to an
authorized Apple service provider if necessary.

■ Do not drop or jar the computer.

■ Turn off your Macintosh before connecting or disconnecting
any cables.

continues >
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■ When recharging the battery, use only the power adapter
supplied with your computer. Adapters designed for other
electronic devices may look similar, but they may not work
with your equipment and may damage the computer or 
the recharger.

■ Do not use the computer in or near water.

■ Keep dirt and liquids away from the ports on the back panel,
the keyboard, and the trackball. If you spill any food or liquid
onto the computer, shut it down immediately and unplug it
before cleaning up the spill. Depending on what you spilled
and how much got into the computer, you may have to bring
the computer to an authorized Apple service provider for
cleaning.

■ Do not use the computer in wet or dusty environments.

■ If the computer has been in a cold place for several hours, 
let it warm up to room temperature before you use it.

■ Use the computer only in environments where the
temperature range is between 10°C/50°F and 40°C/104°F.

■ Do not expose the computer to very low (less than 
–25°C/–13°F) or very high (more than 60°C/140°F)
temperatures.

■ Do not use cables that are frayed or otherwise damaged. 
Hold a cable by its connector (the plug, not the cord) 
when connecting or disconnecting it.

■ Never force a connector into a port. If the connector and port
do not join easily, they do not match. Make sure that the
connector matches the port and that it’s right side up before
you attach it.

■ Do not touch the screen with any sharp or pointed objects.

■ Do not move the computer when you can hear its hard disk
spinning. When you put the computer to sleep, wait until the
screen is blank before moving the computer.

▲ Warning: Electrical equipment may be hazardous if 
misused. Do not allow children to use this product 
without supervision. ▲

Cleaning the computer
■ If necessary, clean the outside of the computer’s case with a

damp (not wet) cloth or paper towel.

■ Clean the screen with soft, lint-free paper or cloth and a mild
glass cleaner. Do not spray the glass cleaner (or any other
liquid) directly onto the screen.
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Caring for batteries
■ Always handle batteries carefully.

■ Do not short-circuit the battery terminals (that is, do not touch
both terminals with a metal object). Doing so may cause an
explosion or a fire.

■ Do not drop, puncture, disassemble, mutilate, or incinerate
the battery.

■ Recharge batteries only as described in this manual and only
in ventilated areas.

■ Do not leave batteries in hot locations (such as the trunk of 
a car) for more than a day or two.

■ Do not leave an uncharged battery in your computer for
longer than a week without plugging in the power adapter.

■ Do not leave a battery in storage for longer than 6 months
without recharging it.

■ Take dead batteries to your authorized Apple service provider
for recycling or proper disposal. The batteries contain
hazardous chemicals and should not be thrown out with
household or office trash.

Traveling with your computer
The safety instructions in this chapter also apply when you are
traveling with your computer. In addition, note these precautions:

■ Always turn off your computer before transporting it by using
the Shut Down command in the Special menu.

■ Bring backup copies of your system software and other
important files on floppy disks, in case you need to 
reinstall them.

■ Do not check your computer as baggage. Carry it with you.

■ Do not allow your computer or any hard disks or floppy disks
to pass through X-ray machines. Have security officials
manually inspect your computer and disks.

■ Be prepared to show security officials that your computer 
is working. Have a charged battery or power adapter ready 
to use.

■ Some airlines may restrict or prohibit the use of computers in
flight. Check ahead to find out what restrictions, if any, apply.

continues >
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■ Take the necessary plug adapters if you’re traveling overseas.
(You may need to use them with the power adapter.) You do
not need a voltage transformer. The power adapter can handle
90 volts to 260 volts AC (48 to 62 Hz).

Check the diagrams below to determine which plug adapters
you’ll need, or ask your travel agent.

Outlet Type Locations

United States, Canada, parts of Latin America, 
Japan, Korea, the Philippines, Taiwan

Soviet Union, most of Europe, parts of Latin
America, the Middle East, parts of Africa, 
Hong Kong, India, most of South Asia

Mexico, United Kingdom, Ireland, Malaysia,
Singapore, parts of Africa

China, Australia, New Zealand

Storing your computer
■ For up to a week: You can store the computer without its

power adapter plugged in for up to a week, provided that the
battery is fully charged.

■ For up to two weeks: You can store the computer with its
power adapter plugged in for up to two weeks.

■ For more than two weeks: See the long-term storage
instructions that apply to your model.

Short-term storage

1. Save your work onto a hard disk or floppy disks.

2. Choose Shut Down from the Special menu.

Shutting down the computer removes the RAM disk (if any) 
on a PowerBook 140 or 170.

3. Close the display.

4. If your battery is not fully charged, plug in the power
adapter.

5. Store the computer in a cool, dry place.

Storage temperatures should remain between 10°C/50°F and
40°C/104°F. Avoid leaving the computer where temperatures
may be extreme or unpredictable—in the trunk of a car, 
for example.
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Long-term storage for the PowerBook 140/170

1. Save your work onto a hard disk or floppy disks.

2. Choose Shut Down from the Special menu.

Shutting down the computer removes your RAM disk, 
if you created one.

3. Recharge the battery.

Plug in the power adapter or use the battery recharger.

4. If you recharged the battery in an external recharger,
put the battery back into the computer.

5. Store the computer in a cool, dry place.

Storage temperatures should remain between 10°C/50°F 
and 40°C/104°F.

If you leave the battery in storage for more than 6 months, 
you may not be able to recharge it.

Long-term storage for the PowerBook 100

1. Save your work onto a hard disk or floppy disks.

Save the contents of your RAM disk if you created one. You’ll
need to re-create your RAM disk when you take the computer
out of storage.

2. Choose Shut Down from the Special menu.

3. Flip the storage switch to the off (down) position to
disconnect all batteries.

continues >
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The PowerBook 100 draws a small amount of battery power
even when it is shut down. Disconnecting the batteries
protects them from draining in storage.

Because disconnecting all batteries erases everything in RAM,
when you take the computer out of storage you will need to

■ turn the storage switch back on

■ reset your system clock

■ restore any control panel settings that were stored in RAM

■ re-create your RAM disk, if you were using one

4. Store the computer in a cool, dry place.

Storage temperatures should remain between 10°C/50°F and
40°C/104°F.

If you leave the battery in storage for more than 6 months, 
you may not be able to recharge it.

General troubleshooting suggestions
When you see an error message, you don’t have to act instantly.
The message stays on the screen until you click OK or turn off
your computer.

To help diagnose and correct problems, collect as much
information as you can before taking action. Note what you were
doing when the problem occurred. Write down the message on
the screen and its ID number (if any), as well as the programs you
were using and the names of any items you know have been
added to the System Folder since system software was installed.
(It’s a good idea to keep this list available on paper in case of a
problem.) This information can help a service person diagnose the
problem if you need to take the computer to an authorized Apple
dealer for repair.

Rebuilding your desktop

A process called rebuilding the desktop helps your computer keep
track of the information on your startup hard disk.

■ To rebuild the desktop, hold down the Option and x keys
while restarting your computer (use the Restart command).
Keep holding down the keys until you see a message asking
whether you want to rebuild the desktop. Comments in Info
windows are lost when you rebuild the desktop.

■ Rebuild the desktop on your startup disk once every month 
or two.
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Starting over

You can often solve a problem by clearing the computer’s memory
and starting over.

■ If possible, save any open documents before restarting the
Macintosh. (If your system is “frozen,” you may not be able 
to save.)

■ If possible, choose Restart from the Special menu or from the
dialog box on the screen. If you can’t choose Restart, press 
the reset button to restart your computer (you can also try
pressing the reset and interrupt buttons together).

■ If you think the problem may be caused by external
equipment such as a printer or a hard disk, try turning the
device off for 10 seconds or more. Then turn it on again 
and restart your computer.

Solving common problems

The “Troubleshooting” section at the back of this book provides
information about solving common problems you may encounter
with specific parts of your system.

Dealing with known or suspected computer damage

If your computer is malfunctioning but does not appear to be
physically damaged, shut it down (and leave the power adapter
plugged in, if possible) until you can get help.

If you know or suspect that your computer is physically damaged,
disconnect the power adapter, remove the battery, and do not use
the computer until it can be repaired.

To obtain service, contact any local authorized Apple service
provider. If you’re in North America, call 800-538-9696 to request
the name of an authorized service provider near you. If you’re
anywhere else, check the local telephone directory.
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Service and support
Apple Computer has established authorized Apple dealers to help
you get the best performance from your system. If you need
answers to product questions or information about product
updates, your authorized Apple dealer can help you. Apple’s
technical support organization backs each dealer and international
technical support group via an AppleLink® network, a state-of-the-
art on-line information service, to ensure prompt and reliable
assistance.

If your system needs service, Apple provides factory-quality parts
and the latest available diagnostic equipment to more than three
thousand authorized Apple service centers around the world.
Apple guarantees parts and warranty labor. (Regulations in each
country determine the length of warranty. Some restrictions may
apply, depending on the country of original purchase.)

If you cannot return to the authorized Apple dealer from whom
you purchased your system, go to the nearest service location. 
For the location nearest you, write or call one of the following:

Apple Computer, Inc. Apple Canada, Inc.
Customer Relations 7495 Birchmount Road
20525 Mariani Avenue Markham, Ontario, L3R 5G2
Cupertino, CA 95014-6299 Canada
USA (800) 268-7796/7637
(800) 538-9696

For locations in other countries, either call the Apple headquarters
in your country or write to the United States address on this page.

Apple also offers service plans. One is the AppleCare® Service
Agreement (available in the United States, Canada, and Australia
only), which extends full warranty coverage up to three years.
Your AppleCare contract will be honored at any participating
authorized Apple dealer within the country of purchase—an
added benefit if you relocate.

You can purchase AppleCare at any time, but you may want to
purchase it with your system, or at least before your warranty
expires, to avoid an inspection at your own expense.
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Keyboard and Character Sets
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return
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Tab key: Moves the insertion point
to the next stopping place (such as
a tab stop or data field).

Caps Lock key: A Shift key for
letters only (numbers and

symbols aren’t affected).

Shift key: Produces capital
letters (or the upper character

on the key).

Control key: In combination
with other keys, provides

shortcuts or modifies actions. 

Option key: In combination with
other keys, produces special

characters or modifies actions.

x (Command) key: Works in combination with
other keys as an alternative to choosing a menu
command or (in some programs) canceling an
operation in progress, such as printing.

Delete key: Deletes selected
material, or the character to

the left of the insertion point.

Return key: Moves the
insertion point to the
beginning of the next
line. In a dialog box,
pressing Return is the
same as clicking the
outlined button.

Arrow keys: Move the insertion
point, as an alternative to using the
trackball. In some programs, the
arrow keys have other functions.
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Using Caps Lock
The Caps Lock key on PowerBook computers does not lock down
when pressed. You can tell whether Caps Lock is on or off by
looking at the menu bar. An arrow appears to the left of the Help
menu icon when Caps Lock is on.

To turn Caps Lock on or off, simply press the Caps Lock key.

Typing special characters and symbols
You can type a variety of special characters (with diacritical marks)
and symbols by pressing modifier keys in combination with
certain letter and number keys.

The Key Caps program, which is installed with the system
software, shows you the characters produced when you type
certain keys and key combinations in the fonts available on your
computer (choose Key Caps from the Apple menu, then choose
the font from the Key Caps menu).

Characters appear here when you press keys
on the keyboard or click them in the window.

Characters available
in the Chicago font



To type a character with a diacritical mark (such as an acute accent
or an umlaut), you press the Option key along with a specific
letter key, and then type the character.

Diacritical mark Key combination

Grave accent ( ` ) Option–`, then type the character

Acute accent ( ´ ) Option–e, then type the character

Circumflex (^) Option–i, then type the character

Tilde (~) Option–n, then type the character

Umlaut ( ¨ ) Option–u, then type the character 

The letter “c” with a cedilla (ç) Option–c

If the character appears after the diacritical mark (rather than 
with it), then the marked character is not available in the font
you’re using.
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The highlighted key represents the
key held down on the keyboard—
in this case, the Option key.

Special
characters
available in
the Chicago
font when the
Option key 
is pressed



Exchanging Disks and Files
With MS-DOS Computers
Apple File Exchange is a file format conversion program supplied
on your system software disks. The program and translator files
are stored in the Apple File Exchange Folder.

You can use the program to initialize a disk in MS-DOS 
(or Apple II ProDOS®) format and convert files to and from 
MS-DOS (or ProDOS). Apple File Exchange cannot open
converted files; you need to open them with an application
program that recognizes the converted files.

Initializing a disk in MS-DOS format
(You can also follow these instructions to initialize a disk in
ProDOS format.)

1. Locate the Apple File Exchange icon and open it.

Apple File Exchange is supplied on one of your system
software disks.

When you open the program, the contents of the active
window are listed on the left side and an empty box appears
on the right side.

2. Insert a blank disk into your floppy disk drive.

A message reports that the program can’t read the disk and
asks if you want to initialize it. The message lists the formats
available in Apple File Exchange, including Macintosh, 
MS-DOS, and ProDOS.

(You can initialize a disk that is not blank by inserting it,
clicking the Drive button until the disk’s name appears, 
and then choosing Erase Disk from the File menu.)
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3. Click MS-DOS.

4. If necessary, click the capacity (in K) of the disk you
inserted.

If you want to initialize a high-density disk in MS-DOS format,
1440K is the only option and it is already selected. If you
inserted a double-sided disk, click 720K.

Apple File Exchange cannot initialize a high-density disk in
720K format, nor can it read a double-sided disk that has been
initialized in the high-density (1.4 MB) format.

5. Click Initialize.

When initialization is finished, a message asks you to name
the disk.

6. Type a name for the disk, and then click OK.

MS-DOS filenames can have up to eight characters, followed
by an optional period and up to three characters.

The name of the disk you initialized appears above an empty
window. The disk’s icon doesn’t appear on your Macintosh
screen because the Macintosh can’t recognize a disk in 
MS-DOS format.

7. Choose Quit from the File menu.
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high-density disks.



Converting files to and from 
MS-DOS format
Apple File Exchange provides two methods of file conversion—
text and binary. Text translation is for text files, and binary
translation is for other file types.

Apple File Exchange can also use translator files designed 
to convert files into formats that specific programs can use. 
One such translator file is provided with Apple File Exchange:
DCA-RFT/MacWrite, which converts documents between
MacWrite® format (for the Macintosh) and Document Content
Architecture/Revisable Form Text format (used by many 
MS-DOS word-processing programs).

Follow these steps to translate an MS-DOS (or ProDOS) file:

1. Locate the Apple File Exchange icon and open it.

Apple File Exchange is supplied on one of your system
software disks.

When you open the program, the contents of the active
window are listed on the left side and an empty box appears
on the right side.

2. Insert the floppy disk containing the files you want 
to translate.

3. Use the Open, Drive, and Eject buttons to display the
files you want to translate and the disk or folder where
you want to store the translated files.

4. Click the names of the files or folders you want to
translate.

The appropriate translation menus (for translating from or to
Macintosh format) appear in the menu bar when you select
MS-DOS files.
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Menus of
translator files

Directory
title or disk

name

Disk name

File selected
for translation



5. Pull down the translation menu you want.

6. Make sure that the translators for the types of files 
you selected have checkmarks; if not, choose them 
so checkmarks appear next to them.

An active translator has a checkmark. The default translator
has a diamond (indicating that it’s always active). Choosing 
an active translator makes it inactive.

7. Compare the size of the files or folders selected 
for translation with the space available on the
destination disk.

Total space required appears between the lists; the space
available on the destination disk appears below its name.

If the size of the selected items is greater than the space
available on the destination disk, deselect some of the items,
remove some files on the destination disk (click Remove), 
or use another destination disk (click Eject).

8. Click Translate.

If two or more active translators (other than Text or Default)
are capable of translating a selected file, a message asks you 
to select the translator you want.

If the names of files or folders on the destination disk are the
same as those of files or folders being translated, a message
asks you to rename the file being translated.

If you need to select options before a file is translated, a 
dialog box appears in which you can select the options.

9. Respond to any messages by selecting a translator,
renaming a file, or selecting options.

When Macintosh files are translated into MS-DOS files,
filenames may be shortened to conform to MS-DOS naming
conventions.

10. Choose Quit from the File menu.

❖ Converting MS-DOS files on a file server: Some file servers 
can store information created by both Macintosh and MS-DOS
computers. For example, the AppleShare PC program 
allows MS-DOS computers to store and translate files on an
AppleShare file server. Consult your authorized Apple dealer
or representative for more information about using a file
server and MS-DOS files.  ❖
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Other file-conversion options

Apple File Exchange’s File menu provides several other options 
to assist you with file conversions.

To see explanations of the translators Apple File Exchange uses,
choose About Apple File Exchange from the Apple menu. Select 
a translator from the list, and then click the About button for more
information. (Click Done to return to the program’s window.)

The active translators
and options for each

translator can be saved
in a file by choosing

“Save settings as.” You
can use these options

again later by choosing
“Restore settings from”

and opening the file.

Choose to reinitialize 
a disk in any 
available format.

Choose to rename
destination

(translated) files.

Names of files that can’t
be converted by the
active translators are

dimmed when this 
item is checked.

The program keeps a 
log of all files translated, 
showing the date, time, 
and type of conversion.



Where to Get More
Information About 
Your Macintosh

Macintosh user groups
Whatever your level of computer experience, you may be
interested in joining a Macintosh user group. User group members
work with Macintosh computers and enjoy sharing what they
know with others. Group activities may include new product
demonstrations, question-and-answer sessions, and classes on
using programs or writing your own programs.

Ask your authorized Apple dealer for the name of the Macintosh
user group nearest you, or call 800-538-9696. For names of user
groups outside the United States, or if you’re interested in starting
your own user group, contact

Berkeley Macintosh User’s Group
1442-A Walnut Street, #62
Berkeley, CA  94709
USA
415-549-BMUG (415-549-2684)

or

Boston Computer Society
One Center Plaza
Boston, MA  02108
USA
617-367-8080
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Technical information
Apple makes technical information for Macintosh computers
available through the Apple Technical Library and the Apple
Communications Library, both published by Addison-Wesley
Publishing Company and available at bookstores.

Apple Technical Library

The Apple Technical Library includes comprehensive technical
documentation for all Macintosh computer models as well as 
the multi-volume guide to the Macintosh operating system, 
Inside Macintosh.

Apple Communications Library

The Apple Communications Library offers complete technical
information about Macintosh communications products and the
Macintosh in a network environment.

APDA

APDA® (Apple Programmers and Developers Association) offers
access to a broad range of programming products, resources, 
and information for anyone developing hardware or software 
for Apple computers. These resources include the most current
versions of Apple and third-party development tools, debuggers,
compilers, languages, and technical references. 

To establish an APDA account, obtain ordering information, or
find out about site licensing and developer training programs,
contact

APDA
Apple Computer, Inc.
20525 Mariani Avenue, M/S 33-G
Cupertino, CA  95014-6299

800-282-2732 (USA)
800-637-0029 (Canada)
408-562-3910 (International)
Fax: 408-562-3971
Telex: 171576
AppleLink address: APDA

If you provide commercial products and services, call 
408-974-4897 for information about the developer support
programs available from Apple.

Assistance for hardware and software developers

If you plan to develop hardware or software products for sale
through retail channels, you can get valuable support from 
Apple Developer Programs. Write to

Apple Developer Programs
Apple Computer, Inc. 
Mailstop 51-W
20525 Mariani Avenue
Cupertino, CA  95014-6299
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A
access privileges The ability to see or change information in a

shared folder or disk. Access privileges are granted by the
owner of the shared item.

active program The program you’re currently using. Several
programs can be open at a time, but only one is active.
Open programs are listed in the Application menu; a
checkmark indicates the active program. The menu icon
changes to show which program is active.

active window The topmost window on the Macintosh desktop.
The active window has solid lines across its title bar and it
“belongs” to the active program.

ADB See Apple Desktop Bus port.

Alarm Clock A desk accessory program that works like a digital
alarm clock.

alias A file that stands for and points to a file, folder, or disk.
When you open an alias, you’re actually opening the
original item.

Apple Desktop Bus  (ADB) port The port to which you can
attach input devices such as a mouse, graphics tablet, or 
bar-code reader. See also bus.

Apple menu The menu at the far left end of the menu bar. 
You choose items from this menu to get information about
memory use, to open items you stored in the Apple Menu
Items folder, and to modify control panel settings.

AppleShare file server A Macintosh computer using AppleShare
file server software that allows network users to store,
retrieve, and share information on that computer.

AppleTalk network A combination of devices, cables, and
software that operate according to the protocols (rules)
developed by Apple Computer. A communications
environment in which many different kinds of computers
and software can work together.

Application menu The menu at the far right end of the menu
bar (its icon indicates which program is active). You choose
items from this menu to hide windows belonging to open
but inactive programs and to make an open program active.
See also active program.

application program A program you use for a specific activity
such as word processing, database management, graphics,
or telecommunication.
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B
back panel The back of the computer. Ports for attaching

external devices are on the back panel.

back up To make a copy of a file or the information on a 
disk. Backing up your work ensures that you won’t lose
information if the original is lost or damaged.

backup batteries The small battery (PowerBook 140/170) 
or batteries (PowerBook 100) that provide backup power
while you replace your main battery.

balloons The small text boxes that identify objects on the screen 
and explain their use.

battery The power source for your computer. See also power
adapter.

Battery desk accessory An Apple menu item that you use to
keep track of your battery’s charge level while you work.

bit Short for binary digit. The smallest unit of information a
computer can hold. The value of a bit (1 or 0) represents a
two-way choice (on or off, true or false, black or white).

bitmap A set of bits that represent a graphic image.

bitmap character A character in a font that’s rendered as 
a bitmap and drawn as a pixel pattern on the screen. 
See also font, pixel.

bitmap font A font in a single point size made up of bitmap
characters (also called a fixed-size font). Some fonts stored
in the Macintosh System file are bitmap fonts. Compare
outline font, TrueType font.

buffer A “holding area” in memory where information can be
stored by one program or device and then read by another.
For example, some printers have built-in memory to store
text that comes from the computer faster than it can be
printed. This memory is called a print buffer.

bus A circuit that transmits information from one part of a
computer system to another. In a network, a bus is a line 
of cable with connectors that link devices together.

button A screen image, sometimes resembling a pushbutton, 
that you click to designate, confirm, or cancel an action.
Compare trackball buttons.

byte A unit of information consisting of a fixed number of bits.
One byte consists of eight bits. See also kilobyte,
megabyte.
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C
cache See memory cache, disk cache.

Cancel button A button that appears in most dialog boxes.
Clicking it cancels any command or options you might 
have chosen and closes the dialog box.

central processing unit (CPU) The microprocessor that
performs the actual computations in your computer. 
See also processor, coprocessor.

checkbox A box associated with an option in a dialog box or
window. You click the checkbox to turn the option on or off.

chip See integrated circuit.

choose To give a command by dragging through a menu and
releasing the trackball button when the command is
highlighted.

Chooser A program that lets you designate devices, such as
printers and shared disks, for your Macintosh to use.

Clear An Edit menu command that removes selected material
without placing it on the Clipboard. You can use the Undo
command immediately after using Clear if you change 
your mind. Compare Cut.

click To position the pointer on an object on the screen and 
then press and quickly release the trackball button.

Clipboard A holding place in the computer’s memory for
whatever you last cut or copied. Information on the
Clipboard can be pasted into documents.

close box The small box at the left end of an active window’s
title bar. Clicking it closes the window.

command An instruction that causes the computer to perform
some action.

configuration (1) The way you have your computer set up. 
(2) The combined hardware components—computer 
and peripheral devices—that make up a computer system.
(3) The software settings that allow the hardware
components of a computer system to communicate 
with each other.

control panels Programs that you use to change Macintosh
features such as sound, trackball movement, and keyboard
options. Control panels are inside the System Folder.

coprocessor An auxiliary processor designed to relieve the
demand on the main processor by performing a few specific
tasks. Generally, coprocessors handle tasks that would be
performed much more slowly by the main processor, such
as mathematical calculations.

Copy An Edit menu command that copies selected material and
places it on the Clipboard, without removing the material
from the original document. See also Clipboard.
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CPU See central processing unit.

current application See active program.

cursor See pointer.

Cut An Edit menu command that removes selected material 
and places it on the Clipboard; from there you can paste 
it elsewhere. Compare Clear. See also Clipboard.

cut and paste To move text, graphics, or other material from 
one place in a document to another place in the same or 
a different document.

D
default A value, action, or setting that the computer assumes,

unless you give it a different instruction.

deselect To change a selected item so it is no longer selected. 
In the Finder, you deselect a highlighted icon by selecting
something else.

desk accessories (DAs) Small application programs often
installed in the Apple menu.

desktop Your working environment on the computer (the 
menu bar and the background area on the screen).

dialog box A box that contains a message requesting 
more information from you, or a box that you use to 
select options.

dimmed Gray or filled in with a pattern of dots, indicating 
that an icon is open, or that a menu, menu item, or 
other option is not available.

directory A list of the contents of a folder or a disk.

directory dialog box A dialog box that appears when you
choose Save, Save As, or Open from a program’s File menu.
You use the dialog box to save a document in a particular
folder or disk, or open a document in a particular folder 
or disk.

disk A flat, circular object with a magnetic surface that stores
programs and documents as magnetic signals, similar to the
way sounds are recorded on tape. See also floppy disk,
hard disk.

disk cache A part of the computer’s random-access memory
(RAM) where programs store frequently used instructions.
Compare memory cache.

disk capacity The maximum amount of data a disk can hold,
usually measured in megabytes (MB) or kilobytes (K).

disk drive The device that holds a disk, retrieves information
from it, and stores information on it.

document Whatever you create with an application program.
See also file.
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double-click To position the pointer on an object and then press
and release the trackball button twice in quick succession
without rolling the trackball.

drag To position the pointer on an object, press and hold the
trackball button, roll the trackball, and release the button.

driver A program that directs the operation of a peripheral
device such as a printer or scanner.

drop folder A shared folder that network users can place files 
or folders into, but only the owner can open.

E
Easy Access A control panel that allows you to modify the 

way your keyboard works. (You can also make keyboard
adjustments without opening the control panel.)

Edit menu Available in most programs, this menu lists editing
commands such as Cut, Copy, and Paste.

eject To remove a disk from a disk drive.

error message A message displayed on the screen that describes
an error or problem with a program or your equipment, or
an instance of miscommunication with the computer.

Everyone A category of network users representing anyone who
connects to a computer on the network.

F
file Any named, ordered collection of information stored on a

disk. Application programs and documents are examples of
files. You create a file when you do work, give your work a
name, and save it on a disk.

File menu This menu lists commands that affect whole
documents and other files—commands such as Save, 
Print, and Quit.

file server A computer using special software that allows
network users to store and retrieve files on the hard disks 
or other storage devices attached to it.

file sharing The sharing of information among computers on 
a network.

Finder The program that creates the Macintosh desktop and
keeps track of your files. The Finder is part of the Macintosh
system software.

floppy disk A disk made of flexible plastic that stores computer
data. The 3.5-inch floppy disks used in Macintosh floppy
disk drives are housed in rigid plastic shells for support 
and protection.

folder A container for documents, programs, and other folders
on the desktop or in a directory window.
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font A collection of letters, numbers, and symbols in a distinctive
typographic design. See also bitmap font, outline font,
TrueType font.

format See initialize.

G
group A group of registered users on a network who have a

common set of access privileges.

guest A person who connects to a computer on a network
without having to give a name or password.

guest access A type of access that permits any network user 
to connect to a computer for the purpose of file sharing 
or program linking.

H
hard disk A disk made of metal and permanently sealed inside 

a disk drive or cartridge. A hard disk can hold much more
information than a floppy disk, and access time is faster.

hard disk sleep A power-conserving feature that stops your
computer’s internal hard disk from spinning when it isn’t
being used. Compare system sleep.

highlighted Visually distinct, usually because the colors 
are reversed.

I, J
I-beam A pointer used to enter and edit text. See also 

insertion point.

icon A small pictorial representation of a file, disk, menu, option,
or other object or feature.

initialize To prepare a disk to receive information by organizing
its surface into tracks and sectors; also known as formatting.
If you initialize a disk with information on it, the information
is erased.

insertion point The place in a document where text you type
will be added. The insertion point is marked with a blinking
vertical bar.

Installer A program that installs or updates system software 
or individual components of system software (such as
networking software).

integrated circuit (IC) An electronic circuit entirely contained 
in a single piece of semiconducting material, usually silicon.
Often referred to as a chip.

interface The way a computer communicates with external
devices such as a printer (through its printer port, or 
printer interface), or with you (through its user interface 
or human interface).
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K
keyboard shortcut A combination of keypresses that gives a

command or sets an option. Keyboard shortcuts usually
involve the use of a modifier key, such as x or Option.

Key Caps A desk accessory that can display the characters
available for each font in your system.

kilobyte (K) 1024 bytes. See also byte, megabyte.

L
label A word or short phrase that you can assign to an icon by

using the Label menu. You can change labels in the Labels
control panel.

lithium cells See backup batteries.

LocalTalk Built-in networking hardware and software that allows
a Macintosh computer to be part of an AppleTalk network.

LocalTalk cable system A system of cables, cable extenders, 
and connector boxes that connect computers and network
devices to an AppleTalk network system.

lock To prevent files or disks from being changed or erased
(locked items can still be opened or copied).

M
main logic board A circuit board that holds RAM, ROM, the

microprocessor, custom integrated circuits, and other
components that make the computer work.

main memory See random-access memory.

megabyte (MB) 1024 kilobytes. See also byte, kilobyte.

member A registered network user who belongs to a 
particular group.

memory A component of a computer system that can store
information for later retrieval. See also main memory,
random-access memory, read-only memory.

memory cache Memory set aside to increase the efficiency and
operating speed of the computer. Compare disk cache.

menu A list of items from which you can choose by dragging 
to highlight the appropriate item and then releasing the
trackball button. See also pop-up menu.

menu bar The strip across the top of your screen that contains
the names and icons of available menus.

menu name A word, phrase, or icon in the menu bar or in 
a dialog box that gives you access to the menu. Press the
name to open the menu.
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modem Short for modulator/demodulator. A device that links
your computer to other computers and information services
over telephone lines.

modem port A port on the back panel of the computer to which
you can connect an external modem.

MS-DOS Microsoft Disk Operating System, a commonly used
computer operating system.

N
network Computer equipment connected for purposes of

communication. A network allows users to store, retrieve,
and share information, as well as share network devices
such as printers.

network administrator A person responsible for setting up,
maintaining, or troubleshooting a network.

network service A capability such as file sharing or printing
provided by special software on a network.

network user A person whose computer is connected to 
a network.

nickel-cadmium (NiCad) battery A type of rechargeable
battery. See also battery.

Note Pad A desk accessory for storing small amounts of text.

O
operating system Programs that organize the internal 

activities of the computer and its peripheral devices. An
operating system performs basic tasks such as moving 
data to and from devices and managing information 
in memory.

outline font A font that describes each character mathematically
as a set of formulas. The mathematical description adjusts
itself to render the character in different sizes. See also
TrueType font, bitmap font, font.

owner The owner of a Macintosh is named in the Sharing Setup
control panel. The owner of a shared folder or disk on the
network is named in the Sharing dialog box.

owner name The name of the owner of a shared folder or disk
that appears in the Sharing dialog box. The owner can be
the Macintosh owner, a registered user, or a registered
group. The owner can set or change access privileges to 
the shared item.
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P, Q
password A unique set of characters that must be entered before

a network user can gain access to a computer on which he
or she is registered.

Paste An Edit menu command that places the contents of the
Clipboard—whatever was last cut or copied—at the location
of the insertion point. See also Clipboard.

peripheral device A piece of hardware—such as a disk drive,
printer, or modem—used with a computer and under the
computer’s control.

PICT A file format used by some graphics and page layout
programs.

pixel Picture element. The smallest dot that the computer and
screen can display, or the representation on the screen of 
the value of a bit. Also, a location in video memory that
corresponds to a pixel on the screen. See also bit.

pointer An arrow or other symbol on the screen that moves as
you move the trackball.

pop-up menu A menu in which the selected option is shown
next to a triangle and inside a box with a shadow around it.
The menu “pops up” when you press the box. Compare
pull-down menu.

port A socket on the back panel of the computer where you can
plug in a cable to connect another device such as a printer
or a microphone.

power adapter The device that recharges the battery in your
computer while it is in use or shut down.

power button A button on the back panel of the PowerBook 140
and 170 that can be used to wake the computer, as an
alternative to pressing a key on the keyboard.

Power Saver A feature of the PowerBook 170 that slows the
computer’s microprocessor from 25 MHz to 16 MHz to
conserve power.

printer port A port on the back panel of the computer to which
you can connect a printer or a network cable.

processor The computer hardware component that performs 
the computations directed by software commands. In the
Macintosh, the processor is a single integrated circuit called
a microprocessor.  See also central processing unit.

program A set of instructions describing actions for a computer
to perform to accomplish a task, conforming to the rules 
and conventions of a particular programming language.
Computer programs are collectively referred to as software.
See also application program.

program linking The ability of an application program to
exchange information directly with another program over 
a network. (Both programs must have the capability.)

pull-down menu A menu whose name or icon is shown in the
menu bar. You “pull down” the menu by pressing the name
or icon. Compare pop-up menu.
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R
RAM See random-access memory.

RAM disk A portion of your computer’s memory set aside as a
temporary storage device. Memory assigned to a RAM disk 
is not available for opening programs.

random-access memory (RAM) The part of the computer’s
memory available for work with programs and 
documents, also known as main memory. Compare 
read-only memory.

Read Me document A document included on some application
program and system software disks to provide you with 
late-breaking information about the product.

read-only memory (ROM) Memory whose contents the
computer can read but not change. Information is placed
into read-only memory during manufacturing. Compare
random-access memory.

registered group A group of registered users listed on a
computer on a network. The group may have special access
privileges to files on that computer.

registered user A network user whose name and password are
listed on a computer on the network. Usually, registered
users have greater access privileges to shared folders and
disks than do guest users.

ROM See read-only memory.

S
save To store information by transferring it from RAM to a disk.

scanning order The order in which the Macintosh searches the
disk drives for a startup disk. See also startup disk.

Scrapbook A desk accessory for storing frequently used pictures
or text. You can cut or copy images from the Scrapbook and
paste them into documents created with most application
programs. Compare Clipboard.

scroll To move a document or directory in its window so that a
different part of it is visible.

SCSI See Small Computer System Interface.

SCSI cable terminator A device used in a SCSI chain to ensure
the accuracy of the signals passing through the chain.

SCSI chain A group of up to six SCSI devices linked to a
Macintosh computer.

SCSI disk mode A mode in which the PowerBook 100 can 
be connected to a desktop Macintosh as an external 
SCSI hard disk.

SCSI port The socket on the back panel of the computer to
which you connect SCSI devices.
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sealed lead-acid (SLA) battery A type of rechargeable battery.
See also battery.

select To designate which object will receive the next action 
you take. Selecting is usually done by clicking or dragging.
A selected object is usually highlighted.

serial ports The connectors for peripheral devices that receive
data in a serial format (that is, one bit at a time). The
Macintosh printer and modem ports are serial ports.

shared disk A hard disk, CD-ROM disc, or other medium whose
contents can be retrieved over the network. A disk can be
shared by a file server or a Macintosh computer that has file
sharing turned on.

shared folder A folder available to some or all network users
over the network.

Shift-click To click the trackball button while holding down the
Shift key. You can use this technique to extend or shorten a
selection and to select more than one item.

Shift-drag To drag while holding down the Shift key. You can
select two or more groups of objects by holding down the
Shift key while you drag diagonally to enclose each group 
of objects in a rectangle.

size box A box at the bottom-right corner of the active window.
Dragging the size box resizes the window.

sleep See hard disk sleep, system sleep.

Slow Keys An Easy Access feature that lets you set a delay
before each keystroke is accepted by the computer. 

Small Computer System Interface (SCSI) A specification 
of mechanical, electrical, and functional standards for
connecting peripheral devices such as hard disks, printers,
and optical disks to microcomputers and minicomputers.

sound input port A port on the back panel of some computers
to which you can connect a microphone.

sound output port A port on the back panel of the computer 
to which you can connect headphones or speakers.

startup disk The disk that contains all the necessary files—
including the Finder and System files in the System Folder—
that the computer uses to start up. The startup disk icon
appears near the upper-right corner of the desktop.

stationery A document that serves as a template. When you
open a stationery document, a copy of the document is
created and opened. The original remains unchanged.

Sticky Keys An Easy Access feature that lets you type
combination keystrokes without actually pressing the 
keys simultaneously.
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storage switch A switch on the back of the PowerBook 100 
that shuts off all battery power for long-term storage of 
the computer.

system extension A program that expands the capabilities 
of system software. System extensions are stored in the
Extensions folder in the System Folder.

System file The file your computer uses to start up. The System
file stores system-wide information including fonts, sounds,
and keyboard layouts.

System Folder A folder containing the programs your computer
uses to start up and operate. A disk that contains a System
Folder is a startup disk.

system rest A feature that slows the power consumption of 
your computer’s microprocessor after a certain period 
of inactivity.

system sleep A power-conserving state in which your computer
uses only the power it needs to maintain the contents of
RAM. Compare hard disk sleep.

system software Programs that manage the computer’s
operation. On the Macintosh, system software is stored in
the System Folder. See also operating system.

T
TeachText A limited word-processing program provided with the

Macintosh system software, made available so you can open
Read Me documents, text files, screen shots, and PICT files.

terminator See SCSI cable terminator.

3.5-inch disk A flexible plastic disk measuring 3.5 inches in
diameter, encased in a rigid plastic shell. These disks 
come in three types: high-density (1.4 MB capacity on the
Macintosh), double-sided (800K), and single-sided (400K).
See also floppy disk.

title bar The bar at the top of a window that shows its name. 
The title bar of an active window is highlighted with
horizontal lines.

trackball buttons The mechanical buttons above and below 
the trackball; both buttons do the same thing. In general,
pressing a button initiates some action on whatever is under
the pointer on the screen, and releasing the button confirms
the action.

Trash An icon on the desktop that you use to discard programs,
documents, and folders.

TrueType font A type of outline font supplied with the
Macintosh system software. See also outline font.
Compare bitmap font.
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U
unlock To allow a locked disk or document to be changed,

deleted, or renamed. See also lock.

User/Group A single registered user or group on a computer
containing a shared folder or disk. This user or group 
may have special access privileges to shared items on 
that computer.

user interface See interface.

user name The name chosen by a Macintosh owner or network
administrator to identify a registered user.

V
virtual memory Hard disk space set aside as an extension of the

computer’s main memory (RAM).

volume Space on a hard disk or a file server that is defined and
named as a place to store files. A hard disk is usually a single
volume, but it can be partitioned into several volumes.

W, X, Y
window A rectangular area that displays information on the

desktop. You create and view documents through windows,
and you view the contents of disks in windows.

Z
zone Zones are set up by a network administrator and are 

used to group devices on a network.

zoom box A small box at the top-right corner of the title bar 
of the active window. Clicking the zoom box resizes the
window so you can see all of its contents (if possible);
clicking it again returns the window to its previous size.
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Troubleshooting
This section describes possible causes and solutions for problems
you may have with your Macintosh PowerBook computer.

▲ Warning: If you have a problem with your computer 
and nothing presented in the manuals that came with the
computer solves the problem, take the computer to your
authorized Apple dealer or service provider. Attempting to
repair the computer yourself may void the Limited Warranty.
Contact your authorized Apple dealer or service provider 
for additional information about this or any other warranty
question. ▲

The computer
The computer won’t start.

■ The computer may be on, but the screen brightness or
contrast may be turned down. Adjust the brightness and
contrast controls to see whether an image appears on 
the screen.

■ If you have a PowerBook 100, make sure the storage switch 
is up.

■ The battery may be drained. Plug in the power adapter, wait
15 minutes, and then try to turn on the computer.

■ If you have any SCSI devices connected to your computer, 
you must turn them on before you turn on the computer.

■ See “Restarting a Computer That Can’t Be Turned on
Normally” in Chapter 9 for more suggestions.

The computer just stopped.

■ The computer may have gone to sleep. Press any key on the
keyboard (except Caps Lock) to wake it again.

■ The battery may have drained so far that the computer has 
put itself to sleep to protect the contents of RAM. Plug in the
power adapter, wait 15 minutes, and then turn the computer
on again.

■ Your system may have “crashed” due to temporary software
problems. Click the Restart button on the screen (if you see
one), or press the reset button on the side (PowerBook 100) 
or back (PowerBook 140/170) of your computer. The button 
is marked with a triangle pointing sideways.

continues >

253

T
R

O
U

B
L

E
S

H
O

O
T

IN
G

Quick Reference



The computer exhibits odd behavior, such as many
unexplained system failures.

■ A common cause of unexplained problems is multiple 
System Folders on the startup disk. Use the Find command 
in the Finder’s File menu to locate any extra System Folders,
and drag them to the Trash.

■ You may have a virus on your hard disk. Obtain a 
virus-detection program, use it to check all your disks, 
and eliminate any viruses the program finds.

■ You may be using a program that’s not compatible with your
computer’s system software. Check the manual that came 
with the program or contact the manufacturer.

The trackball doesn’t work smoothly; it appears to “stick”
or “jump” when rolled.

■ There may be dust or dirt inside the trackball mechanism. 
To clean the trackball, follow these steps:

1. Remove the trackball retaining ring by turning 
it counterclockwise until it pops out. You don’t 
need tools; just press against the two small 
ridges with your fingernails.

2. Lift the trackball out of its cavity.

3. Locate the small rubber rollers at the left and
bottom sides of the trackball cavity. Depending 
on your model, they may look like small rings 
or wheels.

4. Use any reasonably clean, blunt object (your 
finger, a cotton swab) to wipe off the rollers. 
Do not use any liquid inside the computer.

5. Replace the trackball and the retaining ring.
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Power
The battery is draining awfully fast.

■ The features that drain the battery fastest are the screen
backlighting and the hard disk drive. Turn down the screen
brightness, turn off virtual memory (PowerBook 140/170), 
set a shorter hard disk sleep interval, or work with the power
adapter plugged in.

■ You may be using an input device (such as the mouse
intended for desktop Macintosh systems) not designed for
PowerBook computers. Make sure to use only low-power
ADB devices.

■ Your computer supplies power to the modem whenever a
communications program is open. Quit your communications
program if you aren’t using it.

■ If you have a Powerbook 140/170, you may need to discharge
and recharge the battery completely. See “Maximizing Battery
Life” in Chapter 9.

■ Over time, PowerBook batteries do not hold a charge as well
as when they were new. You may need to replace the battery.

The computer goes to sleep too often.

■ The interval before the computer goes to sleep to conserve
power may be very short. Open the Portable control panel 
and set a longer interval in the “Minutes Until Automatic 
Sleep” box.

The battery can’t be recharged.

■ There may be a loose connection in the charging circuit.
Check the power connections to your computer or recharger
to make sure all plugs are securely attached.

■ If all connections are OK, then the battery is probably
damaged or dead. You’ll need to obtain a replacement 
battery from your authorized Apple dealer.

The computer doesn’t go to sleep automatically.

■ The computer does not go to sleep automatically if the 
power adapter is plugged in and you have selected “Stay
awake while plugged in” in the Portable control panel. 
Click the box to remove the X.

■ The computer does not go to sleep automatically if AppleTalk
is active. If you are not using AppleTalk to communicate 
with a network or an attached printer, open the Chooser 
and make AppleTalk inactive.

■ The computer does not go to sleep automatically 
if the modem or printer port is in use. Quit your
telecommunications program or turn off background 
printing in the Chooser (if the documents you’re printing 
can wait until later).

■ One or more applications doing work in the background 
will prevent sleep; you can choose Sleep from the Special
menu to override them.

See Chapter 9 for more information about power and batteries.
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The screen
The screen looks blurred or out of focus.

■ The viewing angle may not be optimal. Tilt the display on its
hinge until the screen looks better.

The screen is too dark.

■ When you first turn on your computer, it may take several
minutes for the screen brightness to “warm up,” especially 
if you’ve chosen a high setting.

■ The screen brightness or contrast may not be optimal for the
surrounding lighting. Adjust the brightness or contrast setting.

■ The screen dims automatically when the battery starts to run
low. You may need to recharge or replace the battery before
you can turn up the brightness.

The pointer moves too fast/too slowly.

■ You need to adjust the pointer’s tracking speed. Open the
Mouse control panel and choose a more comfortable setting.

The pointer won’t move at all.

■ A software problem may occasionally cause the computer to
“freeze.” Restart the computer by pressing the reset button on
the side (PowerBook 100) or back (PowerBook 140/170) of
your computer. The button is marked with a triangle pointing
sideways. If you did not save your work before the computer
froze, you will lose any changes made since you last saved.

There are ghost images or black dots on the screen.

■ When the computer is left on for a few days, temporary
defects may appear on the screen. Put the computer to sleep.
The longer the computer was left on, the longer it will take 
for the images to fade, but they will eventually disappear.

A window has disappeared.

■ Open windows on the desktop may cover each other; if you
have several open windows, it is easy to lose track of one.
Move, resize, or close windows you aren’t using.

■ Windows belonging to open but inactive programs may be
hidden. Choose Show All from the Application menu to show
hidden windows.

An icon is blinking in the menu bar.

■ One of your programs is alerting you to a condition that
requires your attention. For example, you may have set the
Alarm Clock to go off at a particular time, or PrintMonitor 
may be alerting you to a printing problem. Make the 
program active and take the necessary action.

256 Quick Reference: Troubleshooting



Disk drives and disks
The computer won’t start up from its hard disk, or the hard
disk icon doesn’t appear on the desktop.

■ There may have been a temporary software problem. Shut
down your computer, wait at least 10 seconds, and then turn 
it on again.

■ There may be a problem with the system software on the 
hard disk. Start up the computer with the Disk Tools disk. If
the hard disk’s icon appears, reinstall system software as
described in Chapter 8. 

■ There may be a mechanical problem with the disk drive. If
neither of the above suggestions works, take the computer to
an authorized Apple service provider.

The hard disk keeps stopping and starting again.

■ The interval before the computer’s hard disk goes to sleep to
conserve power may be very short. Open the Portable control
panel and set a longer interval in the “Minutes Until Automatic
Sleep” box.

The hard disk is full.

■ You can reclaim space on your hard disk by removing
unneeded files; installing a smaller, customized System 
Folder; turning off virtual memory (PowerBook 140/170); 
or purchasing a disk optimization program to reorganize 
the information on the hard disk.

The icon of a floppy disk doesn’t appear on the screen.

■ The computer may not be able to recognize the drive. Choose
Restart from the Special menu to restart your computer, and 
try inserting the disk again.

■ There may be a problem with the disk. Try inserting a different
disk. If its icon does appear, the original disk is probably
damaged. You may be able to repair the disk or recover some
of the information on it. See “Testing and Repairing Disks” in
Chapter 10.

■ There may be a problem with the disk drive. Try inserting a
different disk. If its icon does not appear either, take the disk
drive to an authorized Apple service provider for repair.

continues >
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A 1.4 MB (high-density) disk you use with your PowerBook
computer is not recognized by another Macintosh.

■ Not all Macintosh models have disk drives that can recognize
1.4 MB disks. You’ll need to copy the files on the 1.4 MB disk
to an 800K disk or a 400K disk. If you regularly plan to use
floppy disk drives of different types, use the lower-capacity
disks in all drives.

You can’t eject a disk from a floppy disk drive.

■ There may be a temporary mechanical problem with the disk
drive. Carefully insert the end of a straightened paper clip into
the small hole near the disk drive’s opening, and push gently
until the disk is ejected.

A message says that a disk is not initialized—but you know
that it is.

■ The disk may not be seated properly in the disk drive. Eject it
and try inserting it again.

■ The disk may be damaged. If you insert another disk in the
drive and the message does not appear, you can assume that
the original disk needs repair. See “Testing and Repairing
Disks” in Chapter 10 for information about recovering
information from a damaged disk.

You can’t delete a file on a floppy disk.

■ The disk may be locked. Unlock it by sliding the tab so that it
covers the hole at the corner of the disk.

■ The file may be locked.  If so, you’ll see a message. You 
can unlock it in its Info window (choose Get Info from the 
File menu).

■ An application program may be using the file. You’ll need to
quit the program.

You can’t save or copy files onto a floppy disk.

■ The disk may be locked. Unlock it by sliding the tab so that it
covers the hole at the corner of the disk.

■ The disk may be full. You’ll see an error message in this case.

See Chapter 10 for more information about disks and disk drives.
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Application programs
A program won’t open.

■ Some programs can’t be opened from a locked floppy disk. 
If you are trying to start a program on a floppy disk, make sure
the disk is unlocked.

A program runs very slowly.

■ Some programs are slowed by your computer’s system rest
feature. You can correct the problem by turning off system
rest. See “Adjusting System Rest” in Chapter 9.

A program doesn’t work, or malfunctions consistently.

■ You may have more than one copy of the program on your
hard disk. Remove extra copies by dragging them to the Trash.

■ Your version of the program may be incompatible with your
system software. Consult the software manufacturer to find 
out which version of the program you should be using.

■ The program may be using less memory than it needs to work
with your documents. Choose Get Info from the File menu
and increase the memory size. 

A message says that a program could not be found.

■ You may be trying to open a document created with a
program you don’t have on your computer, or created with 
a later version of a program you do have. Find out what
program and version was used to create the document, and
obtain it if necessary. Or open the document within another
program that can read its format.

You just did something you didn’t mean to do.

■ If you have not yet taken any other action, you can usually
undo your most recent action (even if you aren’t sure what 
it was). Most programs have an Undo command in the Edit
menu. Choose Undo to go back one step in your work. You
cannot undo more than one action.

See the documentation that came with your programs for more
information about their operation and features.
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Memory
A “not enough memory” message appears when you try to
open a program.

■ You may already have as many programs open as your
computer’s memory can support. Quit any programs you
aren’t using and then restart the computer. Sometimes quitting
and restarting all your programs makes additional memory
available.

■ If you are using a RAM disk or a disk cache, you may not have
enough memory left to open multiple programs. Reduce the
size of your RAM disk or disk cache.

■ Use virtual memory (PowerBook 140/170) to increase the
amount of memory available for opening programs.

■ You may not have enough memory in your computer for the
type of work you want to do. You can purchase a memory
expansion card from your authorized Apple dealer.

SCSI devices
You can’t turn on the computer after connecting a 
SCSI device.

■ SCSI devices connected to your computer must be turned on
before the computer itself. Turn on the SCSI device(s) attached
to your computer, and then turn on the computer.

The computer doesn’t recognize one or more SCSI devices.

■ The device may be off. Check to make sure that it is plugged
into its own power source and turned on.

■ If the device is a disk drive, it may need to be initialized before
you can use it. See the instructions that came with the device.

■ The software (driver) needed to run the device may not be
installed on your computer. Install the software as described 
in the manual that came with the device.
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■ One or more devices in the SCSI chain may not have a unique
ID number between 1 and 6. Check the ID number of each
device to make sure the numbers are appropriate, and change
any that are not.

■ It is important to configure SCSI chains with the right 
cables, and with the correct number and placement of cable
terminators. Check the configuration of your SCSI chain to
make sure that it is correct and that all cables are firmly
attached.

See Chapter 15 for more information about working with SCSI
devices and connecting SCSI chains.

Modems
The external modem doesn’t work.

■ The modem may be turned off or improperly connected.
Make sure it is turned on and that all connections are secure.

■ The modem port circuitry may not be activated. Open the
Portable control panel and make sure that External Modem 
is selected.

The internal modem doesn’t work.

■ The modem port circuitry may not be activated. Open the
Portable control panel and make sure that Internal Modem 
is selected.

See the modem manual for more information about using and
solving problems with your modem.
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Printers
Your computer can’t find the printer.

■ The printer may not be selected in the Chooser. Open the
Chooser and select the printer you want to use.

Your printer does not appear in the Chooser window.

■ The printer may not be connected properly. Check the
connections between your computer and the printer,
including relevant sections of the network if appropriate.

■ The printer software may not be in your System Folder. 
Close the Chooser and install the software you need.

■ AppleTalk must be active before you can use a network
printer. Make sure that AppleTalk is active in the Chooser.

■ If your network has zones, the printer you want may not be 
in the currently selected zone. Make sure the correct zone 
is selected.

Nothing happens, or you see an error message, when you
try to print.

■ The printer may not be turned on. Make sure it is turned on
and warmed up.

■ The printer may be out of paper or have some other problem.
Check the printer status lights and see if there are any
messages on your screen.

■ If an error message states that the printer could not print your
document, turn the printer off for at least 10 seconds. Then
turn it on again, wait for it to warm up, and try to print again.

The printer keeps restarting.

■ You or another network user may be using a different version
of the printer software. Everyone connected to a network
should use the same printer software version. Consult the
network administrator for more information.

Your documents are printed with the wrong fonts.

■ The printer may not have your fonts in its memory and is
substituting other fonts. You may be able to add the necessary
fonts to your printer (see “Transferring Fonts to a LaserWriter
Printer” in Chapter 13), or print on a different network printer
that has the fonts you want.

See the printer manual for more information about your printer’s
features or problems with the printed output.
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Networks
You can’t find or can’t open icons needed to set up 
file sharing.

■ One or more icons may be in the wrong place. Make sure that
the Sharing Setup icon is in the Control Panels folder, and that
the File Sharing Extension file, the Network Extension file, 
and the AppleShare file are in the Extensions folder. (Both
folders are inside the System Folder.)

The shared disk you want to connect to does not appear 
in the Chooser window.

■ AppleTalk must be active before you can use a shared disk.
Make sure that AppleTalk is active in the Chooser.

■ If your network has zones, the shared disk you want may not
be in the currently selected zone. Make sure the correct zone
is selected.

■ If the shared disk is on another network user’s Macintosh, that
Macintosh must be turned on before the disk can be shared.
Make sure the computer is on.

You can’t open a shared disk or folder.

■ You may not have the access privileges needed to use the disk
or folder. Ask the network administrator or the owner of the
shared item to grant you access.

■ You may have entered your name or password incorrectly
when you tried to open the shared disk or folder. Check with
the owner of the item to make sure you are entering your
name and password correctly, and try again.

You can’t connect to your own computer from another
Macintosh.

■ Make sure that your computer is turned on, file sharing is
turned on, you have the correct access privileges, and you
entered your password correctly.
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A
accent marks  231
access privileges  196–199. See

also file sharing;
network

checking  199
set by others  199
setting  197
strategies for using  198
types of  196

active program  40–42, 46
checking for  85
opening a document in  62

active window  16–17
printing contents of  162

ADB devices. See Apple Desktop
Bus devices

air travel tips  223
Alarm Clock

setting alarm  137–138
setting time  136–137
turning alarm off  138

alert sound
choosing  142
installing  143
recording  143–144
removing  143
when alarm “rings”  138
with Slow Keys feature  141
with Sticky Keys feature  141

alias  64
connecting to a shared disk

with  179
creating  64–65, 124
locating original of  125
locking  114
searching for  129
troubleshooting  124
uses of  124

APDA (Apple Programmers and
Developers
Association)  238

Apple II ProDOS format 
converting files to and from

234–236
initializing a disk in  232–233

AppleCare Service Agreement
228

Apple Desktop Bus (ADB)
devices

connecting  101, 218
power use of  101, 218

Apple File Exchange  232
converting files with

234–236
initializing a disk with

232–233
Apple HDI-30 SCSI System Cable

208, 210, 211, 213
Apple HD SC Setup program

110, 120
Apple menu  11

adding items to  125, 134
removing items from  125,

134
Apple Menu Items folder  125,

134
AppleShare icon  177
AppleShare PC program  235
AppleTalk

external modems and  217
sleep and  92, 103, 174
turning on/off  174

Application menu
hide and show windows  85
make an open program

active  42, 85
open PrintMonitor  165
switch programs  85

application programs  43
installing  83
locating  129
making active  42
switching  85
troubleshooting  83, 259

arrow keys  24, 229
arrow pointer  10

B
background printing  159,

164–165
backup batteries  99

replacing  99–100
backup copies  53–54, 115
backup program  115
Balloon Help  70–71
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battery
backup, replacing  99–100
caring for  223
cautions about  98, 99, 222,

223
low-power messages  94
maximizing life of  99
maximizing work time with

101
monitoring charge level of

93–94
recharging  8, 95–97
removing or replacing  98
SCSI disk mode and  216
sleep and  8, 94
troubleshooting  255
types of  98, 99
using the computer without

94
Battery desk accessory

opening  93
Power Saver feature  105
sleep shortcuts from  92

Berkeley Macintosh User’s
Group  237

binary translation  234
bitmap  167
bitmap fonts  167
blinking icons  79, 256
blinking line. See insertion point

Boston Computer Society  237
brightness, adjusting  101, 149
bulletin boards

access privileges for  198
viruses and  84

C
cables

for SCSI connections  208,
210, 211, 213, 214

safety instructions  221, 222
Cache Size box  153
Caps Lock key  229, 230
care and maintenance 221–223
CD-ROM disc

access privileges and
196–199

connecting  208–211
ejecting  116
selecting for sharing  183–184

changed files, searching for  129
changing RAM disk size  107
changing window size  17–18
character repeat rate, adjusting

140
character sets  230–231
Chooser  157

using  158–159, 174, 177–178
choosing a command  14, 49
cleaning the computer  222
Clean Up command  121
Clear command  52

clicking  11
Clipboard  50–51
clock, setting  136–138
close box  20, 21
CloseView control panel

150–151
Close Window command  21
closing a document  43, 44
closing a window  20, 21
color, printing in  163
comfort. See ergonomics
Command key  24, 49, 229
commands

choosing  14
keyboard shortcuts for  49

communications products,
System 7 and  204

computer viruses  84
configuration. See hardware

configuration
contrast, adjusting  149
Control key  229
control panels

alert sound  142
appearance of Finder

windows  147
AppleTalk  174
desktop pattern  144–145
disk cache  153
Easy Access  141
hard disk sleep  104
insertion point blinking  146

control panels (continued)
internal/external modem  217
keyboard response  140
label names  136
menu item blinking  146
file sharing  183–187,

189–190, 191–195
network identity  175, 195
program linking  202, 203
RAM disks  106–108
SCSI ID number  212
system rest  102
system sleep  103
32-bit addressing  156
trackball speed  139
virtual memory  154–155

copying a disk  29, 34–35
copying a document  53–54,

56–58
copyright law, program sharing

and  184
creating a document  38–40
creating a folder  122

on a shared disk  180
creating stationery  66–68, 130
cursor. See pointer
customer service  228
customized system software,

installing  81–82,
161–162

Cut command  50
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D
damage to computer  227
Data Access Language (DAL)

204
date

searching for files by  129
setting  136–137

DCA-RFT/MacWrite translator
234

dealer support  228
Delete key  39, 229
deleting a file  33–34
deleting text  51–52
deleting typing errors  39
deselecting an item  12
desk accessories (DAs)

Battery  92, 93, 105
Key Caps  230–231
switching among  85

desktop  6
changing pattern of  144–145
contents of  22–23
dragging an object on  12
moving an item to  125
pointing to an object on  10
printing contents of  163
rebuilding  226
selecting an object on  11
straightening up  121

desktop Macintosh. See
Macintosh desktop
computer

diacritical marks  231
dialog box  28
directory  123

saving a file in  123
directory dialog box  123
disk cache  153

adjusting the size of  153
disk capacity  26, 27
disk drives  26. 27, 206–207
diskettes. See floppy disks
Disk First Aid program, using

118–119
disks  27. See also floppy disks;

hard disk
backing up  115
caring for  117
copying the contents of  29
erasing  112
ejecting  31, 116
formatting. See initializing
initializing

floppy disk  28, 109,
111–112

hard disk  109, 110
inserting  26
installing programs on  34–36
locking  32, 114
removing items from  33–34
startup  113
testing and repairing

117–120

Disk Tools disk
Apple HD SC Setup program

on  110, 120
Disk First Aid program on

118
starting up with  82, 90

Document Content Architecture
(DCA) format  234

documents  23
adding to Apple menu  134
aliases for  64–65, 124–125
backing up  53–54
changing  46–49, 50–52
closing  43–44, 53
converting to and from

stationery  66–68, 130
copying  53–54, 56–58
creating  38–39
naming  39–40, 123
opening  44, 46

automatically  134
when its program is active

62
printing  162–163
saving  39–40, 49, 60–61, 123
saving as a template  66–68,

130
double-clicking  46

adjusting speed of  139
downloading printer fonts

168–169

dragging  12
drivers  134, 208
drop box  198
drop folder  198
duplicating a document  57–58

E
Easy Access control panel,

keyboard adjustments
with  141

Easy Install dialog box  80
ejecting a floppy disk  31, 116
electronic bulletin boards. See

bulletin boards
emptying Trash  34

turning off warning  152
when erasing or resizing a

RAM disk  107
erasing

a floppy disk  112
a RAM disk  107
typing errors  39

ergonomics  13, 78
error messages  89, 142. See also

troubleshooting
in printing  164
in SCSI disk mode  214

Everyone  196
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extended warranty coverage
228

Extensions folder  175, 177, 204
external floppy disk drive  25,

26. See also floppy disk
drive

caring for  207
connecting  206–207
disconnecting  207

external modem, connecting
217

external recharger  96–97
external SCSI disk drive

as startup disk  113
connecting  208–211
using your computer as  90,

212–214

F
fax/data modem  217
files

adding to System Folder
134–135

backing up  115
closing  43, 44, 53
converting to and from 

MS-DOS format
234–236

files (continued)
deleting  33
getting information about

131–132
locating  124–125, 126–129
locking  32, 114
opening  15, 44
organizing  62–63, 122, 132
program vs. document  23
removing from System Folder

135
shared disk access to

176–180
sharing. See file sharing
straightening up  121
system. See System file,

System Folder, system
software

throwing away  33
file server  176. See also shared

disks; shared folders
and MS-DOS files  235

file sharing See also access
privileges; network

changing your password
181, 195

checking access privileges
199

connecting to a shared disk
177–178, 179–180

creating a folder on a shared
disk  180

file sharing (continued)
disconnecting from a shared

disk  178
disconnecting someone from

your disk  193
files that belong to others

182–193
files that belong to you

176–181
gaining access to your own

computer  194–195
giving away ownership of a

folder or disk  182, 190
monitoring  192
naming users or groups for

sharing  185–187
preventing access to your

disk  184
restricting access to your disk

189–190
setting access privileges

197–198
selecting a folder or disk to

share  183–184
selecting users or groups for

sharing  188
troubleshooting  175, 185,

263
turning off  191–192
turning on  183

File Sharing Monitor  192
Find commmand  126
Find dialog box  126, 127
Finder  40, 43

changing display of window
contents  147

checking memory availability
in  205

checking memory use in  152
making active   41, 42

finding items on a disk  126–129
fixed-size (bitmap) fonts  167
floppy disk drive  25, 26. See

also external floppy
disk drive

in scanning order  113
installing programs without

83
installing system software

without  79–82
removing disk from  31, 116
restarting with  90
starting up with  207
troubleshooting  116, 257,

258
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floppy disks  22, 26, 27
backing up contents of

53–54, 115
caring for  30
capacities of  26, 27
copying contents of  29–30
ejecting  31, 116
erasing  112
initializing  28–29, 109,

111–112
initializing in MS-DOS format

232–233
inserting  26
installing system software

from  79–82
locking and unlocking  32,

114
obtaining  25
removing from drive  31, 116
restarting from  90
starting up from  79, 82, 207
troubleshooting  115, 116,

118–119, 257, 258
folders  23

access privileges to  196
aliases for  64, 124
ceasing to share  184
changing ownership of  182,

190–191

folders (continued)
creating and naming  122
creating on another

computer  180
deleting  33
locking items in  114
organizing files in  62–63,

122
selecting for sharing  183–184
setting access privileges for

197–198
throwing away  33

fonts  166–167
bitmap (fixed-size)  167
installing  167
Key Caps program and

230–231
outline (scalable or variable-

size)  166
removing  168
seeing which are available

170
transferring to a LaserWriter

168–169
TrueType  166

formatting. See initializing

G
gaining access to your computer

over a network
194–195

troubleshooting  263
General Controls panel

date  136–137
desktop pattern  144–145
insertion point blinking  146
menu item blinking  146
time  136–137

Get Info command  131
gray-scale documents, printing

163
group, registered. See registered

group
guest

access privileges of  196, 198
allowing to link to your

programs  203
connecting to a shared disk

as  177–178
creating a folder as  180
denying access to  189
linking programs as  200–201
removing from a group  190

H
halftone, printing as  163
hard disk  22, 27

as startup disk  6, 27
backing up  115
capacity of  27
caring for  117
changing ownership of

190–191
connecting to a printer  170
connecting to your computer

208–211
damage symptoms  110
deleting items from  33–34
designating as startup disk

113
finding items on  126–129
formatting. See initializing
initializing  28, 109, 110
installing programs on

34–36, 83–84
installing system software on

79–82
saving space on  81
scanning order at startup  113
sleep feature  104
sharing your own  182–188
sharing someone else’s

176–178
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hard disk (continued)
testing and repairing

117–120
troubleshooting  117–120,

257
using your computer as

212–214
virtual memory and  154–155

hard disk icon  22, 27
failure to appear  117–118
removing from desktop  116

hard disk sleep  104
hardware configuration  77

ADB devices  218
external floppy disk drive

206–207
headphones or speakers  220
memory  205
microphone  219
modem  217
mouse  218
printer  218
SCSI devices  208–211
using your computer as a

SCSI disk  212–214
hardware development support

238
HDI-30 SCSI System Cable  208,

210, 211, 213

headphones, connecting  220
Help menu  70–71
hidden window contents,

viewing  18–19
hidden windows, viewing  85
highlighted (selected) icon  11
horizontal scroll bar  19

I, J
I-beam pointer  46

locating  47
using to move insertion point

47
icons  6, 22–23

assigning labels to  149
changing appearance of

148–149
changing names of  58
clicking  11
double-clicking  46
dragging  12
highlighting  11
identifying  22–23, 27
low-power  101
making aliases for  64–65
opening  15

icons (continued)
organizing  62–63
pointing to  10
pressing  11
renaming  58–59
selecting  11
straightening up  121
with question mark  79

ID numbers, for SCSI devices
208–209, 212, 215

ImageWriter
Page Setup options for  160
selecting in Chooser  158
troubleshooting  164

Info window  131
change an icon  148–149
create stationery  67–68, 130
get information about a file

131
locate original of an alias  125
lock a file  114

initializing  28, 109
initializing a floppy disk  28–29,

111–112
in MS-DOS format  232–233

initializing a hard disk  110
inserting text  47
insertion point  39, 46

adjusting blinking of  146
positioning  47

Install 1 disk  79, 80, 81
Installer program  79–82, 

161–162
installing

Apple menu items  134
fonts  167
printer software  158,

161–162
programs  29, 34–36, 83–84
sounds  143
System Folder items  134
system software  79–82

in SCSI disk mode  215
internal modems  217
interrupt button  89, 90, 215

K
keyboard  24, 229

adjusting response of
140–141

comfort tips  13, 78
turning computer on from  4,

88
Keyboard control panel  140
keyboard shortcuts  49, 141
Key Caps desk accessory

230–231
kilobyte (K)  26, 27
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L
Label menu items, changing  136
labels

assigning to icons  149
changing  136
searching for  129

Labels control panel  136
LaserWriter

background printing with
159, 164–165

downloading fonts to
168–169

fonts available for  170
Page Setup options for  160
printing on  162–163
restarting  171
selecting in Chooser  159
start page, turning on or off

171
transferring PostScript files to

172
troubleshooting  164

LaserWriter Font Utility program
170

downloading fonts with
168–169

licensing agreements
file sharing and  184
software installation and  83

lightning bolt icon  93, 95

line, insertion point  39
linking programs  200–203
lithium cells. See backup

batteries
LocalTalk cable, connecting  174
Locked box, in Info window

114
locked files, searching for  129
locking files  114
locking/unlocking a disk  32,

114
low-power messages  94

M
Macintosh desktop computer 

back up files  115
gain access to your computer

194
install files  34, 83, 90, 117,

215
reinstall system software  90,

215
run your PowerBook as a

SCSI disk  212–214,
216

share files  182
transfer files  182

Macintosh HD icon, opening  15
MacWrite format, converting to

and from  234–235

magnifying the screen image
150–151

maintenance  221–223
megabyte (MB)  26, 27
member (of a group)  187
memo pad, creating  66–68
memory. See also disk cache;

memory cache; RAM
disk; virtual memory

adding  205
changing a program’s use of

86
checking use of  152
disk cache feature  153
managing  152–156
32-bit addressing feature  156
troubleshooting  152, 156,

260
virtual  154–155

memory cache  153
adjusting size of  153

Memory control panel
adjust disk cache size  153
create a RAM disk  106
resize or remove a RAM disk

107
turn on/off 32-bit addressing

156
turn on/off virtual memory

154–155

menu bar, 6
menu item, blinking of  146
menus  6, 14, 23

commands in  14
keyboard shortcuts in  49
pulling down  11
titles (names) of  6
viewing  11

microphone, connecting  219
mistakes, deleting  39
modem

connecting  217
power use of  101, 217
troubleshooting  261

modem port  217
modifier keys  24, 229

Sticky Keys feature with  141
typing special characters with

230–231
monitor. See screen
monitoring file sharing  192
Mouse control panel

double-click speed  139
pointer tracking  139

moving text  50–51
moving a window  20–21
MS-DOS format

converting to and from  232,
234–236

initializing a disk in  232–233
multiple programs, working with

85
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N
naming

a document  39–40
a folder  122
any icon  58
a registered group  186–187
a registered user  185
your Macintosh  175–176

network. See also access
privileges; file sharing

accessing your own
computer  194–195

assigning access privileges
196–198

assigning passwords to
registered users/
groups  186

ceasing to share a folder/disk
184

changing folder ownership
182, 190

changing your password
181, 195

checking your access
privileges  199

network (continued)
choosing a printer  159
connecting to a shared disk

177–178, 179
denying access to your

computer  189
disconnecting from a shared

disk  116, 178
disconnecting users from

your computer  193
installing system software

79, 80, 81–82
linking programs  200–203
monitoring file-sharing

activity  192
naming registered groups

186–187
naming registered users  185
preventing access to your

computer  189
removing users/groups from

your list of registered
users  190

selecting a printer  159
selecting a zone  159, 177
selecting one user/group for

sharing  188

network (continued)
setting up your Macintosh

173–176
shared disks  22, 116,

176–180
sharing your own files

182–195
sleep state and  92, 103
starting file sharing   183
stopping file sharing  191
troubleshooting  175, 185,

263
updating printer software

161–162
viewing group member

names  187
viruses and  84
working with files and

folders  180, 182
network administrator  159, 173,

174, 176, 181
new folder, creating  63, 122
nickel-cadmium (NiCad)

batteries  98, 99, 101.
See also battery

O
opening an icon  15
opening a document  44, 46

in the active program  62
opening a program  38
operating system  43, 79
Option key  24, 229
organizing files  121–125

in folders  62–63, 122
outline fonts  166
overwriting text  47–48
owner  196

P
Page Setup options  160
password

assigning to others  186
changing your own  181, 195

Paste command  51
performance

memory management and
152, 156

of programs  83, 102, 105
32-bit addressing and  156
virtual memory and  154–155

Personal LaserWriter SC. See
LaserWriter
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plug adapters  224
pointer

I-beam  46, 47
arrow  10

pointing  10
Portable control panel

adjust system sleep  103
adjust hard disk sleep  104
assign SCSI disk mode ID

212
select internal/external

modem  217
turn system rest on/off  102
work with virtual memory

154
PostScript file, transferring to

LaserWriter  172
PostScript fonts, downloading

168–169
PostScript Log, creating  172
power adapter

conserving power with  101
for external recharger  96
hard disk sleep and  104
recharging battery with  8,

88, 95
short-term storage and  224
StyleWriter printer and  218
system sleep and  103
travel tips  223, 224

PowerBook 100 model
backup batteries  99

replacing  99–100
battery

charge time  97, 101
life, maximizing  99
recharging  8, 88, 95,

96–97
removing/replacing  98
type  99
use time  101

brightness control  149
contrast control  149
external floppy disk drive

206–207
installing programs

without  83
interrupt button  89
low-power messages  94
modem  217
reset button  89
RAM disk  93, 105, 108
SCSI disk mode  90, 212–216
sound output  220
storage switch  88, 225–226
storing  93, 224–226
turning off  92
turning on  5, 88

PowerBook 140 model
backup battery  99
battery

charge time  97, 101
life, maximizing  99
recharging  8, 88, 95,

96–97
removing/replacing  98
type  99
use time  101

brightness control  149
contrast control  149
interrupt button  89
low-power messages  94
microphone  219
modem  217
power button 5, 88, 90, 92
RAM disk  93, 105, 108
recording sound  143–144
reset button  89, 90
SCSI disk mode warning  212
storing  224–225
32-bit addressing  156
turning off  92
turning on  5, 88
virtual memory  101, 154–155

PowerBook 170 model
backup battery  99
battery

charge time  97, 101
life, maximizing  99
recharging  8, 88, 95,

96–97
removing/replacing  98
type  99
use time  101

brightness control  149
interrupt button  89
low-power messages  94
microphone  219
modem  217
power button 5, 88, 90, 92
Power Saver feature  101, 105
RAM disk  93, 105, 108
recording sound  143–144
reset button  89, 90
SCSI disk mode warning  212
storing  224–225
32-bit addressing  156
turning off  92
turning on  5, 88
virtual memory  101, 154–155

power button
restarting the computer with

90
shut down warning  92
turning on the computer with

5, 88
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power problems
low battery  8, 88, 94
in SCSI disk mode  216

Power Saver  105
conserving power with  101

power states  4, 87
power use of

ADB devices  101, 218
disks vs. RAM disks  105
microprocessor  105
modem  101, 217
screen brightness  101
SCSI disk mode  216
virtual memory  154

pressing  11
Print command  162–163
printer

choosing  157–159
connecting  218
downloading fonts to

168–169
installing printer software on

79–82, 158, 159
installing fonts on  167
LaserWriter Font Utility and

170

printer (continued)
outline vs. bitmap fonts

166–167
out of paper  165
PrintMonitor and  165
restarting  171
selecting Page Setup options

for  160
removing fonts from  168
troubleshooting  164, 262
updating printer software on

networked computers
161–162

printer port  218
printing  162–164

in background  159, 164–165
color or gray-scale  163
desktop contents  163
fonts for  166–167
LaserWriter start page  171
on network  159, 161–162
Page Setup options for  160
troubleshooting  158, 159,

164, 262
window contents  163

PrintMonitor  164–165
ProDOS format. See Apple II

ProDOS format

programs  23
adding to Apple menu  125,

134
aliases for  64–65, 124–125
application vs. system  42
automatic startup for  134
changing memory use of  86
disconnecting links to  201
installing  29, 34–36, 83–84
linking  200–203
making active   40–42
multiple  85–86
opening  38, 46
Power Saver and  105
RAM disks and  106
system rest and  102
quitting  43, 44, 53
sharing caution  184
switching among   40–42, 85
troubleshooting  83
types of  43

protecting disk contents  32,
114–115

Put Away command  31, 116,
178

Q
question mark disk icon  79, 113
question mark menu icon  70–71
Quit command  53
quitting a program  43, 44, 53
quitting SCSI disk mode  216
quitting work (turning computer

off )  7, 91–93

R
RAM. See random-access

memory
RAM disk  105–106

creating  106
conserving power with  101,

105
erasing  107
memory recommendations

for  105, 108
permanence of  105
reset button and  90
resizing or removing  107
restarting and  89, 90
restoring after storage

225–226
shutting down and  93
using as a startup disk  108,

113
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random-access memory (RAM).
See also RAM disk

adding  205
backup batteries and  99
checking use of  86, 152
disk cache and  153
preserved in sleep  103
preserved under low-power

conditions  94
management of  152–156
recommended for RAM disk

use  105, 108
restoring after storage

225–226
programs’ use of  86
32-bit memory and  156
virtual memory and  154–155

rebuilding the desktop  226
recharging the battery  8, 88,

95–97
recording sound  143–144
registered group  186, 196

access privileges of  196, 197
exclusive access for  188
linking programs with  203
naming  186–187
removing a user from  190
seeing members of  187
setting access privileges for

197

registered user  176, 196
access privileges of  196, 197
changing your password as

181
connecting to a shared disk

as  177–178
creating a folder as  180
denying access to  189
disconnecting  193
exclusive access for  188
linking programs as  201
linking programs with  203
naming  185
removing  190
setting access privileges for

197
setting password for  186
sharing your files with  182

removing
battery  98
dirt  222
extra System Folders  36, 83
floppy disk  31, 116
fonts  168
RAM disk  107
registered user or group  190
sounds  143
System Folder items  135
unwanted files  33–34

replacing backup batteries
99–100

replacing main battery  98
reset button  89, 90
Restart command  89
restarting the computer  89–90

solving a problem by  227
Return key  229
run time, maximizing  101

S
safety instructions  221–223
Save As command  60–61
Save command  39–40, 49

Save As command vs.  61
saving your work  39–40, 49

as different version  60–61
in a directory  123

scalable fonts. See outline fonts
scanning order  113
screen

adjusting brightness of  149
adjusting contrast of  149
cleaning  222
comfort tips  78
magnifying image on

150–151
power use of  101
troubleshooting  253, 256

scroll arrows  19
scroll bars  19
scroll box  19

SCSI (Small Computer Systems
Interface)  208

SCSI chain  208. See also SCSI
disk mode

configurations for  211
length of  211
setting ID numbers for  118,

208–209
termination, rules for  210

SCSI devices  208. See also SCSI
disk mode

connecting  210, 211
installing software for  208
power use and  101
setting ID numbers for  118,

208–209
terminators for  210
troubleshooting  260–261

SCSI disk mode  212
battery use in  216
configurations for  213
connecting your computer in

212–214
quitting  216
resinstalling system software

in  90, 215
setting ID numbers for  212
simplifying connection

process  214
terminators for  213
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SCSI icon  208
SCSI peripheral interface cable

211, 213
SCSI port  208
SCSI terminator  210
sealed lead-acid (SLA) batteries

98, 99, 101. See also
battery

searching for files  126–129
seeing hidden window contents

19
seeing hidden windows  85
selecting an icon  11, 14, 15
selecting text  47–48
serial port. See modem port,

printer port
service locations  228
setting up computer hardware.

See hardware
configuration

setting up your computer on a
network  173–176

shared disks  22, 176. See also
file sharing

access privileges for  197–198
belonging to you  182–184
ceasing to share  184, 189,

191–192, 193
changing folder ownership

on  182, 190–191

shared disks (continued)
connecting to  177–180
creating new folders on  180
disconnecting from  116, 178
using files and folders on

180, 182
shared files. See file sharing
shared folders, access privileges

for  196–199
Sharing Setup control panel,

using to
change your password  195
identify your computer on

the network  175–176
turn file sharing off  191–192
turn file sharing on  183
turn program linking on/off

202
Shift key  24, 229
shortcuts. See keyboard

shortcuts
Show Balloons command  70
Shut Down command  7, 92
size box  17
size of window, changing  17–18
SLA batteries. See sealed lead-

acid batteries

sleep   4, 8, 87, 103
adjusting  103–104
automatic  94, 99, 102
conserving power with  101
hard disk sleep  104
low-power and  94
network use and  103
preventing  103, 104
putting computer to  7, 91–92
troubleshooting  255
virtual memory and  104, 154
waking the computer from

4–5, 6, 8, 88, 103
when to use  7, 91, 101

Sleep command  7, 91
Slow Keys feature  141
Small Computer Systems

Interface. See SCSI
software developer support  238
software drivers  134, 208
software licensing agreements

83, 184
software, system. See system

software
Sound control panel

choose a sound  142
record a sound  143–144
remove a sound  143
set sound volume  142

sound input port  219
sound output port  220
sounds. See also alert sound

choosing  142
installing  143
recording  143–144
removing  143
setting volume of  142

speakers, connecting  220
starting up your computer  4–6,

88–90
startup disk  6, 27, 35, 79

conserving space on  135
designating  113
installing system software on

79–82
RAM disk as  108
scanning order for  113
System Folder on  35–36, 135
System 7 and  82
troubleshooting  79, 117–118,

253
VM Storage file on  155

Startup Disk control panel  113
startup disk icon  6, 27
Startup Items folder  134
stationery, creating  66–68, 130
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“Stay awake when plugged in”
checkbox  103, 104,
154

Sticky Keys feature  141
storage switch  88, 93, 95,

225–226
storing the computer  93,

224–226
battery charge and  94, 223

StyleWriter printer, power
adapter caution  218

support services  228
System 7

Balloon Help and  70–71
communications products

and  204
hard disk requirement for  82
networked computers and

161
system crash, restarting after

89–90
system error, restarting after  89
System file. See also System

Folder
installing fonts in  166, 167
listing fonts in  170
removing fonts from  168

System Folder  23, 79. See also
System file

installing sounds in  143
on program disk  35–36
on startup disk  79, 82
putting files in  134–135
removing files from  135
removing sounds from  143
VM Storage file in  155

system rest  102
system sleep  4, 8, 87, 103

adjusting  103
automatic  94, 99, 102
conserving power with  101
low-power and  94
network use and  103
preventing  103
putting computer to  7, 91–92
waking from   4–5, 6, 8, 88,

103
when to use  7, 91, 101

system software  43, 79
custom installation  81–82
fonts  167–168
reinstalling in SCSI disk mode

215
sounds  143
special files  134–135
standard installation  80
troubleshooting  254, 257

T
Tab key  229
TeachText program  38
technical information  238
technical support  228
templates, creating  130
text

changing  46–49, 50–52
deleting  51–52
inserting  47
moving  50–51
replacing  47–48
selecting  47, 52
typing  39

text translation  234
3.5-inch disks. See floppy disks
32-bit addressing  156
time, setting  137–138
title bar  17, 20
trackball  4, 10

adjusting  139
buttons  4, 10
choosing a command 

with  14
cleaning  254
clicking with  11
dragging with  12
pointing with  10
pressing with  11
turning computer off with  7
using  10–14
comfort tips  13, 78

translators  234–236
Trash  6, 23

emptying  34
turning off warning for  152
using  33–34

to eject a disk  116
traveling, tips for  223–224
troubleshooting  226–227,

253–263
aliases  124
Apple menu items  125
application programs  83, 259
battery  255
blinking icons  79, 256
computer stops working  8,

253
damage to computer  227
file sharing  175, 185, 263
floppy disk drives  116, 257,

258
floppy disks  115, 116,

118–119, 257, 258
gaining access to your

computer over a
network  195, 263

hard disks  117–120, 257
lost windows  256
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troubleshooting (continued)
memory  152, 156, 260
modems  261
network  175, 185, 263
odd behavior  254
power problems  255
printers  164, 262
printing  158, 159, 164, 262
screen  253, 256
SCSI devices  260–261
sleep  255
starting up  79, 89–90,

117–118, 253
system crash  89–90, 253
system software  254, 257
32-bit addressing  156
viruses  84, 254

TrueType fonts  166
downloading  168–169
installing  167

turning computer off  7, 91–93
turning computer on  4–6, 88

and connecting automatically
to a shared disk
179–180

turning file sharing off  191–192
turning file sharing on  183

U
unlocking a disk  32, 114
unlocking a file  114
untitled window  38, 39
upgrades, memory  205
user groups, Macintosh, locating

237
user name  185, 186
user, registered. See registered

user
Users & Groups control panel,

using to
assign a password  186
deny file sharing access  189
gain access to your computer

over a network
194–195

name a registered group
186–187

name a registered user  185
name users for program

linking  203
remove a registered group

190
remove a registered user

from a group  190
user support groups  237

V
variable-size fonts. See outline

fonts
vertical scroll bar  19
viewing hidden window

contents  19
viewing hidden windows  85
View menu  132
Views control panel, using to

change the way Finder
windows appear  147

virtual memory  154–155
power use and  101

viruses  84, 254
VM Storage file  155

W, X, Y
waking the computer  4–6, 8, 88
warranty service  228
window  15, 16, 23

active  15
changing appearance of  147
changing name of  58–59
changing size of  17–18
closing  20
finding  256

windows (continued)
hiding and showing  85
making active  16–17
moving  20–21
printing contents of  163
rearranging items in  132
straightening items in  121
title bar of  17
troubleshooting  256
untitled  38, 39
viewing contents of  16–19,

132
word wrap  39

Z
zones, selecting  159, 177
zoom box  17, 18
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